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WASTE Form Number:
MANAGEMENT ’ e NP 19-1-6
PROGRAM User’s Manual Criteria Form
m, Page 1 of 1
Laboratories
Does the user's manual contain as appropriate:
1. Software Name: nSIGHTS -
2. Software Version: 1.0
3. Document Version: 1.0
4. ERMS #: 522061
5. A statement(s) of functional requirements (consistent O Yes [0 No XK NA [J NR
with those in the RD) and system limitations? *
6. An explanation of the mathematical model and O Yes O No X WA [ NR
numerical models?
7. Physical and mathematical assumptions? O Yes O No X NA [OJNR
8. The capabilities and limitations inherent in the software? K Yes [0 No [O NA [ NR
9. Instructions that describe the user's interaction with the B Yes [0 No [OJ NA [ NR
software?
10. The identification of input parameters, formats, and valid K Yes [0 No [O NA [ONR
ranges?
11. Messages initiated as a result of improper input and how O Yes [0 No X NA [ONR
the user can respond?
12. The identification and description of output B Yes [OJ No [O NA [O NR
specifications and formats?
13. A description of any required training necessary to use K Yes [ No [ NA [O NR
the software?
14. The identification of components of the code that were O Yes [0 No X NA [ NR
not tested? .
eSS
Randy Roberts _11/26/200%
Code Team/Sponsor (prinf) Signature Date
16. : _
(2P F .
Technical Reviewer (prinf) Signatur Date
17. '
7_<4 = ]
Responsible Manager (prinf) . Signature Date
18y a X : u{:,b/a'lf
L 11/26/2002-
Q CM Coordjnator (prinf) a Date

Key for check boxes above:

Check Yes for each item reviewed and found acceptable

Check No for each item which requires further work

Check N/A for items not applicable

Check N/R for items not reviewed (multiple technical reviews)
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Addendum to User Manual Criteria form.
This addendum contains explanations for boxes marked N/A.

Explanation for 5 — A statement of the functional requirements is contained in the
Requirements Document ERMS#522058.

Explanation for 6 — A functional description and theoretical development is contained in
the GTFM - User Documentation ERMS# 240244, August 15, 1996. nSIGHTS contains
the functionality of the DOS based well-test simulator GTFM, re-architected and re-
implemented for the Windows platform

Explanation for 7 — The physical and mathematical assumptions are contained in GTFM
— User Documentation ERMS# 240244, August 15, 1996.

Explanation 11 — Messages initiated as a result of improper input are echoed in the
software screens indicating source of improper input.

Explanation 14 — Code components that were not tested are listed in the Validation and
Verification Plan ERMS#522060 and in the Verification Document ERMS#522063.
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1 INTRODUCTION

1.1 Overview

nSIGHTS (n-dimensional Statistical Inverse Graphical Hydraulic Test Simulator) is a
comprehensive well test analysis software package. It provides a user-interface, a well
test analysis model and many tools to analyze both field and simulated data. The well
test analysis model simulates a single-phase, one-dimensional, radial/non-radial flow
regime, with a borehole at the center of the modeled flow system.

The nSIGHTS system consists of two independent applications: nPre and nPost. The two
applications differ in function, but are similar in their interface. nPre assists the user in
model set-up, data pre-processing, running of the model and diagnostics of the
simulation. nPost post-processes results calculated in nPre and stored in post-processing
files.

This manual intends to guide the user in the use of nSIGHTS software; it does not
provide a guide to the well test analysis model or to well test analysis.

The first section, Using nSIGHTS, provides an overview of the basic steps in working
with nSIGHTS, examines some of the basic concepts in nSIGHTS as well as to describe
the user interface.

The remaining sections of the manual detail:

e the input windows used for. setting up a simulation in nPre (nPre Input Windows)

e nPre input windows Auto-Setup (nPre Auto Setup)

e running a simulation (Running Simulations)

e general information on data, plot, list and output objects (Objects)

e handling data objects for processing data (Data Processing: Data Objects)

e plotting data (Plotting)

¢ nPost Lists, and

e nPost OQutput options

A final section Tutorial will guide one through detailed steps in setting up, running and
post-processing an optimization simulation.
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1.2 User Manual Nomenclature

Within this manual, different fonts are used to indicate menu text, dialog prompts, drop-
down list selections, user keyboard entry, jargon, object names, page and object
identifiers and parameters. The following key describes the different items and their
associated font:

Menu Text — this is text that appears on menus, dialog boxes, or menu bars. For text in
dialog boxes, it is associated with the dialog heading and "frames" surrounding groups of
items. - -

Dialog Text — this is text that appears in dialog boxes.

Drop-down List Selection — this is text that appears in a drop-down list box.

Keyboard — this is text entered by the user in text or numeric fields on menus.
Jargon — this is text that names an nSIGHTS specific concept for the first time.

Object Name — this is the name of an nSIGHTS object. Note that the object name used in
the manual refers to the object name used in the Object menu. Object names in the object
tree or object description area may differ from the object name in the Object menu (see
Appendix E for tables of alternative object names).

Page or Object ID — this is the identifier for a specific nSIGHTS object with the object
tree.

Parameter — this is the name of an nPre parameter.

1.3 Getting Help

The nSIGHTS user manual is available in both hard-copy format and through the on-line
help system. To access the on-line help system, select the Help Topics command from the
Help menu in the main window, or select the F1 key.

As well, context sensitive help is available for tool bar buttons and objects.
When a cursor is placed over a tool bar button, context sensitive help displays a small

text window providing a short name for the tool bar button, as well as to display a
message within the status bar (at the bottom of the main window).
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To access help for an object, either select the *] button or Shift-F1 and then the object in

question. A help window will appear containing the help information for the selected
object.

The B] button provides information on the software, including the software version, a
link to register software complaints and a link to the manufacturer’s website.
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2 USING NSIGHTS

2.1 Overview

The general steps to creating a model run, executing a model run and viewing the output
are outlined below.

(1) Open nPre. nPre is used to pre-process input data, select model run options and
execute the model run.

(2) Complete input requirements through Input Windows. For all simulation modes,
the following input is required:

o define general model options and physical configuration = Configuration input
window

e import field data and develop constraints and diagnostic plots = Field Data
input window
define test sequences —>Sequence input window
enter parameter values = Parameter input window and if applicable, f(p)/f(r)
Points Parameter input window

» if suite or range parameters are defined, specify related options = Suite/Range
input window
specify simulation output options =>Simulation Output input window
specify output files to be created during simulation =>Output File Setup input
window

e create plots for viewing during simulation = Processing Setup input window
Depending on the simulation mode, further input may be required:

e if optimization or forward-range mode is selected, pair field data and
simulated data for comparison => Fit Selection input window

e if optimization mode is selected, pair field data and simulated data for
comparison => Fit Selection input window, and specify optimization options =
Optimization input window

e if sampling mode is selected, specify sampling options =>Sampling input
window

(3)  Execute the model. Select the Minimal or Verbose command from the Run menu.
Minimal shows minimal information during the simulation, whereas Verbose provides

detailed information, at the cost of slightly increased execution time.

(4)  Examine diagnostic plots. If required, make necessary adjustments in the input
and repeat step (3).

(5) Close nPre.
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(6) Open nPost. nPost is a post-processor for simulation results, and contains many
statistical tools to examine the results.

(7)  Read simulation results into nPost. Analyze and plot the results.

(8) Examine results. If necessary, return to nPre, make necessary changes to the
input, and repeat from step (3).

2.2 Basic Concepts

2.2.1 Model Runs and Simulations

Each time the well test analysis model is executed within nSIGHTS, a model run is
created. To execute the well test analysis model (and create a model run), a command in
the Run menu is selected (see Section 5).

Depending on the model options selected, a model run within nSIGHTS may consist of
one or many simulations or cases. A simulation is the calculation of one flow solution,
with one set of parameter values. A case is one or a group of simulations depending on
the simulation mode:

» In forward mode, a case is one simulation, with one combination of suite, range or
sampled parameters.

¢ In optimization mode, a case is a group of simulations, based on one set of non-fitting
parameters, such as a set of sampled parameters or one combination of suite or range
variables. Each simulation of the optimization mode case has adjusted values of
fitting parameters, with the goal of providing an optimal fit between simulated results
and field data.

Simulation mode indicates general model function. For example, optimization mode
indicates that the model will conduct several simulations, adjusting the values of user-
specified parameters for each simulation, to obtain an optimal fit between simulated and
field data. Each model run has only one simulation mode. The simulation modes
available are identified and described in Section 3.1.1.

2.2.2 Pages and Objects

The nSIGHTS approach to data visualization and data processing is based on the
conceptual paradigm of pages and objects. These pages and objects are organized in an
object tree (see Section 2.3.3).

5
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An object has a defined function related to data input/output, data manipulation, or plot
construction. For example, a data object may read a file containing a table of pressure
data, while a plot object may plot pressure with respect to time. Section 6 describes
object basics.

A page contains a collection of related or similar objects. nNSIGHTS contains four types
of pages: data pages, plot pages, list pages (nPost only) and output pages (nPost only).

Data pages are used to collect objects that do not in themselves create a visual
representation. For example, table input data are represented by an object named Read
Table File. There is always at least one data page (the default data page), however the
user can add as many data pages as desired. Multiple data pages are used to better
organize objects (more than 15 objects to a page can be cluttered). Data objects are
further described in Section 7.

Plot pages contain objects that result in a visual representation appearing upon a single
plot. Associated with each plot page is a top-level window that contains the actual plot.
Only those objects on a specific plot page will appear on the plot. Plot pages and objects
are further described in Section 8.

Output pages (nPost only) contain objects whose primary purpose is to write data to a
file. The output page, and associated output objects are further described in Section 10.

A list page (nPost only) performs a similar function to the List menu in nPre. For each
list object, an associated list top-level window is created, displaying text information.
The list page and associated objects are further described in Section 9.

2.3 User Interface

The nPre or nPost user interface consists of a main window, from which the majority of
controls are located. Other top-level windows in the interface include plots, the window
list menu and object controls. The user interface description in this section focuses on the
main window interface. : '

Figure 1. shows a typical nPre main window.
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Figure 1. nPre Main Window Screen

Figure 2. shows a typical nPost main window.
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Figure 2. nPost Main Window Screen

The user-interface that occupies the bulk of the main window differs between nPre and
nPost. In nPre, the main window consists of two main components: an nPre control bar
(navigational pane) and an nPre input window. In nPost, the main window consists of two
main components: an object tree, and the object property window.

Additional user-interface components for both nPre and nPost include a menu bar, a tool

bar, an object description area (directly below the menu bar), a message line, a status bar
and a window list menu window.
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2.3.1 nPre Control Bar

The nPre control bar, shown in figure 3., displays all the nPre input windows. It is
equivalent to the nPre menu.

Figure 3. nPre Control Bar

An nPre input window is simply a means of organizing the different steps of an
nSIGHTS simulation. Selection of an input window from the nPre control bar or menu
will display the corresponding nPre input window.

The commands are shown as either small icons or large icons, controlled by selecting the

small icon button or the large icon button [%:] in the tool bar, or by right-clicking in
the control bar and selecting the corresponding command from the pop-up menu. If the
control bar is too small to show all the commands, scroll buttons will appear on the right
hand side of the control bar.

The nPre control bar is closed by selecting the 1 button on the top right hand corner of
the nPre control bar, or by toggling the Control Bar command in the View menu.

2.3.2 nPre Input Window

The nPre input window contains dialog prompts, object trees and corresponding object
property windows or tables to define the input data for a simulation. The input window
may be organized into tabs, as shown for the Configuration main tab window (figure 4.):
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Figure 4. Configuration Main Tab Window

If there are too many tabs to fit within the main window, scroll buttons will appear
adjacent to the tabs in the top right hand comer of the input window.

The nPre input windows for each nPre command are described in detail in Section 3.

2.3.3 Object Tree
The object tree is a means of visually organizing pages and objects.

?e Input Data::Data
| [~ Input Data: :DataPgDesc

] | 11 Tutorial.nOpt: :ReadOptSImResul
1 r—tt TutorigPerturb.nOpt: :ReadOpts
i L TutorialSamping nOpt: Readopt
B-E Jacobian Data::Data

®-0 Jacobian log P Plot::XY

&-03 Jacobian log dP' Plot: XY

E?El Residual Data::Data

-0 log dP Res Diag::XY

&0 log dP* Res Diag::XY

-2 Confiderce Region Data::Data

-0 K and n Confidence Region::XY

é-a Perturb Results::Data
-1} Perturb Results: :DataPgDesc
| |-H SelectOptResuts::SelectOptRest
| 1% KTableHistogram::TableHistograt
| 43 SelectoptCovar::SelectOptCova
&1 K Perturb Hstogram: :XY
-3 K Perturb Histogram ::2D-XY
-1t 1D Axes::X Axis

~1t 1D Axes::Y Axis

(-1t 20PlotAnno:: 2DPlotAnNo

| BXTomE O
() e——— S |

Figure 5. Object Tree
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The pages in an nSIGHTS visualization are represented as first-level icons in the tree.
The different types of pages are indicated by the following icons:

a data pages, list pages and output pages
o 2D plot pages
« 3D plot pages

“H jcons in the second level of the tree represent the objects associated with each page.
Objects can be hidden/unhidden if the tree node for the page is toggled.

Both page and object icons are followed by a text identifier. The text identifier contains
an object ID followed by the name of the page or object. The object ID is specified in the
top left hand corner of the object property window. For pages, the object ID for the first
object in the page will also be the ID for the page.

New objects are created using the New command in the Object menu. The command
results in a list of available objects being presented, from which the user may pick one.
An icon and ID representing the object then appears in the object tree and its properties
appear in the property window.

Selecting an object causes its properties to appear in the object property window. The
selected object (also known as the current object) is indicated by a black square around
the icon, as shown below for the XY Data: X4 Data object.

é}-ﬂ K Perturb Histogram::XY
3 K Perturb Histogram ::2D-XY
1% 1D Axes::X Axis
3t 1D Axes:'Y Axis
~1+ 2DPlotAnno::2DPlotANNo

-EIXY Data: XY Data

Figure 6.

The object of type Read XY Data is selected in the figure above. Usually only one
object is selected, but multiple objects may be selected by holding down the shift key
when selecting objects. Selecting multiple objects is useful only for copy, delete, and
duplicate operations (see Section 2.3.5.2). When multiple objects are selected, only the
object property window for the last object selected is shown.

An object’s icon reflects its status. Available status indicators are as follows:

10
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Normal Status

Incorrect Object Properties
Error in Object Calculation
Exposed Properties

mELH

If the object status is OK (all object properties are set correctly and all object input is
satisfied) the icon will be displayed normally. Otherwise a green question mark may
appear over the icon if the object properties are not set correctly, or a red X if the object
calculation resulted in an error. Other status indicators are a black XP if the object
contains exposed properties (see Section 6.3.2). Some objects may appear with a pink Q
overlaying the icon, indicating that the object's quality assurance status is to be verified.

2.3.4 Object Property Window

The data associated with the current object (i.e. the object's properties) are displayed in the
property window, along with a user interface (UI) for editing the properties, and the
object buttons. In the example below, the Read XY Data object properties consist of the
Object ID, the name of the file, file reading options, plus status information describing the
attributes of the loaded file.
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Figure 7. Property Window

Selecting a different object in the object tree, or creating a new object, clears the object
property window display and places the properties of the new object in the property pane,
where they can be modified.

The object buttons in the property window have the following effect:
Apply Processes all user input in the object property window and checks it for

validity. If the data are OK, they are copied into the object and the object
is re-calculated. All connected objects downstream are also re-calculated

11
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and any affected plots updated.

Cancel Replaces the data displayed in the property window with the object

properties first displayed or saved with the last selection of the Apply
button.

Clear " Clears object properties (may not be available for all objects).

Default Sets object properties to a default value (may not be available for all
objects).

2.3.5 Menu Bar

The menu bar for both nPre and nPost contains the following menu items: File, Object,
Page, View, Window, and Help. nPre contains several additional menus items: nPre, List,
Auto Setup, and Run.

2.3.5.1 File Menu

The File menu bar item contains the usual file operations:

New Removes the current nPre or nPost file, and creates a new blank
nPre or nPost file.

Open Presents a file selection dialog to open an existing nPre or nPost
configuration file (default extension .nPre or .nPost). Upon
selection of a file, the existing configuration is cleared and the
selected configuration file is loaded. A configuration file contains
the nPre input data (nPre only) and all the pages, objects, and
object properties and data. The main window title is then changed
to the file name.

Save Replaces the contents of the current configuration file with the
current input data and page/object set-up. This method will use
Save As if a configuration file has not been loaded.

Save As Presents a file selection dialog (default extension .nPre or .nPost).
After a file name is specified, the Save operation is performed.

Print Setup Presents the standard Windows printer selection dialog. The
default printer for plots and the basic page set-up is specified.
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Exit Closes nPre or nPost.

2.3.5.2 Object Menu

The Object menu bar item is shown in figure 8.

e
Copy Cul+C

Copy Bage
Paste, Cul+y

Delete Del
ooy F12
Connections Y

Figure 8. Object Menu Bar

Note that the same Object menu is also available as a pop-up menu, by right-clicking the
mouse in the object tree window while an object is selected.

The menu provides the following operations for manipulating objects in an object tree:

New Creates a new object and places it on the current page. The New
menu item cascades to a second menu providing a list of objects
available for the current page type. For data pages, the second
menu contains categories of objects, which cascade into a third
menu containing the available objects.

Duplicate Creates a copy of the currently selected object(s) on the current
page. Equivalent to Copy followed by Paste.

Copy Clears the copy buffer and places a copy of the currently selected
object(s) in the copy buffer. Note that multiple objects are selected

by holding down the shift key when selecting objects.

Copy Page Clears the copy buffer and places a copy of all objects on the
currently selected page in the copy buffer.

Paste Creates copies of all objects in the copy buffer on the currently
selected page. The page does not have to be the same page as the
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page from which the objects were copied, however, it does have to
be a page of the same type.

Delete Removes the currently selected object from the page. Places a
copy of the object in the copy buffer.

Apply Same effect as pressing the Apply button in the current object
property window.

Connections  Displays a text top-level window that provides information on the
connections of the currently selected object, the objects used as
input, and the objects which use the currently selected object’s
output as input. See Section 6.2.3 for details.

2.3.5.3 Page Menu

The Page menu bar item is used to perform operations on data, plot, list and output pages.
Note that the same menu is also available as a pop-up menu, by right-clicking the mouse
in the object tree window while a page is selected. Not all the commands are available in

both nPre and nPost.

New 2D XY Plot

New 3D XYZ Plot

New Data

New List

New Output

Duplicate

Copy current

Copy all

Paste

Creates a new 2D plot page and window.
Creates a new 3D plot page and window.
Creates a new data page.

Creates a new list page (nPost only).
Creates a new output page (nPost only).

Creates a copy of the currently selected page.

Places a copy of the current page and all its objects in the
copy buffer.

Places a copy of all pages and all objects in the copy buffer.

Creates copies of the pages in the copy buffer in the current
object tree.
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Delete Deletes the currently selected page.
Delete all Pages Deletes all pages in the current object tree (nPre only).

Bring Page Window Top If the currently selected page in the object tree is a plot or
list page, the plot or list window is brought to the top of the
window order (i.e. made visible).

All Connections Displays a text top-level window that provides information
on the connections of all objects within the currently
selected page. See Section 6.2.3 for details.

There are no set limits within nPre or nPost on the number of pages in a single
application.

2.3.5.4 View Menu

The View menu bar item has four items in nPre and three items in nPost:

Toolbar Controls the presence of the toolbar displayed below the object
description area.

Status Bar Controls the presence of the status bar at the bottom of the main
window.

Control Bar  Controls the presence of the nPre control bar (nPre only). The
nPre control bar is described in Section 2.3.1.

Settings Displays the View Settings dialog which specifies default settings for
nSIGHTS operation. This dialog is discussed in detail in Section
2.4.

2.3.5.5 Window Menu

There are at least two items on the Window menu bar item:

Window List Displays the window list menu top-level window. Upon
selection of any top-level nPre or nPost window (the main
window, plots or control menus) in the window list menu,
the selected window is brought to the top of the window
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order. The window list menu is further described in
Section 2.3.10.

Minimize all windows Minimizes all windows.

The Window menu will contain one entry for each top-level window open except for the
main menu. The top-level windows are identified by the nPre input window (nPre only),
the window ID and the window type. Selecting an item will bring the window with the
same name to the top of the window order. In the example below, there are three top-
level windows in nPre. All three are 2D plots: the plots are associated with plot pages in
the Field Data input window, the Sequence input window (Process/Plot tab), and the
Processing Setup input window.

Window List Fil
Minimize al windows

_ Hd:_:P_Cafteﬁan i
Seq::F_01_diag
Proc::K andn

Figure 9. Window Menu
2.3.5.6 Help Menu

The Help menu bar item has two items:

Help Topics Displays the Help window containing the on-line help
manual.

About nSIGHTS Displays the About dialog, containing information about
the software version, and links to the developer and
manufacturer.

2.3.5.7 nPre Menu

The nPre menu lists all the nPre input windows. It is equivalent to the nPre control bar.
Selection of an input window from the nPre control bar or menu will display the
corresponding nPre input window.

2.3.5.8 List Menu

The commands in the List menu provide a summary, in a text window, of the nPre model
input data. The different input data summaries available and their corresponding menu
commands are as follows:
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Current Displays the model input data associated with the current

nPre input window.

Current Errors Displays errors in the model input data of the current nPre
input window. If the command is inaccessible, there are no

errors for the input window.

Calculated Parameters Displays parameters used in the model which are calculated

based on user input parameters.

All Displays all model input data.
All Errors Displays all errors in the model input data.
Messages Displays the last 300 error messages that have occurred.

In addition to the summary of input data, all list windows provide information on the
nPre version including the version date and the QA status, the date the listing window

was created and the configuration file name.

For example, the following figure shows the list text window for the Current command,

with the Configuration nPre input window active:

o & Current Meni

|| nPre 0.90P E
| i
1 Version date 14 Jun 2002 i
1 Listing date 14 Jun 2002 h_{
; QA status QAR: no (bets) ¥
|| config file C:\nSights\Tutorial\Tutorial.nPfre 'l"._.'.
" i
{ St

| i
| Control Settings i
! it
Main Settings it
Ssimulation type optimization L'};
Simulation subtype Normal i
Phase to simulate Liquid lmﬁ
Il skin zone 7 no
] Extecnal boundary Fixed Pressuce r_h!l
if
1 I'
| Liquid Phase Settings H
I i
| system porosity single '.'_F,
Compensate flow dimension geometry yes !--'-"
| Leakage None I'fﬁ
£
| m
| Test Zone Settings ':
Test zone volume can vary no fh'
Test zone compressibility can vacy no 1;51
Test zone tempersture can vary no lii
|| befault test-zone tempecatuce 20.00 el ’i
|| selution variable Pressure s

Figure 10. Current Command with active nPre Configuration Window
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The text window has its own mini menu bar and toolbar, containing the following menus

and commands:

Output
Print

Print Setup

Print Preview

Save As

View
Toolbar

Settings

Fonts

Presents the standard Windows print dialog.

Presents the standard Windows printer selection dialog. The
default printer for plots is specified, as well as the basic page set-

up.

Presents the standard Windows print preview screen. Select
the Close button to return to the list window.

Saves the data in the text window in a text file, with a default file
extension of *.Ist. .

Toggles the toolbar on and off.
Currently unavailable.

A second menu cascades containing commands to change the size
of the text font, on a relative scale (smallest to largest).

The toolbar contains two standard Windows buttons that shortcut to the Output->Print and
the Output>Save As commands.

2.3.5.9 Auto Setup Menu

Since the setup of certain portions of the input data and plots are similar from test to test,
the commands in the Auto Setup menu provide automatic generation of some input data
and plots. There are three Auto Setup menu commands: Field Data Plots, Sequence Plots,
Basic Fits. They are described in detail in Section 4.

2.3.5.10 Run Menu

The Run menu contains several commands to run the simulator:

Minimal

Verbose

Executes a model run with minimal run time information. A small
dialog displays the elapsed simulation run time and a progress bar
for multiple case model runs.

Executes a model run with maximum run time information. A
dialog displays the information, including elapsed run time and
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fitting parameter information.

Covariance Only For optimization mode, calculates the covariance matrix based on
the current set of parameters, without conducting a simulation.

These three commands are described in detail in Section 5.

The Minimize Main command can be toggled on or off. Toggled on has the same effect as
selecting the Minimize button in the run window. Upon selection of the Minimize button,
the main menu, as well as the run window are minimized. Plot windows remain visible,
in order to observe changes in the plots during the simulation.

2.3.6 Tool Bar

The tool bar contains icons corresponding primarily to File and Help menu items. It is
displayed below the object description area, and its presence is controlled in the View
menu.

2.3.7 Object Description Area

Displayed below the menu bar, the object description area provides information on the
currently selected object or input window and tab (nPre only).

2.3.8 Message Line

Below the nPre input window or the object property window is the message line. Error,
warning, and information messages regarding nSIGHTS execution are displayed in this
area.

2.3.9 Status Bar

A standard Windows status bar at the bottom of the main window. nSIGHTS does not
use the status bar except to display Shift and NumLock status and context sensitive help.

2.3.10 Window List Menu Window

The window list menu window will appear if F11 is pressed or if Window list is selected
from the Window menu bar item:

19
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Figure 11. Window List Menu Window

The Window List menu window contains a list of all currently defined nSIGHTS top-level
windows. In addition to the main window, top-level windows include plots, list
windows, and object controls. Selecting an item from the Window list menu will bring the
associated window to the top of the window order.

The menu window also has a mini toolbar:

Selection (pressed-in) of the push-pin icon causes the Window list menu window to
float above all other top-level menus.

= Minimizes all plot windows.

e Tiles horizontal all plot windows.

= Tiles vertical all plot windows.

=] Cascades all plot windows.

Sets the Window list menu window as transparent.

2.4 Program Settings

Selecting Settings from the View menu bar item will cause the following Settings dialog to
appear as shown in figure 12.

I Smail Fonts for control pent

I l:mhm coefl or WindowSelecior ==

! 1

T

ook | e T o |1 ves -]
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Figure 12. Program Settings Dialog Window

Settings available on the various tabs on this menu are saved in the system registry and
will remain in effect until explicitly changed. They are not saved in nPre or nPost
configuration files. Each tab on the menu is described in the following subsections.

2.4.1 Plot Tab
Controls the appearance of certain elements of plot windows.

Small fonts for control part The size of font used in controls on the plot
window.

Alpha blending coeff for Window Selector Controls the transparency of the Windows List menu
window (see Section 2.3.10). Effect depends upon
the operating system and graphics hardware.

2.4.2 TreeView

Controls how objects are represented in the object tree.

Single line for menu objects If not checked, the text labels for objects in the tree
are presented on two lines. Otherwise a single line
is used.

Show for single line Options for object identification used in text labels

displayed in a single line.

ID Only the object ID is displayed.
Type The object type is shown.
Both Object ID and type are both displayed.

2.4.3 OpenGL Visual

An OpenGL Visual describes the technical settings used for displaying 2D and 3D
graphics in nSIGHTS. This menu has two formats. If a plot page has been created, the
menu shows only the status of the visual as shown below in figure 13:
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Figure 13. OpenGL Visual Menu

The first field gives the index, red, green, and blue color depth, the color planes and depth
buffer depth and the buffering status. For effective use of nSIGHTS the following
settings are recommended:

ldx Index - n/a as it depends upon hardware.
R/G/B Red/green/blue color depth - at least S is desirable, 8 is preferred.
Cn Total color depth including alpha channel (not used in nSIGHTS

currently) - will usually be 4 times color depth.

Zn Z or depth buffer depth - 32 bits is preferable, at least 16 is
necessary.
Sngl/Dbl Single or double buffer - usually select double buffered visuals.

Single buffered visuals may flicker.

The other fields in the dialog (Version, Renderer, and Vendor) displays additional
information which may be useful for debugging display problems.

If a plot page has not been defined the menu appears with a selector box available (shown
with drop-down-box):
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Figure 14. Settings Selector Box Menu

Note that the number of visuals available and their properties will depend upon your
graphics card and drivers. The example shown above is for an Oxygen VXI graphics
card under Windows 2000. If Default is selected, nSIGHTS will attempt to pick an
appropriate visual. Note that the selected visual may or may not use hardware
acceleration and may or may not be appropriate for technical graphics. For example,
many cards have some visuals optimized for games, which have different requirements
(usually smaller Z buffer).

2.4.4 OpenGL Properties

Open GL Properties control the use of anti-aliased lines (which may or may not be
supported on your graphics card and selected visual). Anti-aliased lines blend pixels so
that lines appear smooth. Anti-aliased lines typically are slower to draw than normal
lines.

Anti-alias 2D lines If selected, lines on 2D plots are smoothed.
Anti-alias 3D lines If selected, lines on 3D plots are smoothed.

2.4.5 OpenGL Fonts

Compensates for operating system bugs in vertical or rotated text drawn on 2D plots.
Change this only if your displayed fonts have mirrored or distorted letters.
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2.4.6 Calculation Priority

Controls the priority of the simulation thread.
2.4.7 Country Settings

International settings.

European real delimiters Replaces decimal place with comma in user-interface, real number
display and I/O.
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3 NPRE INPUT WINDOWS

The nPre input windows contain dialog prompts, object trees and corresponding object
property window or tables to define the input for a model run. Different input windows
are used as a means of organizing input data, and each window may be further organized
into tabs. This section describes the different nPre input windows and their function,
summarized in Table 4.1.

The nPre input windows are accessed by selecting a command from the nPre menu, or the
nPre control bar. Not all input commands are accessible. Input commands, as well as
tabs and dialog prompts, are hidden if they are not required for the current set of selected
options. For example, the Optimization input window remains hidden unless Oprimization is
selected as the Simulation Sub-Type in the Main tab of the Configuration input window. A
hidden command or tab is either faded and cannot be selected, or completely hidden from
view.

Table 4.1: Summary of nPre Input Windows and Functions

Input Windows and Tabs Function

Configuration Defines model function and general options for the model run.

Main Sets basic model options, such as simulation mode.

Curve Files Loads XY files containing time-variable boundary condmons and
pressure- or radius-variable parameters.

Liquid Options specific to liquid phase simulations.

Gas Options specific to gas phase simulations.

Matrix Options specific to the matrix of dual porosity systems.

Default Units Sets default units for the model run.

Test Description Documentation of the model run.

Field Data Object tree to create constraints and diagnostic plots from field data.

Sequence Sequence definition. Sequences are discrete time intervals representing a
set of well-bore boundary conditions.

Time-Base Options for defining sequences.

Sequences Defines the sequences.

Process/Plot Object tree to create simulated data sets that correspond with the field
data constraints defined in the Field Data tab and to create simulated
data diagnostic plots.

TZ Curves Associates curve files (time variable boundary conditions) with
sequences.

Dynamic Time Step Controls for automatic adjustment of the time step during simulations.

Partial Run Controls to simulate only a subset of the defined sequences.

Parameter Establishes fitting and non-fitting parameters, and defines these
parameter values, ranges or distributions. Note that parameter functions
that vary with pressure or radius are defined in the f(p)/f(r) Points
Parameter input window.

Formation Formation parameters.

Fracture Fracture parameters, only for dual porosity systems.

Matrix Matrix parameters, only for dual porosity systems.

Fluid Fluid parameters, only for liquid phase simulations.

Gas Gas parameters, only for gas phase simulations.

Leaky Layer Leaky layer parameters, only for single leakage systems.

Upper Leaky Layer Upper leaky layer parameters, only for upper/lower leakage systems.

25

Information Only




Lower Leaky Layer Lower leaky layer parameters, only for upper/lower leakage systems.
Skin Zone Skin zone parameters, only for simulations with a skin zone.
Test-Zone Test-zone parameters.

Numeric Numeric parameters.

f(p)/f(r) Points Parameter

Defines parameter functions that vary with pressure or radms Only
accessible if parameters are defined as points functions in the Parameter
input window. A

Points Entry Enter XY points to define the function.
Interpolation Defines an interpolation function for the XY points.
Units/Transform The units and transforms of the XY points.

Optimization

Controls for the optimization of points defining the parameter function.
Optimization mode only.

Simulation Output

Defines the output to be calculated by the model.

Main

Defines the output to be calculated by the model.

Production Restart

Restarts production integration at specified times (for production output).

Superposition

Only for pressure superposition output type, the Superposition tab
provides a table to input radii at which pressures will be summed, and
related options.

Fit Specification Field and simulated data are paired for regression analysis. The pairing
of field and simulated data indicates the field data to which the regression
model should fit simulation results. Only for optimization modes or
forward-range mode.

Fit Specification/ Pairs field and simulated data.

Graphics

Fit Selection Determines which data pairs are to be used by the model.

Optimization Optimization solver options. Only for optimization modes.

Main Selection of algorithm, and general options.

Tolerances Options for optimizer tolerances.

L-M Algorithm Options for the Levenburg-Marquardt algorithm.

Simplex Algorithm Options for the downhill simplex algorithm.

Perturbation Initiates perturbation mode. Only for optimization-normal mode.

Sampling Sets up the sampling of a parameter. The parameters to be sampled are
defined in the Parameter or Sequence input windows. Only accessible
for sampling modes.

Main Selection of sampling options, such as the sampling procedure and the
number of times a parameter is to be sampled.

Correlations The simulation program will force the correlation between two
parameters to the correlation values specified in this tab.

Samples Provides a table of the sampled values to be used by the model.

Graphics An object tree for the visualization of sample data.

Suite/Range Determines the priority of suite or range parameters.

Not accessible for sampling modes.

Priority Sets the priority of suite or range parameters.

Output File Setup Defines model output files.

XY Data Determines which XY .array data to output to a file. All modes except
range modes.

Profile Creates a profile output file, which outputs a grid of pressure as a
function of time (X axis) and radius (Y axis). Only for forward-normal
modes.

Range Creates a range output file, which contains grid (2 range variables) or

cube (3 range variables) data of residuals (between simulation and field
data). Only for range modes.

Information Only -~




Optimization Creates a file containing fit results. May also include residuals,
covariance matrices, and Jacobian data. Only for optimization-normal
and optimization-sampling modes.

Processing Setup Object tree to create plots to monitor the real-time progress of the model.

3.1 Configuration Input Window

The configuration input window defines the basic options of the model, which define the
type of simulation to occur, the model’s general physical configuration, and the types of
parameters that will be used to describe the physical configuration.

3.1.1 Main Tab

Defines the basic options of the model, and its basic physical configuration, as shown in
figure 15:
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Figure 15. Configuration Main Tab Window

Simulation Type
Forward The model simulates a hydraulic test response based on
user input.
Optimization The model adjusts the values of user-specified parameters
to obtain an optimal fit to field data.

Simulation sub-type Simulation sub-types Normal, Range or Sampling are
accessible for both Forward and Optimization simulation
types, resulting in six possible simulation modes.

Forward-Normal The simulation is based on user-input parameter values.
Forward-Range A range of values and the number of intervals per range is
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Forward-Sampling

Optimization—-Normal

Optimization-Range

Optimization-Sampling

Phase to Simulate
Ligquid
Gas

System porosity

assigned to two or three input parameters. (Note that input
parameters may include sequence data, such as flow rate or
pressure boundary conditions.) Forward simulations are
performed for each combination of range variables. For
each simulation, a fit metric is calculated based on a
comparison of simulated results with a user-defined
constraint. A map of all these fit metrics, also called
parameter-space maps or fit surfaces, is used to determine
the optimal fitting-parameter combination.

Uncertainty ranges and distributions are assigned to input
parameters of interest. (Note that input parameters may
include sequence data, such as flow rate or pressure
boundary conditions.) The input parameter distributions
are sampled a specified number of times, and a forward
simulation is produced for each sample set.

A number of simulations are conducted, in which user-
specified parameters (fitting parameters) are adjusted for
each simulation to obtain an optimal fit between simulated
results and field data.

Two or three input parameters are specified with a range of
values, and additional parameters are specified as fitting
parameters. For each combination of range variables,
optimization simulations are conducted (i.e. the fitting
parameters are adjusted for each simulation to obtain an
optimal fit). For each simulation, a fit metric is calculated
in addition to optimization results.

Used to investigate the correlation between fitting and non-
fitting parameters. Uncertainty distributions are assigned to
non-fitting parameters of interest, and fitting parameters are
defined. The non-fitting parameter distributions are
sampled a specified number of times, and for each sample
set of non-fitting parameters, optimization simulations are
conducted (i.e. the fitting parameters are adjusted for each
simulation to obtain an optimal fit).

Indicates that a liquid phase simulation will be conducted.
Indicates that a gas phase simulation will be conducted.

For liquid simulations only.
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Single The model only considers one component of the media: the
formation.

Dual The model considers two components of a fractured
medium: the fracture and the matrix. Parameters need to
be specified for each component.

Leakage For liquid simulations only.

None The aquifer is assumed to be confined; there are no leaky
layers above or below the model system.

Single A single leaky layer above the model system.
Upper/Lower Layers above and below the model system are leaky.

Skin Effects If yes, a zone surrounding the well-bore is differentiated
from the formation, for which characteristic parameters
need to be defined.

External Boundary Specified external radius is either at Fixed Pressure or Zero
Flow.

3.1.2 Curve Files Tab

The Curve Files tab allows the user to load curve files to be used as well-bore boundary
conditions or parameter functions. Curve files are XY data sets which describe time-
varying boundary conditions or parameters which vary as a function of pressure (f(P)) or
a function of radius (f(r)). Each file may contain one or more data sets, each provided
with its own Curve ID.

Three types of curve files can be loaded within this tab: Well-bore boundary conditions, f(P)
parameters and f{r) parameters. To load each file, type the file name in the corresponding text

box or use the browse button dEI), and then select the Reload Curves button at the bottom
of the dialog. The default file extension for curve files is *.nCRV, but a file of any
extension may be loaded, as long as the file is in the correct format.

The files loaded in this tab will be accessed in different input window and tabs as
required, as described in Table 4.2.

Table 4.2: Use of Curve Files

Curve File Type Location of Use

Well-bore boundary conditions TZ Curves tab in the Sequence input window
f(P) parameters Parameter input window

f(r) parameters Parameter input window
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3.1.3 Liquid Tab

The Liquid tab is only accessible if Liguid was selected as the Phase to Simulate in the Main

tab.,

Permeability/hydraulic conductivity

Storage Parameter

Specific Storage

Porosity*Total Compressibility

Compensate flow dimension geometry

Test zone volume

Test zone compressibility

Test zone temperature

Hydraulic Conductivity can be entered directly,
or calculated from Permeabiline. Values for
conductivity or permeability are entered in
the Parameter input window.

Specific storage is entered directly as a
parameter in the Parameter input window.

Specific storage is calculated from porosity
and compressibility, which are entered in the
Parameter input window.

Compensation is used in two cases:

(1) for flow geometries that vary with radius

(2) for flow geometries which would
incorrectly calculate the area at the bore-
hole. For example, a spherical flow
geometry (n=3) would incorrectly
calculate the area of a cylindrical
borehole.

For varying test zone volumes, curve files
(volume of test zone vs. time) are required
to describe the boundary conditions of pulse
or flow sequences with isolated well-bore
storage.

For varying test zone compressibility, curve
files (test zone compressibility vs. time) are
required to describe the boundary conditions
of pulse or flow sequences with isolated
well-bore storage.

For varying test zone temperature, curve files
(temperature vs. time) are required to
describe the boundary conditions of pulse
sequences with non-isothermal test zone
thermal conditions.
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Default temperature

Solution variable

Default liquid density ‘

3.1.4 Gas Tab

The default temperature is entered in the text input box,
with the temperature units, either degrees Celsius (C) or
degrees Fahrenheit (F), specified in the

drop-down-box.

Pressure O Head

Hidden unless Head is selected as the Solution Variable. The
default liquid density is entered in the text input box, with
the liquid density units (kg/m’, g/cm”, Ib/ft or Ib/in)
specified in the drop-down-box.

The Gas tab is only accessible if Gas was selected as the Phase to Simulate in the Main tab.

Klinkenburg effects

Viscosity as f(P)

Gas flow solution variable

STP temperature

STP pressure

3.1.5 Matrix Tab

If yes, ‘the effect of gas slippage on permeability
(Klinkenburg effects) is calculated, requiring the parameter
Formation Klinkenburg factor.

Allows the definition of a simple function of pressure,
based on a Gas viscosity slope factor parameter, where
viscosity = Gas viscosity parameter + Gas viscosity slope
factor parameter * Pressure. Complex functions of
pressure are created using various parameter Types available
in the Parameter input window (see Section 3.4).

Mass flow or Volume@STP. STP stands for Standard
Temperature and Pressure.

Only required if Volume@STP is selected as the Gas flow
solution variable. The STP temperature is entered in the text
input box, either in degrees Celsius (C) or degrees
Fahrenheit (F), specified in the drop-down-box.

Only required if Volume@STP is selected as the Gas flow
solution variable. The STP pressure is entered in the text input
box, either in kPa, MPa, psi or bar, specified in the drop-
down-box.

The Matrix tab is only accessible if Dual is selected as the System porosity in the Main tab.
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Matrix Geometry The geometric relationship of the matrix and fracture.

Spherical The matrix is composed of spheres separated by fractures.
Prismatic The matrix is composed of rectangular slabs separated by
fractures.
Alpha A shape factor used in the equation to relate the matrix and

fracture permeabilities.

Entered The shape factor is entered using the Geometry Factor
(Alpha) parameter.
Calculated The shape factor is calculated based on the Matrix sphere

diameter parameter for spherical matrix geometries, and on
the Slab matrix block thickness parameter for prismatic
matrix geometries.

3.1.6 Default Units Tab

The units that appear within all other nPre input windows will correspond to the units
specified in the Default Units tab, unless the units are specified directly in the input
window. The units for each variable are selected from a drop-down list.

3.1.7 Test Description Tab
The Test Description tab contains a text input box to allow the user to document the test to

be simulated. In practice, it is a good idea to document all tests, as details of a test are
forgotten with time.

3.2 Field Data Input Window

Field data are used by nPre to create model constraints and diagnostic plots. The field
data input window contains an object tree, and its corresponding object property window,
where users can load, view and manipulate field data.
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Figure 16. Field Data Input Window

The Auto Setup->Field Data Plots command (see Section 4.1) is used to automatically create
objects to read/process field data and to create default cartesian plots.

3.3 Sequence Input Window

Sequences are discrete time intervals that divide a testing period, with one sequence
representing a continuous period of consistent well-bore boundary conditions. A series
of sequences allows nPre to consider the cumulative effect of changing well-bore
boundary conditions as well as consecutive well tests. An unlimited number of
sequences may be specified.

There are four types of sequences, each representing a different type of well-bore
boundary condition:

History sequence — Time periods during which borehole pressures or heads are specified
as constant or variable in time since the start of the sequence. History sequences are used
to represent:

1. the time period between drilling and initial shut-in of the test zone

2. time periods where external factors, such as changes in packer pressures, affect
test-zone pressures

3. constant-pressure flow tests

Flow sequence — Time periods during which water is injected or withdrawn from a well.
Flow rates can be constant or variable in time since the start of the sequence. For highly
variable flow rates, a curve file for a single flow sequence is used. For stepped flow
rates, multiple flow sequences with constant flow rates are used. A zero-flow-rate flow
sequence is used to represent:

1. the recovery period following a pumping test
2. time periods immediately after test zones are shut in for the first time
3 pressure recovery under shut-in conditions following constant pressure flow tests

(allows test-zone compressibility to be specified as a fitting parameter).

33

Information Only




Pulse sequence — Time periods during which a test zone is shut in and pressures in the test
zone and the surrounding formation are equilibrating. The initial pressure is specified,
and isolated zone well-bore storage is assumed. Pulse sequences are used to represent
pressure recovery periods following individual pulse injections or pulse withdrawals.

Slug sequence — Time periods during which the injection or withdrawal of a slug of water
from an open well causes changes in well (or tubing string) water levels. The initial
pressure is specified, and open hole (open tubing string) well-bore storage is assumed.
For liquid simulations only.

For history and flow sequences, well-bore storage may also be incorporated into the
boundary conditions. Two types of well-bore storage are available:

Open Hole — A tubing string of constant diameter filled with liquid is assumed to be
connected to the test-zone. For liquid phase simulations only.

Isolated — The test-zone is filled with a compressible liquid or gas.

3.3.1 Time-Base Tab

This tab determines the time-based 'options for defining sequences:

Sequence time entry In Duration mode, the duration of each sequence will
need to be entered as input in the Sequences tab
table. In Srart Time mode, only the start time of each
test sequence will need to be entered. For a
complex series of sequences, Start Time mode will
generally be simpler, as duration times do not need
to be calculated for every sequence.

Start time of first sequence The start time of the first sequence needs to be
specified for both Duration and Start Time mode. Note
that if the time is input before the units are changed,
the time will be converted to the new units.

End time of last sequence The end time of the last sequence only needs to be
specified for Start Time mode. Note that if the time is
input before the units are changed, the time will be
converted to the new units.

3.3.2 Sequences Tab

The Sequences tab contains a table to describe the sequence type, designation and time
period. The format of the table will change depending on selection of duration or start
time mode in the Time-Base tab.

Information Only ~




Sequences should be entered in chronological order. Table rows are inserted, deleted or
duplicated using the commands in the pop-up menus (right click of the mouse).

Type

Designation

Duration [time units]
or

Start Time [time units]

=
2.
&

Sequence Data

Duration [time units]
or
Start Time [time units]

Information Only

Double click on a Type cell to select one of the
available sequence types from a drop-down list:
Flow, History, Pulse, Slug. The different types of
sequences are described in detail in Section 3.3.

Name of the sequence. It is used by objects that
load, manipulate and plot the sequence data. The
default naming convention consists of the first letter
of the sequence type, followed by the order number
for sequences of that type. For example, the first
flow sequence will have a default name of F_01,
and the second flow sequence will have a default
name of F_02.

For duration mode, the duration time is entered in
the cell, and correspondingly, for start time mode,
the start time is entered in the cell. Note that if the
time is input before the units are changed, the time
will be converted to the new units. [time units] in the
table heading are specified in Configuration—Default
Units.

The time units are changed for one sequence by
double-clicking on the corresponding cell and
selecting the desired units from the drop-down list.

Double click on the cell, and a Sequence Setup Dialog
will appear, requiring time step and sequence type
specific information. See Section 3.3.2.1 for a
detailed description of this dialog. ,

For duration mode, Start Time is the table heading,
and correspondingly, for start time mode, Duration is
the table heading. It is automatically calculated,
based on the row above, once the Duration cell
(duration mode) or the Start Time cell (start time
mode) is entered. If the time information of the row
above is changed, this value will only be
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recalculated if the Duration (duration mode) or the
Start Time (start time mode) is re-entered.

>
=
o

A check marked box indicates that the sequence
will be included in auto setup of diagnostic plots
(i.e. Auto Setup->Sequence Plots).

3.3.2.1 Sequence Set-up Dialog

The Sequence Set-Up Dialog (Sequences tab) provides defining details to sequences. It is
sequence type dependent — each sequence type has its own Sequence Set-Up Dialog. The
following example, figure 17, is for a flow sequence.

jFow Sequence Selup Dialog

oo |
1 Time stEp type . - ol
Stotic time step site ferimisees 3 |row =]

1} Total # ctlogtime staps |2$& !
Firstlog time step size R “§ [rowr =

4 Mmimum sme siep site feriresas  pfhow =]

Mammum timo step site |2 TITITRE-D1 § II_@LL_ N E |

4 =
i Flowype iFm -:!!
[ SRR "

| Feedfiow |- §[Usgem  i+]
Semplingfvary data nie z }
Wellbore storage lNgnn - i'lj

Figure 17. Flow Sequence Set-Up Dialog Screen

The first six dialog prompts of the dialog are common to all sequence types. The
availability of these prompts is dependent on the Time step type, either Sratic, Log, Dynamic P
or Dynamic Q. :

The femaining dialog prompts are specific for each sequence type, and specify the
boundary conditions for each sequence type.

For flow and history sequences, the magnitude of the boundary condition is specified in
one of three ways:

Fixed Fixed values are specified in the Fixed flow or Fixed pressure text
boxes.
Range A range of values is specified in the Range Variable Dialog box that

appears upon selecting the Sampling/vary data text box.

Curve Pressure or flow values are described in a curve file. Curve files
associated with the sequence are identified in the TZ Curves tab.
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The type of well-bore storage is also specified for flow and history sequences.

For pulse and slug sequences, the initial pressure is specified, or determined relative to
pressures in previous sequences. The initial or offset pressures are entered in the Pulse
pressure Or Slug pressure text boxes.

Absolute Absolute. The initial pressure is specified.

Tubing String Rel. Relative to the pressure in the tubing string at the end of the last
sequence that affected tubing string water levels. A pressure offset
is specified, that will be added to the tubing string relative
pressure.

Sequence Relative Relative to the pressure at the end of the previous sequence. A
pressure offset is specified that will be added to the sequence
relative pressure.

Test zone thermal conditions are also specified for pulse sequences.

3.3.3 Process/Plot Tab

The Process/Plot tab window is used to create diagnostic plots of pressure and flow-rate
data. The window contains an object tree, and corresponding object property window,
where users can load, view and manipulate data.

Objects and plots of data can be created automatically by the Auto Setup->Sequence Plots
(see Section 4.2) after all sequences are specified. Note that the objects and plots of
simulated data can be created before the simulation has been conducted. Error messages
will appear on the message line, for example “XY data set is empty”. As the simulation
is being conducted, the data sets are automatically updated.

3.3.4 TZ Curves Tab

The TZ Curves tab contains a table to associate sequences with curves from curve files
loaded in the Curve Files tab of the Configuration input window. The curve data describe
the data-type (e.g. flow) as it changes with time, and consequently the data should have
time as the X data, and the data-type for the Y data. The X and/or the Y data may be
transformed by log 10.

Table rows are inserted, deleted or duplicated using the commands in the pop-up menus
(right click of the mouse).

Type The curves file type is dependent on the type of sequence it relates
to:
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Flow
Pressure
Volume Change

Volume

for flow sequences

for history sequences
for history, flow or pulse sequences with isolated well-bore storage

for history, flow or pulse sequences with isolated well-bore storage

Compressibility for history, flow or pulse sequences with isolated well-bore storage

Temperature

Curve 1D

Start Sequence
End Sequence

Curve Data

Time Base

Test

for pulse sequences with non-isothermal test zone thermal
conditions

A drop-down list providing the available curve data from the curve
file loaded as Well-bore boundary conditions in the Curve Files tab of the
Configuration input window.

The starting and ending sequences are selected from drop-down
lists that contain the sequences defined in the Sequences tab. The
curve file may span several sequences. The sequence type of the
sequences selected must correspond with the curve file type.

Double click on the cell, and a TZ Curve Setup Dialog will appear, as
shown in figure 18.

i Test Zone Curve Selup

| o] o
| Tmebase E—
| Y dets units in curve m
] 'vdetaislog10 e
1 Time data units
Time data is log 10 ne l}v.i

Figure 18. Test Zone Curve Setup Window
Determines where time zero begins for the curve data.

Curve time is consistent with test time.

Sequence Time zero is at the beginning of the sequence.

Y data units in curve Units of the Y data (e.g. flow).

Y data are log 10
Time data units

yes if the Y data are log 10 transformed.
For Sequence time bases, units of the Y data (e.g. flow). For
Test time bases, the units are assumed to be the same as
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those defined for the Start time of first sequence in the Time-
Base tab.

Time data are log 10 For Sequence time bases, yes if the X data are log 10
transformed. For 7est time bases, the time data cannot be
log 10 transformed.

3.3.5 Dynamic Time Step Tab

The time step for each sequence is discretized in the Sequences tab, specifically within the
Sequence Set-up Dialog. However, the time step may be automatically adjusted as a
function of the pressure change in the well for history, pulse and slug sequences, or the
flow rate change in the formation for flow sequences.

The Dynamic Time Step tab contains the controls for the automatic adjustment of the time
step. Based on maximum and minimum values, the time step is decreased if the pressure
or flow change is greater than the specified maximum change, and correspondingly, the
time step is increased if the pressure or flow change is less than the specified minimum
change.

The Max # of TS in dynamic sequence dialog prompt controls the maximum number of time
steps that will occur in any one dynamic sequence. The maximum number of time steps
is used for memory allocation only and should not be changed unless run-time errors
occur.

3.3.6 Partial Run Tab

A subset of the defined sequences can be simulated, according to the controls on the
Partial Run tab.

[ Time-Base | © Sequences | ® ProcessiPiot | ® TZ Curves | @ Dynamic Time Step (@ Partial Run | |

Simulation time cdents |p°,|,u Tast EI:
———e e

S‘lnn;oqunnn H_01

End goquenca lF_m j.i > g
e -

R - = e

Figure 19. Partial Run Tab

For a partial run, select Partial Test for the Simulation time extents. The partial Tun is defined
by starting and ending sequences, selected from drop-down lists that contain the
sequences defined in the Sequences tab.

3.4 Parameter Input Window

Non-fitting and fitting parameters, including their value, range or uncertainty distribution,
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are defined in the Parameter input window.

The parameter window is divided into tabs as a means of organizing the parameter list.
The list of tabs and possible parameters in each tab varies depending on the model’s
configuration. Table 3.1 summarizes all the parameters, and the model configuration
under which the parameter is available.

Table 3.1: Model Parameter Summary

Parameter

] Notes

Formation Tab

Formation Thickness

Always required.

Flow dimension

Always required. Refers to the geometry of the flow system. For radial
systems, the flow dimension value is 2.

Static formation pressure

Always required. Units vary depending on Head Solution variable
(Configuration-> Liquid): pressure units or length units.

External boundary radius

Always required.

Formation conductivity

Required for single porosity systems if hydraulic conductivity is to be
entered directly.

Formation permeability

Required for single porosity systems if hydraulic conductivity is
calculated from permeability.

Formation spec. storage

Specific storage. Required for single porosity systems if specific
storage is to be specified directly.

Formation porosity

Required for single porosity systems if specific storage is calculated
from porosity and compressibility.

Formation compressibility

Required for single porosity systems if specific storage is to be
calculated from porosity and compressibility.

Formation klinkenburg factor

Required for gas phase simulations where Klinkenburg effects are
considered.

Fracture — For dual porosity syste

ms only.

Fracture conductivity

Required if hydraulic conductivity is to be entered directly.

Fracture permeability

Required if hydraulic conductivity is calculated from permeability.

Fracture spec. storage

Specific storage. Required if specific storage to be specified directly.

Porosity within fracture

Required if specific storage is calculated from porosity and
compressibility.

Fracture compressibility

Required if specific storage is calculated from porosity and
compressibility.

Matrix — For dual porosity system

s only.

Matrix volume factor

Always required for dual porosity systems.

Geometry factor (Alpha)

Required if the geometry factor is to be entered directly.

Matrix sphere diameter

Required for spherical matrix geometry, if the geometry factor is to be
calculated.

Slab matrix block thickness

Required for prismatic matrix geometry, if the geometry factor is to be
calculated.

Matrix conductivity

Required if hydraulic conductivity is to be entered directly.

Matrix permeability

Required if hydraulic conductivity is calculated from permeability.

Matrix spec. storage

Specific storage. Required if specific storage to be specified directly.

Matrix porosity

Required if specific storage is calculated from porosity and
compressibility.

Matrix compressibility

Required if specific storage is calculated from porosity and
compressibility.

Skin zone — Only if skin zone specified.

Radial thickness of skin

| Always required if skin zone specified.
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Skin zone conductivity

Required if hydraulic conductivity is to be entered directly.

Skin zone permeability

Required if hydraulic conductivity is calculated from permeability.

Skin zone spec. storage

Specific storage. Required if specific storage to be specified directly.

Skin zone porosity

Required if specific storage is calculated from porosity and
compressibility.

Skin zone compressibility

Required if specific storage is calculated from porosity and
compressibility.

Fluid — For liquid phase simulations only.

Fluid Density

Always required for liquid phase simulations.

Fluid thermal exp. coeff.

Fluid thermal expansion coefficient. Only used by non-isothermal
pulse tests.

Gas — For gas phase simulations on

ly.

Atmospheric pressure[abs]

Always required for gas phase simulations.

Gas viscosity

Always required for gas phase simulations.

Gas viscosity slope factor

Required if viscosity is considered as a simple function of pressure
(Configuration->Gas-> Viscosity as f(P)).

Molecular weight

Required if mass flow is the solution  variable

(Configuration->Gas->Gas flow solution variable).

Reference temperature

Always required for gas phase simulations.

Test-zone

Well radius

Always required.

Test-zone compressibility

Required for liquid phase simulations if isolated well-bore storage or if
a pulse sequence is defined.

Volume change from normal

Refers to the volume of equipment in the borehole, i.e. volume of test
interval not occupied by fluid. Required for gas phase simulations, or
liquid phase simulations if isolated well-bore storage or if a pulse
sequence is defined.

Tubing string radius

Required if a slug sequence is defined.

Leaky layer — For single leakage systems only.

Leaky layer thickness

Always required for single leakage systems.

Leaky conductivity

Required if hydraulic conductivity is to be entered directly.

Leaky permeability Required if hydraulic conductivity is calculated from permeability.

Leaky spec. storage Specific storage. Required if specific storage to be specified directly.

Leaky porosity Required if specific storage is calculated from porosity and
compressibility.

Leaky compressibility Required if specific storage is calculated from porosity and

compressibility.

Upper leaky layer — For upper/lower leakage systems only.

Upper leaky layer thickness

Always required for upper/lower leakage systems.

Upper leaky conductivity

Required if hydraulic conductivity is to be entered directly.

Upper leaky permeability

Required if hydraulic conductivity is calculated from permeability.

Upper leaky spec. storage

Specific storage. Required if specific storage to be specified directly.

Upper leaky porosity

Required if specific storage is calculated from porosity and
compressibility.

Upper leaky compressibility

Required if specific storage is calculated from porosity and
compressibility.

Lower leaky layer — For upper/lower leakage systems only.

Lower leaky layer thickness

Always required for upper/lower leakage systems.

Lower leaky conductivity

Required if hydraulic conductivity is to be entered directly.

Lower leaky permeability

Required if hydraulic conductivity is calculated from permeability.

Lower leaky spec. storage

Specific storage. Required if specific storage to be specified directly.

Lower leaky porosity

Required if specific storage is calculated from porosity and
compressibility.
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Lower leaky compressibility Required if specific storage is calculated from porosity and

compressibility.

Numeric Tab

# of radial nodes

Always required. :

Pressure solution tolerance Required for non-linear solutions. Non-linear solutions are required for
gas flow simulations or if parameters are defined as functions of
pressure.

STP flow solution tolerance Required for non-linear solutions. Non-linear solutions are required for

gas flow simulations or if parameters are defined as functions of
pressure.

# of matrix nodes

Required for dual porosity systems.

# of leaky nodes

Required for leakage systems.

# of skin nodes

Required if skin effects are considered.

All the tabs in the Parameter input window contain tables, listing the parameter Name,
Type, Value and Units. Table column widths can be adjusted if necessary, by placing the

cursor on the column title edge until the mouse changes to a double arrow, and then drag,
or by double clicking on the column title, which automatically re-sizes the column.

Name

Type
Constant
Suite
Range
Optimize
Sample
J(P) Points

The parameter name, as listed in Table 3.1.

Determines the treatment of the variable by the model. The
available types are selected from a drop-down list accessed by
double-clicking on the corresponding table cell.

Indicates a non-fitting parameter.

Only available for modes other than range mode. Several values
for the parameter are specified, to a maximum of nine values. A
simulation will be conducted for each value of the parameter. A
maximum of three parameters can by defined as type Suite, the
priority of each parameter defined in the Suite/Range input window.

Only accessible in range mode, a range of values is defined for the
parameter. A maximum of three parameters can by defined as type
Range, the priority of each parameter defined in the Suite/Range
input window. It is similar to Suite type, except for the simulation
mode (i.e. normal mode vs. range mode), and the number of real
values that can be defined in the range (up to 1000).

Only accessible in optimization mode, it indicates a fitting
parameter.

Only accessible in sampling mode, it is a parameter for which a
sample is taken from a defined distribution.

Parameter i1s defined as a function of pressure. The parameter
function is described in the f(p)/f(r) Points Parameter input window.
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Note that parameters cannot be defined as a function of pressure in
dual porosity or leaky systems.

f(P) File Parameter is defined as a function of pressure. The parameter
; function is described in a curve file, which is loaded as an fiP)
parameters file within the Curve Files tab of the Configuration input
window. Note that parameters cannot be defined as a function of

pressure in dual porosity or leaky systems.

f(r) Points Parameter is defined as a function of radius. The parameter
function is described in the f(p)/f(r) Points Parameter input window.

fr) File Parameter is defined as a function of radius. The parameter
function is described in a curve file, which is loaded as an fi{r)
parameters file within the Curve Files tab of the Configuration input
window.

Value For constant parameters, the value is simply input into the
corresponding cell. For non-constant parameters (except f(P) or
f(r) points), double click on the corresponding cell to open the
Value Dialog specific to the parameter Type (see Section 3.4.1). For
parameters of type f(P) or f(r) points, the values are entered in the
f(p)/f(r) Points Parameter input window. If the value input is
incomplete, the parameter Value cell will display BAD. Before
inserting a value, change the Units to the units of the value to be
input.

Units Changed by double-clicking on the table cell, which activates a
drop-down list. Units are as specified on the Configuration->Default
Units tab until they are explicitly overridden by the user. Note that
if the Value is set before the Units are changed, the Value will be
converted to the new Units.

3.4.1 Value Dialog

The Value Dialog depends on the parameter Type. The dialog for each parameter type is
described in Table 3.2.

Table 3.2: Value Dialog inputs based on Parameter Type

Parameter Required Inputs

Type

Suite The dialog contains a table, into which suite values are entered, to a maximum of nine
values.

Range The range of values is defined by specifying the minimum, maximum, and number of steps
between the minimum and maximum values. Stepping is linear or Jogarithmic.
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Optimize The range of possible values is defined by the minimum and maximum, and the
optimization begins with a parameter value set at the best estimate value. The value
stepping to find the next estimate may be linear or logarithmic. The estimate of the
standard deviation is required to calculate Jacobian data, and is used to calculate the
estimated covariance matrix.

Sample The distribution of values is set as Normal, Log-Normal, Uniform, Log-Uniform,
Triangular, or Log-Triangular. - The distribution characteristics are also required, such as
the mean and standard deviation for a normal distribution.

f(P)File/f(r) | The curve to be used is specified by the curve ID. A drop-down list will specify the curve
File IDs available from the parameter curve files loaded in the Curve Files tab of the
Configuration input window. The curve data should have pressure (f{P)) or distance from
the borehole (f{r)) as the X data, and the corresponding dependent variable as the Y data.
The X and/or the Y data in the curve file may be transformed into log 10. The X and Y
variable units are also specified in this dialog.

Note that for the parameter type f(P) Point and f(r) Points, the values are entered in the
f(p)/f(r) Points Parameter input window.

3.5 f(p)/f(r) Points Parameter Input Window

Defines a parameter function for parameters that vary with pressure or radius (distance).
Only accessible if a parameter in the Parameter input window is specified as type f(p)
Points or f(r) Points. It provides the same options available for parameter curve files.

The input window will contain a tab for each parameter defined as f(p) Points or f(r)
Points type in the Parameter input window. Each tab contains at least three tabs: Point
Entry, Interpolation and Units/Transform. In optimization mode, there is an additional
Optimization tab.

3.5.1 Point Entry Tab

The X and Y parameters are entered into a table that varies depending on whether the
simulation mode is forward or optimization. In either simulation mode, X data will be
radius or pressure, depending whether the parameter was defined as a function of radius
or pressure, and Y data will be the dependent variable values.

In the following example of the Point Entry tab, formation conductivity was set as a
function of radius (forward mode):
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Figure 20. Point Entry Tab

In optimization mode, there are two additional columns in the Point Entry tab, OptMin and
OptMax, as shown in the following example:

L R RN T T
] S A A e

XType Radius [m] | OptMin | OptMax YType ] K_fm [mfsec]
<al Fixed 10 n/a n/a Suite! 3vals
Fixed 20 n/al nla Fixed|  1.00000E-09| "

Figure 21. OptMin and OptMax Columns in Point Entry Tab

There are three types of X and Y data, Fixed, Suite, or Optimize, specified by drop-down
lists in the XType and YType columns. Oprimize type is only available in optimization mode.
For Fixed type data, data are simply entered one value per line in the data columns. For
Suite type data, the model run will conduct a separate simulation for each suite value
entered in the Suite Value dialog, which appears upon double clicking the corresponding
cell in the data column:
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Figure 22. Suite Values Entry Menu

A maximum of three parameters, including those defined in the Parameter input window,
can be of type Suite.

In optimization mode, the OpiMin and OptMax columns provide the minimum and
maximum optimization values for each defined point in the X(r) or X(p) function. They
are specified here to ensure that the minimum values of one defined point in the X(r) or
X(p) function does not overlap the maximum value of the preceding defined point in the
X(r) or X(p) function.

Either or both the X and the Y data can be transformed by log 10. If data are transformed
by log 10, it should be specified in the Units/Transform tab.

The units for the X and Y data are also specified in the Units/Transform tab.

Table rows are inserted or deleted using the right click pop-up menu.

3.5.2 Interpolation Tab
The interpolation tab has the same options as the Create Curve from XY Data object.
This is not surprising, since the f(p)/f(r) Points Parameter window has a purpose similar to a

curve file.

Details of the interpolation options are described in full in Section 7.1.5.

3.5.3 Units/Transform Tab

The Units/Transform tab determines the units of the data input into the Point Entry tab. An
option is available to specify if data are to be transformed by log 10.
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Figure 23. Units/Transform Tab

3.5.4 Optimization Tab

Only available in optimization mode, the dialog in the Optimization tab is similar to the
Optimized Value Dialog of the Parameter tab.
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Figure 24. Optimization Tab dialog, only available in Optimization Mode
For a description of the dialog options, refer to Section 3.4.1.

Dialog inputs are available for both the X and Y optimization parameters. Note that X
maximum and minimum values are entered in the Point Entry tab.

3.6 Simulation Output Input Window

3.6.1 Main Tab

The Main tab of the Simulation Output input window defines the output to be calculated by
the model. It consists of a table where the type of output is defined:

47

Information Only




ol B T T B

e e e e ettt S S -]

D Type Sub-Type Radius | RadiusUnits | Output Uni'rs’i‘ ,,
sPDAT (Pressure Test Zone n/a n/a kPr i i
sQDAT  |Flow Well nfa n/a us@ji.‘, i

-

bolaJeln]-

G SR, R N R |

Figure 25. Main Tab of Simulation Output Window

1D The output ID identifies the data type. A default ID
is automatically given upon selection of the output

type.
Type, Sub-type Determines the type of output to be calculated:

Pressure
Test Zone Pressure in the well-bore.
Observation Well Pressure at a specified distance from the well-bore.
The specified distance is input in the Radius column.
Superposition Sums pressures at specified radii. Superposition
radii and options are input in the Superposition tab.

Flow

Well Flow into or out of the well, including Formation, '
Test-zone and Well-bore storage flows. For flow
sequences, the well flow is specified.

Formation Flow into the well-bore from the formation, or out
of the well-bore to the formation. Test zone and
well-bore storage flows are not included.

Test Zone Flow in the well-bore due to volume changes in the
test-zone.

Well-bore Storage Flow due to well-bore storage. For example, a
pressure change will generate flow from the well-
bore storage due to the change in the
compressibility of the liquid or gas.

Production Integrated flow rate (i.e. total volume). Same sub-
types as Flow.
Other
TZ Temp. Temperature in the test zone. Simply echoes
variable test zone temperature curve data.
' 7Z Comp. Compressibility in the test zone.
TZ Volume Volume in the test zone.
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Radius Determines the radius from the well-bore at which
pressure will be output.  For Pressure type,
Observation Well sub-type only.

Radius Units Units of the radius are selected from a drop-down
list.

OQutput Units Units for the output are selected from a drop-down
list.

Table rows are inserted, deleted or duplicated using the right click pop-up menu.

3.6.2 Production Restart Tab

For production output, the production integration can be restarted at specified times. The
specified times are input into the provided table.

3.6.3 Superposition Tab

Only for pressure superposition output type, the Superposition tab provides a table to input
radii at which pressures will be summed, and related options, shown in figure 26.

(© Main | ® Production Restart (¥ Superposttion] ____
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Figure 26. Superposition Tab

Depending on the Type, data are entered into the Radius column. For a Constant type, a
single value is input into the Radius column. For Oprimize, Suite/Range, and Sampled, a Value
Dialog will appear upon double-clicking the corresponding Radius cell. The inputs to each
Value Dialog are described in Section 3.4.1. Note that Oprimize, Range and Sampled Value
Dialogs are only available for optimization, range and sampling modes, respectively.

The Qperation column determines whether the pressure at the specified radius is added (+
Pressure) or subtracted (-Pressure), or whether the pressure change from static formation
pressure at the specified radius is added (+ dPressure) or subtracted (-dPressure).

3.7 Fit Specification Input Window

In the Fit Specification input window, field and simulated data are paired for regression
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analysis. The pairing of field and simulated data indicates the field data to which the
model should fit simulation results. Generally, the constraints defined in the Field Data
input window are compared to the corresponding simulated data constraints defined in
the Process/Plot tab of the Sequence input window. The Fit Specification input window is
only accessible for optimization mode or forward-range mode.

Auto Setup->Basic Fits is available to generate the fitting objects. It uses data processing
objects previously generated with Auto Setup->Field Plots and Auto Setup->»Sequence Plots as
the pairs of data for fitting.

3.7.1 Fit Specification/Graphics Tab

The Fit Specification/Graphics tab contains an object tree for fit specification objects. These
fit objects pair field and measured data, but do not indicate which data pairs should be
used as constraints by the model. The selection of data pairs as constraints is controlled
in the Fit Selection tab.

There are three fit specification objects: Single Fit, Composite Fit and Sequence Fit.
These objects are described in Appendix A.

The following example shows the fit specification objects with incorrect object properties
status (), due to empty model data set. Once the model is run, the data set will no
longer be empty, and the fit object status will be normal.
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Figure 27. Fit Specifications / Graphics Tab

3.7.2 Fit Selection Tab

Once field and simulated data have been paired in fit objects within the Fit
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Specification/Graphics tab, the fit specifications to be used as constraints are selected in the
Fit Selection tab.
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Figure 28. Fit Selection Tab

Fits are selected by checking the Optimize checkbox, and selecting the appropriate fit
specification object in the drop-down list. The AutoFill button will automatically select all
the created fit objects.

Each line of the Fit Selection tab indicates an independent optimization. Consequently, if
more than one line is selected, the simulation will conduct a multiple fir. To optimize
several parameters in one optimization (or single fir), use the Composite Fit object in the
Fit Specification/Graphics tab to combine several Single Fit, Sequence Fit and/or
Composite Fit objects.

3.8 Optimization Input Window

In the Optimization input window, a fitting algorithm for optimization mode simulations is
selected, and algorithm options specified. The input window is only available for
optimization mode simulations.

Two inverse-fitting algorithms are available: downhill simplex and Levenburg-
Marquardt. For most problems, either algorithm may be used. The downhill simplex
algorithm is slower to use than the Levenburg-Marquardt algorithm, however the

downhill simplex algorithm will generally converge to a solution regardless of the initial
estimates of the fitting parameters.

Parameters are normalized to a value range of 0 to 1 before optimization.

3.8.1 Main Tab

Within this tab, basic algorithm options are selected, as shown in figure 29.
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Figure 29. Main Tab of the Optimization Input Window

Algorithm

Calculate confidence limits

Covariance matrix calculation

Ist Order

2nd Order

Fixed deriv. span in covariance calc

Fixed span

Multiple fit start point
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The  Simplex or Lev-Mar (Levenburg-
Marquardt) algorithms are discussed in
Section 3.8.

Confidence limits are calculated from the
covariance matrix. The covariance matrix
will not be calculated unless this toggle is
set to yes.

Ignores the second derivative terms of the
Hessian matrix (used in the calculation of
the covariance matrix). Requires less
simulations and guarantees a positive
definite Hessian matrix.

Strictly correct formulation of the Hessian
matrix.

Derivative span in covariance matrix
calculation may be fixed within the Fixed
Span input box, or may be calculated using
an iterative procedure.

Value is entered if derivative span in
covariance calculation is fixed.

For multiple optimizations, all optimizations
after the first optimization can start with
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parameter values based on the original best
estimate specified for the parameter, or the
last result values from the last optimization.

Update best estimates If yes, the best estimates in the parameter
tables of the Parameter input window will be
updated with the final optimization values.

3.8.2 Tolerances Tab

Within this tab, tolerances are set, in addition to the maximum number of simulations.
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Figure 30. Tolerances Tab of the Optimization Input Window

Optimization is complete once tolerances have been met. Both optimization algorithms
have a Parameter tolerance, and the Levenburg-Marquardt algorithm has an additional
tolerance specified in the L-M Algorithm tab.

In calculating the covariance matrix, an iterative procedure is used to calculate the
derivative span (if the derivative span is not fixed in the Main tab). The derivative span
has been successfully calculated once the Derivative adjustment tolerance has been met.

3.8.3 L-M Algorithm Tab
This tab provides options for the Levenburg-Marquardt algorithm.

Lambda is a step parameter used to generate new estimates of parameters. The smaller the
value of lambda, the greater the step change. During optimization, lambda is increased if
the new parameter estimates did not improve the fit, and decreased if the new parameter
estimates improve the fit. To control the lambda factor, the following options are
available: Lambda factor multiplier, Initial lambda factor and Minimum lambda factor.

In addition to lambda, the derivative of the fit component function is used to generate
new estimates of parameters. The Maximum derivative span limits the span of the derivative,
as large spans increase the difficulty in converging towards a solution.

As previously described in Section 3.8.2, an additional tolerance is required for
optimization to be complete in the Levenburg-Marquardt algorithm: the Relative change
tolerance.
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3.8.4 Simplex Algorithm Tab

This tab provides options for the downhill simplex inverse-fitting algorithm.

Initial vertex span The vertex span is used to generate the initial simplex.
Initial derivative calc span Provides the initial derivative span used in the calculation

of the covariance matrix.

3.8.5 Perturbation Tab

Running optimization perturbations is one method of investigating parameter uncertainty.
In perturbation mode, nPre randomly perturbs the initial estimates of fitting parameters
(i.e. slightly increases or decreases the initial estimate) and re-optimizes the fitting
parameters. nPre repeats this process for a specified number of perturbations. If each
perturbation results in a fitting parameter value close to the initial estimate, the problem
solution is unique and well-constrained. Note that perturbation mode is not currently
compatible with optimization-range or optimization-sampling modes.

Do optimization perturbations Check the checkbox to activate perturbation mode.

# of perturbations The number of random perturbations within the
perturbation span.

Perturbation span The maximum span over which perturbations will be
created. Note that all parameters are normalized to a range
of 0 to 1, and consequently the perturbation span will be
between 0 and 1.

Perturb from The first perturbation can use the original best estimate
value (Srarr) or the last optimization value (Last Fir) for its
initial estimate of parameters.

Random # seed A user-selected random seed number allows perturbation
simulations to be reproducible.

3.9 Sampling Input Window

The Sampling input window contains options related to the setup of the sampling of a
parameter. Note that sampled parameters may include sequence data, such as flow rate or
pressure boundary conditions, and superposition distances. The ranges and distributions
are defined at the point of parameter or sequence definition, in the Parameter and Sequence
input windows, respectively.
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3.9.1 Main Tab

The Main tab defines the sampling procedure:
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Figure 31. Main Tab of the Sampling Input Window

Sampling procedure NSIGHTS supports two sampling routines: Latin Hyper-Cube and Monte-

Number of trials

Random number seed

User specified variable correlations

yes

No

Force non-specified correlations to 0.0

yes

No

Sample
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Carlo

Number of times input parameter distributions are
sampled.

A user-selected random seed number allows
sampling simulations to be reproducible. A random
seed number is automatically provided.

The correlation between two variables will be
forced to the values specified in the Correlations tab.

Correlations, if not forced to zero, will be
calculated during simulation.

Non-specified correlations will be forced to zero. If
correlations are not user specified, all correlations
will be forced to zero.

Non-specified correlations will not be forced to any
value, and will be calculated during simulation.

This button re-samples the parameters, based on the
current setting in this tab. Any objects or plots
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containing sample data will be updated with the
new sampled data.

3.9.2 Correlations Tab

If more than one parameter is defined as a sampled type, a correlation between the
parameters is forced to the value specified in the tables provided in this tab. This tab is
only available if variable correlations are user specified (User specified variable correlations in
the Main tab).
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Figure 32. Correlations Tab of the Sampling Input Window

Parameter correlations can only occur between variables of the same basic type.
Consequently, the Correlations tab is divided into four tabs (Parameter, Sequence Q,
Sequence P and Superposition R), each tab providing a table for the input of correlations.
Tabs are hidden if there are less than two parameters for any parameter category.

3.9.3 Samples Tab

This tab contains a table of the sampled parameter values, with a column per parameter,
sequence or superposition distance. The parameters are re-sampled upon activation of
this tab. In the following example, 10 trials are defined for the formation conductivity:

1 |2.9440891E-09 i
2 [1,6941906E-09 ‘
3 |5.4436779E-10
4 |4.4533507E-09
5 |65267687E-09
6
7
8
9

55488796 E-09 )
3.3937244E-09
7.3009359E-09

8.7039046E-09
10(9.7837555€-09

e —— ? o)

Figure 33. Samples Tab of the Sampling Input Window
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3.9.4 Graphics Tab

The Graphics tab contains an object tree, and corresponding object property window,
where users can load, view and manipulate data to create visualizations of sample
correlations. Sample data are available as table data, with the object ID of Sample.

3.10 Suite/Range Input Window

3.10.1Priority Tab

The priority of each suite and range parameter is determined in this tab and input
window. For both suite and range parameters, the simulation program loops through the
first parameter (Grid/Cube X (slowest grid/cube)), and for each value in its suite or range,
it then loops through the second parameter (Grid/Cube Y (fastest grid/middle cube). If
three suite/range parameters are defined, for each value of the second parameter, the
simulation program loops through the third parameter (Cube Z (fastest cube)). For each
combination of suite/range values, a simulation is performed.

3.11 Output File Setup Input Window

Output files from nPre can be read into nPost for visualization and post-processing. The
output files are all binary.

Four output files can be created, each with its own tab:

XY Output Any XY array (a collection of XY data) created within nPre is
output into a file with the default file extension *.nXYsim. The
default XYDataArray f{1) Table Global consists of all the simulation
output defined in the Main tab of the Simulation Output input
window. Not available in range mode.

Profile A grid containing pressure as a function of time (X axis) and radius
(Y axis) is output to a file with the default file extension *.nPro.
The grid can contain a subset of time, by limiting the number of
sequences. As grid data can be quite large, the data may be
reduced according to a Time step modulus, reducing the number of X
(time) points, or a Node modulus, reducing the number of Y (radius)
points. Available in forward-normal mode only.

Range Outputs grid or cube data of residuals (error between simulated and
field data) into a file with the default file extension *.nRng. In
optimization mode, grid or cube data of optimized values and the
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main diagonal of the covariance matrix (if calculated) are also
written to the file. If two range variables are defined, grid data are
output, if three range variables are defined, cube data are output.
Available in range mode only.

Optimization Fit results, residuals, covariance matrix and Jacobian data are
output to a file with the default file extension *.nOpt. Available in
optimization-forward or optimization-sampling mode only.

To write the file during simulation, check the checkbox at the top of each tab. For all
output files, data are created in a new file, or appended to an existing file. Data can only
be appended to an existing file if:

e The current run is the same mode as the runs existing within the file (e.g. all runs
within the file are forward-normal).

¢ The data to be output for the current run is the same as the data output for the existing
runs (e.g. all runs within an appended file write the XYDataArray f(t) Table Global,
with the same simulation output defined).

For files containing appended data, each run is identified by the Run identifier. Within
nPost, the data for any one run can be selected, with each run identified by its run
identifier. For runs with multiple cases (e.g. sampling mode runs, multiple fit
optimizations), each case will have an identifier in addition to the run identifier.

3.12 Processing Setup Input Window

To create plots to monitor the real-time progress of the model and write simulation
output, the Processing Setup input window contains an object tree, and its corresponding
object property window. Objects can load, view and manipulate model data.

Simulated data sets can be created before the simulation has been conducted. Error
messages will appear on the message line, for example “XY data set is empty”. As the
simulation is being conducted, the data sets are automatically updated.

A plot window is not automatically updated during the simulation. Addition of an object
that forces the plot to update regularly must be used, such as a Data Label object with
the last fit value as input.
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4 NPREAUTO SETUP ‘

As the setup of certain portions of the input data and plots are similar from test to test,
auto setup provides a quick way of generating certain input data and plots. There are
three Auto Setup commands: Field Data Plots, Sequence Plots, and Basic Fits.

All auto setup commands create objects within object trees, and there are common
aspects between the auto setup procedures:

Auto setup is created in a tree structure, however input is still required from the user.
The user must specify the input data, and input any required options in processing
objects (e.g. Scale/Transform objects).

Data and plot pages are created with a default naming convention for the page or

object IDs:

e The type of data are specified with a letter: Q for flow data, P for pressure data, f
for field data, s for simulated data. The name of a sequence will also be used in
the default name, if applicable.

e The type of operation occurring within the page or object is also specified: Input
for pages that read data, DAT for objects that read or extract data, Process for
pages and objects that process data, Diag for diagnostic plot pages. For some
process objects, the process occurring (e.g. dP/dInt) is specified.

e Examples:

P_input Object ID of a data page containing a read object
for pressure data.

fQDAT000 Object ID of a read data object reading field flow
data.

F_01_fdP/dInt Object ID for an object that calculates the derivative
of field data pressure for a flow sequence named
F 01.

log F_01_sPDAT Object ID of a Scale/Transform object that
' conducts a log transform on the simulated pressure
data within flow sequence F_01.

All plot pages will contain:

e A Data Labels object that plots a label containing the current date and the nPre
version info in the top right hand comer of the plot.

e A Data Labels object that plots a label containing the progress of the optimizer.
This object forces the plot to be updated during a simulation.

e A User Labels object that plots a default title label.

Only 2D plots are created in auto setup procedures. The user will be required to reset
the axes limits in order to view the data in a 2D plot window. This is done by
selecting Axes>Extents in the 2D plot window pop-up menu, by selecting the Reset

View button () in the 2D Plot window toolbar, or by selecting Standard->Reset View

59

Information Only




in the 2D Plot window menu bar.

Auto setup results should always be checked to ensure that the created pages and objects
use the correct input data and the correct data transformations.

4.1 Field Data Plots Auto Setup

Selection of the Auto Setup command Field Data Plots will create data and plot objects
within the Field Data input window’s object tree that are typically required to create
constraints and/or diagnostic plots from field data.

Only two sets of data and plot pages can be created, one for pressure data, and one for
flow data. Selection of the Auto Setup->Field Data Plots command can create one or both of
these data sets at a time. If a data set is created again by auto setup, and the data sets
already exist, they will be deleted, and new empty pages and objects will be created.

A dialog to facilitate the auto setup of field data plots provides the following options:
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Figure 34. Auto Field Data and Plot Setup Window

Data to Read

Input File Type

All in Same Table File

Pressure and/or Flow data sets are created. For each data set,
a data page is created with one read object. The user will
need to specify the field data to be imported with the read
object(s). For table input data, an additional Select XY
from XY Array object is created, to select XY data from
the table.

The input file type, XY data or table data, is selected in the
dropdown box. This option determines the type of read
object created in the input data page.

For table input, if both pressure and flow data sets are being
created, this checkbox creates one read table object to read
a table which contains both pressure and flow data, and two
select XY objects. The read table object will be in one data
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input page, named PQ_Input.

Processing If one of the processing options is selected, a new data page
is created, containing the object(s) required to complete the
data processing. The user is required to complete the
processing options for each processing object (refer to
Appendix A for details on each processing object).

Remove Dups To remove duplicates in the data, a Remove Duplicates
object is created.

Reduce To reduce the data, a Reduction object is created.
Scale/Transform To scale or transform the data, a Dual XY S/T object is
created.
Plots to Create Selection of either the Pressure or Flow checkbox will create

a 2D-XY plot page, containing two objects:

o An XY Data Series object to plot transformed data, as
well as simulated data.

e A Sequence Grid Lines object, which will plot
gridlines to define sequences.

The example below, figure 35, shows the Auto Field Data and Plot Setup dialog and the
resulting object tree after auto setup:
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Figure 35. Auto Field Data and Plot Setup & Corresponding Object Tree
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4.2 Sequence Plots Auto Setup

Selection of the Auto Setup command Sequence Plots will create data objects and plot
objects within the Process/Plot tab of the Sequence input window that are typically required
to create diagnostic plots of simulated data sets. As well, a Create XY Array object,
containing the simulated output defined in the Process/Plot tab of the Sequence input
window, will be created in the Processing Setup input window.

Auto setup cannot be selected until sequences have been defined in the Sequences tab of
the Sequence input window.

The Sequence Data and Plot Setup dialog, which appears upon selection of the Auto
Setup->Sequence Plots command, contains frames for each type of sequence containing
checkboxes for common diagnostic plots. The frame and checkboxes for sequence types
not defined will be hidden.
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Figure 36. Automated Sequence Data and Plot Setup Window

No diagnostic plots for a sequence type will be created unless the Extract checkbox is
selected. Each plot to be created is then selected with a checkbox. Plots are only created
for a sequence if the Auto checkbox is selected for the sequence in the Sequences tab of the
Sequence input window.

Each diagnostic plot option will create a data page and a plot page for all applicable
sequences with the Auto checkbox selected. The data page will include two Extract
Sequence(s) objects, one for field data and one for simulated data. The user is required
to specify the applicable field and simulated data, but the correct sequence has been
automatically chosen.

All sequence types have an Analytic on plots checkbox, which is only active if at least one
diagnostic plot has been selected from that sequence type. This option adds an Analytics:
Line Data object to all 2D plots for that sequence type, allowing the user to create a
straight line on a plot interactively. A corresponding legend box on the 2D plot, showing
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the analytic line results, is also created using a Data Labels object.

Table 5.1 provides the available diagnostic plots, and a brief description.

Table 5.1: Auto Setup Sequence Diagnostics Plots

Flow Sequences

Standard Diagnostic Plots field and simulated pressure data, as well as the derivative of the data
(dP/dInt) in a 2D XY plot.

FD Diagnostic For both field and simulated data, plots 2*dlogP/dlogt” +2.

History Sequences

Decline Plot Plots the field and simulated flow data on a 2D XY plot.

Diag #1 Plot For both field and simulated data, plots 2*d"logQ/dlogt” +2.

Diag #2 Plot For both field and simulated data, plots 2*dlog(1/Q)/dlogt” +2.

Pulse and Slug Sequences

Ramey A Plot Plots normalized pressure and the derivative of normalized pressure (dP/dlogt)
for both field and simulated data.

Ramey B Plot Plots normalized pressure and the derivative of normalized pressure (dlogP/dlogt)
for both field and simulated data.

Ramey C Plot Plots (1-normalized pressure) and the derivative of (l-normalized pressure)

__| (dlogP/dlogt) for both field and simulated data.

Ramey FD Plot Plots two times the derivative of normalized pressure (2*dlogP/dlogt) for both

field and simulated data.

4.3 Basic Fits Auto Setup

In optimization mode, the Auto Setup>Basic Fits command will create fit data objects in the Fit
Specification/Graphics tab of the Fit Specification input window, as well as to define fits to use in the
Fit Selection tab of the Fit Specification input window. The Auto Setup>Basic Fits command is not
available until sequences have been defined.

The Fit Specification Setup dialog, which appears upon selection of the Auto Setup>Basic Fits
command, contains frames for each type of sequence containing checkboxes for possible fits for
that sequence type. The frame and checkboxes for sequence types which have not been defined
will be hidden. In addition, there is a Cartesian Fits frame, with associated checkboxes, which will
produce fits for all defined sequences (the entire test).
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Figure 37. Fit Specification Setup

No fit objects will be created for a sequence type or Cartesian Fits unless the Fit checkbox is
selected. Each fit to be created is then selected with a checkbox. Fit objects are only created for a
sequence if the Auto checkbox is selected for the sequence in the Sequences tab of the Sequence
input window.

For each sequence type selected (i.e. Fit is checkmarked), a data page is created. The data page
will contain a Single Fit object for each type of fit specified in the checkboxes. The checkbox
Combined will combine all the single fits defined for each sequence type into a Composite Fit
object.

For Cartesian Fits, two Extract Sequence(s) objects will be created for both field and simulated
data, in order to extract all the sequences for the Single Fit object. The user is required to specify
the applicable field and simulated data, but the correct sequences have been automatically
selected. Extract Sequence(s) objects are not created for any other sequence type, as it is
assumed that Auto Setup - Sequence Plots has been previously conducted, and the output from the
Extract Sequence(s) objects created in the Process/Plot tab of the Sequence input window will be
used as required.

The type of fit (e.g. log Pressure in Flow Sequence Fits) refers to the data transformation of both field
and simulated data before input into a Single Fit object. If the data transformation was not
already conducted in the Process/Plot tab of the Sequence input window, Scale/Transform objects
will be created for both field and simulated data to perform the data transformation required.

In addition to the creation of fit objects, auto setup will fill the Fit Selection tab, in a manner similar .
to pressing the Auto Fill button. All fits created will be included, one per line in the Fit Selection
tab. If composite fits were created, the single fits of those composites will not be included.
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5 RUNNING SIMULATIONS

Once all required input has been entered, a model run can be executed by selecting one of the
following commands from the Run menu:

Minimal Conducts a full model run, with a small window providing minimal
information.
Verbose Conducts a full model run, with a small window providing detailed

information. The information provided is dependent on the simulation
mode. For example, in optimization mode, the best fit value and the
current fit value are shown for each parameter to be optimized. Due to the
detailed information, a verbose model run will have a slightly increased
execution time compared to a minimal model run.

Covariance Only Calculates the covariance matrix using the current set of defined
parameters, without conducting any simulations. Only available for
simulation modes that calculate the covariance matrix.

The following three figures are examples of the run window for an optimization model run with
multiple fits. The title of the run window indicates the current case and/or fit of the simulation.

Run=>Minimal
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Figure 38. Minimal Run Simulation
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Figure 39. Verbose Run Simulation

Run=>Covariance Only
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Figure 40. Covariance Only Run Simulation
Dialog buttons and information displayed on all the run windows include:
Cancel Cancels the run.
Minimize Minimizes the main menu, as well as the run window. Plot

windows remain visible, in order to observe changes in the plots
during the run.

Time elapsed Time elapsed since beginning of the run.

Est. time remaining Estimation of the time remaining for the run is only displayed once
the first case is complete. For runs with single cases, it will not be
displayed.

Progress Bar For runs with multiple cases (e.g. multiple fit optimizations,

perturbations, etc.), a progress bar is provided that indicates the
number of cases completed.
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6 OBJECTS

An object has a defined function related to data input/output, data manipulation, or plot
construction. A fundamental premise in nSIGHTS is that objects can be combined in many
flexible ways to produce a near-infinite variety of data processing procedures and visualizations.

Each page type has associated objects, specifically data objects, plot objects, list objects and
output objects. In addition, there is a global object, described in Section 6.4. However, all objects
have similar characteristics and controls, which are described in this section.

6.1 Object Data Types

Most objects use the output of other objects as their input. Objects may also use the output of the
nPre simulator as input. Only object output of a compatible data-type can be used as input. For
example, a Table Column Scale/Transform object can only use table data-types as input. With
the nSIGHTS user interface, input objects are selected from drop-down menus that contain the
names and descriptions of all available object output of the correct type. The following table
provides a brief explanation of data types used by nSIGHTS:

Table 6.1: nSIGHTS Data Types

Data Type Description

Color Map An array of colors, usually smoothly varying.

Covariance Data Calculated covariance matrices.

Cube Data A data structure with values at regular array XYZ locations.

Cube Indices Indexes representing the location of each value within cube data.

Curve Data X and Y values that define a function. Input XY data and function characteristics are

included in the data structure.

Fit Specification

Pairs of field and simulated data.

Grid Data A data structure with values at regular array XY locations.
Jacobian Data Calculated Jacobian results from optimizer.

Pen Set 24 specific colors

Real Value A single numeric value.

Sequence Time Data

Sequence start/end times and 1Ds.

Table

Rows and columns of numeric data. Each row and column also has an associated ID.

Time Value A numeric value associated with a time setting. All time values are also real values.
XY Array A collection of XY data.

XY Data X and Y values.

XYZ Label XYZ co-ordinates and associated text labels.

6.2 Object Concepts
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6.2.1 Object ID

Every object that is created has an associated identifier or ID that is used to refer to the object
within the nSIGHTS user interface. The ID is always located in the upper left hand corner of the
object property window. All objects have a default ID, usually the name of the object, although
some objects automatically change the default based on object properties.

You should usually modify the object name so that a) it is unique, and b) it reflects your usage of
the object. A unique object name is important to distinguish object output, while a relevant object
name makes it easier to understand complex visualizations containing many objects.

6.2.2 Object Selection

Nearly all nSIGHTS objects require input from another object. Within the object property
window, these input data are selected using a drop-down menu. When not active, the drop-down
menu shows the current object selection.

The drop-down menu box is activated by pressing the down arrow. After activation, a list of
objects producing output of the correct data type is displayed, figure 41.

EODAT s0DAT 0utput
POAT POAT P_lnput Fiald Data
F.o F_01_fPOAT F_01_process Sequence

_n F_01_sPDAT F_01_process Sequence
F_01_tdP/dim F_01_fdP/dint F_01_process Sequonce
'_01_sdPydint F_01_sdP/din F_01_procoss Sequence
og input log_F_01_tPOAT F_D1_fit Fit Specfication

og Input log_F_01_sPOAT F_01_fit Fit Speaficaton
Resid F_01_logP F_01_ft Fit Speafication

F_0i_logP F_01_fit Ft Spacification
og input log F_01_tdP/dint F_D1_fa Fit Specfication
og input log_F_01_sdPjdim F_D1_f Fit Specfication
Fisicl F_01_log dP F_O1_ft Fit Specification

F_01_togaP E 01 ft Fit Spedficotion |

Figure 41. Object Selection List

The listing in the drop-down menu contains:

e the object type (or output ID if there is more than one output of the same type from a single
object)

e the object ID of the associated object

e the name of the page where the object is located, only if the objects available are from more
than one page

e innPre only, the nPre object tree where the page is located

6.2.3 Object Connections
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The input/output connections between objects are viewed by selecting the Connections command in
the Object menu. This command will display a text top-level window that provides information on
the connections of the currently selected object: the objects used as input, and the objects which
use the currently selected object’s output as input. '

Similar to object selection, each object is defined by:

e the object ID

¢ the object type (or output ID if there is more than one output of the same type from a single
object)

e the name of the page where the object is located

e in nPre only, the nPre input window where the page is located

e a number indicating the order the object was created, relative to other objects (i.e. the first
object created in the current application will be #1, the second object created will be #2, etc.)

An example of a connection window for a P(t) Derivative Calculation object, named
F _01_fdP/dint created in the F_01_process page of the Sequence input window, is provided below
in Figure 42:

oupit Vew o * - s ¥ e 3
&4 g Wi st 2 T w Bl
i 2
I F_01_fdP/dInt::Derivative::F_01_process::Seq #35 i{
{  Input From il
F_01_fPDAT::ExtractSequence::F_01_process:Seq#33 ;f”
Output To ¥
dinP:: XY Data::F_01_diag::Seq #40 iz
log F_01_fdP/dint::XY S/T::F_01_fit:Fit #45 i
'
E

Figure 42. Connection Window for a P(t) Derivative Calculation Object

Based on the example object connections window, F'_0]_fdP/dInt was the 35™ object created in
this nPre application. It uses as input an Extract Sequence(s) object, named F_0]_fPDAT, from
the same page. F_0] fPDAT was the 33" object created in this nPre application. Two objects use
the F 01 _fdP/dint object output as input: an XY Data Series object, named dinP, from the
F 01 diag page in the Sequence input window, and a Single Scale/Transform object, named
log F 01 fdP/dint, from the Constraints page in the nPre Fit Specification input window.

Note that the object name used in the connections page relates to the object identifier within the
object tree, which may differ from the object name in the Object menu (see Appendix E for tables
of alternative object names). All object names used within this manual refer to the object name
used in the Object menu.
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The connections for all objects within the currently selected page are similarly viewed by
selecting Page->All Connections.

6.2.4 Object Execution

The nSIGHTS architecture includes an object execution algorithm that ensures objects are re-
calculated as required. For example, changing the scale in a Scale/Transform object will cause
all objects using the resulting data to be re-calculated and all plots dependent on those objects to
be re-drawn.

The algorithm used to determine execution is fairly straightforward. A tree is built based on inter-
object references. Tree connections are viewed using Object->Connections or Page->All Connections
as described in Section 6.2.3. The tree is traversed in such a manner that all input data to an
object is re-calculated before an object is re-calculated.

An error occurs when a circular reference is detected: i.e. object A depends on object B for input,
but the object B also depends upon object A. In this case, nSIGHTS will issue a non-fatal error
message of the form ObjCalc - Non-blank object not found - circular reference.

6.2.5 Object Errors

Object errors are errors due to input or object property settings. Before an object is executed, its
input objects and internal properties are checked. If a problem is detected, an error message is
displayed in the message line portion of the screen. The error message will contain the name of
the object causing the error and the error. The error must be corrected before execution can
continue.

The object icon of an object with an error will be modified to reflect the object's status (i.e. the
icon will appear as ® or #). Once the error has been fixed, the object icon will return to
normal status (¥ );

Another type of error message causes a dialog to appear with the title nSIGHTSInternalError and a

(usually cryptic) error message. Subsequently, nSIGHTS will abort. This is indicative of a bug.
Occurrences of these errors should be reported to the author.

6.3 General Object Controls

6.3.1 Masters and Slaves

Master and slave capabilities allow the internal settings of one object (the master) to control those

Information Only "




of another object (the slave). In many cases, data processing objects and visualizations are created
that may contain several instances of a set of object properties. In many cases, we want to
compare these objects, and consequently they need to have the same object properties. For
example, to compare the derivative of pressure for field data and model results, two P(f)
Derivative Calculation objects are required, one for each set of data. Both derivative objects
should have the same derivative options. To facilitate the comparison, the master and slave
facility allows the user to modify the object properties of only one object (the master), and the
slave object properties will be automatically adjusted accordingly.

- For example, the two P(t) Derivative Calculation objects described above could be linked as
follow:

1) A P(t) Derivative Calculation object for the field data derivative calculation is created:
the Object ID is set to dPField, the pressure field data source is selected, and the
appropriate derivative options selected. By default, the object will be a master (i.e. the
Master toggle is turned on).
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lg 0 _IdP/d 1I]F e:s m _POATF ln_promtsmrru I=]
- Dervatve Spect 7 = |
r—juam S;M.., = [.Clam'ewlF n .WMLSW__H
T Garaive Type ST Donvaive Calciaion o C e
s, [avrania w‘lj” ILuq%Spun ] “ . Cak =]
=% aninte st Vifidcw! Log Epsilor : < 1
s |I_A-”‘ . qunsas ’—“- [V oooe -ﬂ!l ..3‘.
-LinfLog % Span Value Source —— - \.iM.w’sSomvolw#——-—---
PjMst . TYE e O E “ Ioo i
] JExp ILosumwwsump pumnﬂ]. i j
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Figure 43. P(t) Derivative Calculation Object with Master toggle turned on.

2) Another P(t) Derivative Calculation object for the model results is created: the Object 1D
set to dPModel, and the model data source is selected. The Master toggle is turned off, and
the dPfield object is selected from the drop-down menu.
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Figure 44. P(t) Derivative Calculation Object with Master turned off.

Master/Slave capability is available for most object properties where property variation is likely to
be required. There are two variations of the master/slave dialog frame depending upon the
window layout. Both variations are shown in the object property of the P(t) Derivative
Calculation object shown in the above example, and are shown in detail here, in figure 45:

FBemveive Speciicaton———

P, Master o Slevnts [Daveive F_01_saPpdin Sequl=] |
——— T e — T

3 SR Valie SEure

Enst  Dibp [=stPerutSampls Gpunmrir=])

Figure 45. P(t) Derivative Calculation Object Variations
Note that many master/slave controls also contain an Expose toggle. Selecting the Expose toggle

will create an exposed version of the control as described in Section 6.3.2. Only master controls
can be exposed. '
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6.3.2 Exposed Controls

One drawback to the object property window of the nSIGHTS user-interface (UI) is that it is
difficult to rapidly change properties of a plotted object or two objects. For example, to repeatedly
change the selected run and/or simulation of an extract object (e.g. Extract XY from XY Results
object) and view the change in a plot requires the following procedure:

1) select the run and/or simulation.

2) press Apply

3) select the plot window to view results

4) select the Main Menu

5) select the extract object in the object tree
6) change the run and/or simulation selection
7) press Apply

8) re-select the plot window to view results.

9) repeat steps 4 to 8

nSIGHTS offers a capability called exposed controls to resolve this problem. An exposed control
is a Ul element which has been disabled on the object property window and has been re-created in
its own small top-level window. Within this top-level window are the control and additional Ul
elements to support other capabilities. Exposed controls are actuated by selecting the Expose
toggle on selected UI components. Exposed controls are bundled with Master/Slave capabilities.
Note that only master controls can be exposed.

The element remains exposed after the property pane has been changed to a different object. The
exposed control will be available until it is disabled (Expose toggle switched off), or the object is

deleted.

There are currently two types of exposed controls: list selections and real values.

6.3.2.1 Exposed List Selections
An example exposed list selection is shown below in figure 46.
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Figure 46. Exposed List Selections
This control was created by exposing the Index Selection Value Source selection property of an

Extract XY from XY Results object. The title of the control is constructed from the object ID
and the name of the exposed property.

Changing the selection with the mouse has the same effect as making the change on the
unexposed control on the property window AND pressing Apply.

The four direction push buttons at the bottom assist in navigating the list: > increments the

selection, < decrements the selection, |<- goes to the first selection in the list, and ->| goes to the
end of the list.

The Animate button, when pressed, resets the selection to the start of the list, and then goes
through each selection in order. While animating, the text in the button changes to Stop.

6.3.2.2 Exposed Reals

An example of an exposed real value control shown below in figure 47.

E GridExtract Xy Extract XY
E [I-Vulul
i

EH |9m-° R I”ﬂ.i I!
Step Typa —— 3
| r Cun. Cilog. !‘
=51 i
[ Shonge G|

Figure 47. Exposed Real Value Control

This control example exposes the value of the Extraction Constant Value Source of an Extract XY
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object (for extracting a slice from a grid). The exposed value is entered in the top field of the
control. Typing in a new value and pressing the Enter key has the same effect as making the
change on the unexposed control on the property page and pressing the Apply button.

The additional controls are designed to support animation (see Section 8.3.3) by smoothly varying
the exposed value for a specified number of steps or frames. If the Step Options is set to Range the
increment is calculated based on the Start and End value and the # of steps. If it is set to Incr. the
increment is entered directly.

Step Type controls the type of increment. If set to Lin, range increments are calculated as:
increment = (end - start) / steps, and successive values calculated as: next = current + increment.
Log range increments are calculated as: increment = (loglO(end) - loglO(start)) / steps, and
successive values are calculated as next = 10**(log10(current) + increment).

The control buttons perform the following actions:

Step Increment the current value.

Animate Set the current value to the start value, then increment the current value # of
steps times. While animating, the button text changes to Stop. Pressing the
button will stop the current animation.

ResetSt Set the current value to the start value.

End2St Set the start value to the current end value.

6.3.3 Formatting Real Numbers

There are many cases where it is desirable to control the format used to convert numeric values to
strings. Examples include axes increment labels, posted data points on plots, etc. nSIGHTS uses a
common control for this task:

1t Label Format ]

] C‘ir;neral El‘

Decimal
|Scientific
Scientific 2
|Exponent

|Exponent2

Figure 48. Increment Label Format for Real Numbers

The first field is a drop-down list that specifies the general formatting type, while the second field
is used to specify the number of decimal places:

General Conversion depends upon the value of the number being converted. Generally,
decimal conversion is used for numbers of absolute value less than 1.0E+11 and
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Decimal

Scientific

Scientific 2

Exponent

Exponent 2

NI

greater than 1.0E-05 (or 0), while scientific notation is used for all others. Trailing
zeroes are generally eliminated, except that integer values less than 100 have a
single decimal place (e.g. 99.0). The second field is not used for general.

A fixed number of places after the decimal are specified.
A fixed number of digits precision is specified.

Same as Scientific except uses mantissa x 10**X format in subscript/superscript
notation.

Expressed as 10 to a power using subscript/superscript notation. Note that the
mantissa will be dropped. This is intended primarily for log axes and log data
labels. Note that 10**0 will be converted to 1.

Same as Exponent only values with exponents between -1 and 2 will appear as 0.1,
1, 10, and 100.

Note that the Scientific 2, Exponent, and Exponent 2 notations are not available for conversions that are
not used for plotting labels.

The second field appears as follows in figure 49:

Decimal Scientific Scientific 2

| Joewoo =] [ecoco
0x10<°0">
0.0x10¢°0°>
0.00x10¢°0">
10.000x10¢*0">
10.0000x10¢*0%>
110.00000x10¢"0">
0.000000x10<"0">

0.0000000x10¢°0"> |
{10.00000000x10¢°0"

0.0C0E+00
0.0000E+00
0.00000E+00
0.000000E+00
0.0000000E+00
0.0000000DE+00

0.00000000

Figure 49. Field used to specify the number of decimal places.

6.3.4 Font Selection

nSIGHTS betrays its Unix origins by not using a standard Windows font selector. It restricts font
usage to a limited number of alternatives in the interest of maintaining visual integrity. There are
two main font dialogs available, differentiated by the fonts display dimension: 2D or 3D. The
common font options for 2D and 3D display include:
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Fam: Select font family.

Arial A Helvetica Type font.
Times Conventional Times Roman.
Courier A Courier font.

wt:  Font weight: either Medium or Bold.

Sint:  Font slant: either Reg. or ltalic.

Size:  Size in points.
Fonts for display in 3D have the following additional fields:
Thk  Thickness - governs the depth of the font in 3D. There are five alternatives:

Flat Font is two-dimensional and will be invisible from the side.
Thin, Med., Thick, V. Thk. Various qualitative degrees of depth.

A third font dialog is available for some 2D labels that can be rotated to vertical: -

Rot  Rotation can be Horizontal, Left, or Right.

6.4 Global Objects

nPre and nPost contain common invisible or global objects. These objects cannot be created or
deleted by the user. There are four types of global objects: system information objects, a
standard pen set, default linear color maps and default nPre simulation objects.

6.4.1 System Information Objects

System information objects are intended for use with Data Labels plot objects. It provides a
mechanism of identifying output graphics for QA and documentation purposes.

There are four system information object types:

Version The current nSIGHTS version identifier (e.g. VersionPre 0.90M).
Version date The release date of the version.

Today The current date.

Time The current time.

In drop-down lists within nPre, system information objects are identified as follows in figure 50:
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Version Sysinfo System Global

Versiondate  Sysinfo System Global
Today Sysinfo System Global
Time Sysinfo System Global

Figure 50. nPre System Information Object Drop-down List

The same object identification is used in nPost, without the Global object tree identifier.

6.4.2 Standard Pen Set and Linear Color Maps

Pen Set and Linear Color Map objects are required by most object tree setups, and are
frequently the only pen set and linear color map objects required. Consequently, one pen set and
two color map objects are available by default as global objects.

The default Pen Set object has an object ID of Standard. Likewise, the default Linear Color
Map objects have an object ID of Cold2Hot and Greyscale. The Cold2Hot linear color map
provides a rainbow color range from blue to red, where as the Greyscale linear color map
provides a range of grey colors.

6.4.3 nPre Simulation Objects

nPre also contains a number of global objects which are created automatically by the simulator.
These include tables of sample values and optimizer results, and XY data for each defined
simulation output.

nPre simulation objects are identified in the same manner as all objects, with an object tree

identifier of Global. For example, simulation pressure XY output would be identified as sPDAT
SPDAT f(t)Output Global.
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7 DATA PROCESSING: DATA OBJECTS

The data page contains data objects, which are objects that process data. For example, data can be
input, scaled or transformed. Visualization of data objects is accomplished using plot pages and
plot objects (see Section 8).

This section does not intend to detail every data object. It will discuss some data object concepts,
and provide a summary of the available data objects and their function. Each data object is
described in detail in Appendix A.

7.1 Data Object Concepts

This section is provided to describe the default data objects, data object controls, and the input for
some of the more complex data objects.

7.1.1 Default Data Objects

All data pages have one default object: a default data page description (Default::DataPgDesc).
This data object contains an object ID that is used as the identifier for the page in the object tree.
It also contains an empty text box that allows the user to document the collection of objects in the

page.
7.1.2 Tables in the Object Property Window

Two objects, Enter Table and Enter XY, contain spreadsheet-type tables within the object
property window. An example Enter Table object property window is shown below in figure 51:

E-ggeuln =Input Table Data t
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Figure 51. Enter Table in the Object Property Window
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Values are entered into the cells. The Update button and the pop-up menu (accessed by right-
clicking the mouse over the table) can be used to fill in the table with values.

Selecting an object in the input-data drop-down-box and clicking the Update button displays the
values from the selected object in the table of the Enter Table/XY Data object. When the Apply
button is clicked, the values are stored in the Enter Table/XY Data object. The values can then
be modified. Reselecting the Update button will refresh the values in the table, and all

modifications will be lost.

The pop-up menu contains the commands outlined below. Selected rows and columns are based
on the cursor location upon activation of the pop-up menu.

Insert Before

Insert After

Delete

Insert Row Before

Insert Row After

Delete Row

Insert Column Before

Insert Column After

Delete Column

Paste from Clipboard

Copy to Clipboard

Inserts a row above the selected row. For XY data only.

Inserts a row below the selected row. For XY data only.

Deletes the selected row. For XY data only.

Inserts a row above the selected row. For table data only.

Inserts a row below the selected row. For table data only.
Deletes the selected row. For table data only.

Inserts a column before the selected column. For table data only.
Inserts a column after the selected column. For table data only.
Deletes the selected column. For table data only.

Pastes the contents of the clipboard into the table. For example,
data in a spreadsheet can be copied and then pasted into the table.

Copies the entire contents of the table to the clipboard. The table
can then be pasted into a spreadsheet or text editor.

7.1.3 Scale/Transform Objects
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Scale/transform objects perform mathematical operations on input data. Common options include:

Operation Order
Scale ?Transform

Transform 2Scale

Scale Operation

Transform

Scale Value Source

Scale Value

Offset Value Source

Offset Value

Null Processing
set to constant

g onstant

Minimum Thresholding
None
Null

Clamp

Maximum Thresholding
None
Null
Clamp

Output Description

The object will perform the scale operation, then the
transform, in this order.

The object will perform the transform, then the scale
operation, in this order. |

Drop-down list containing four different equations that
determine the scale operation, where D is the data, Sc is the
Scale Value and Of is the Offset Value.

Drop-down list containing several transform functions (e.g.
In(Data), 1/Data, Abs(Data), €tc.)

Master and expose controls for the scale value. See Section
6.3.1 for details.

Text box for input of a scale value.

Master and expose controls for the scale value.

Text box for input of an offset value.

When active, will set all null values to the constant
specified in the constant text box.

Text box to input a constant value that will replace all null
values.

Does not apply a minimum threshold.

Sets all values below the text box value as null.

Sets all values below the text box value at the text box
value.

Does not apply a maximum threshold.

Sets all values above the text box value as null.

Sets all values above the text box value at the text box
value.

Provides a description of the object, which will be used as
the object type in drop-down lists, and the label of the
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object in a Series Legend.

7.1.4 Interpolation Methods

Interpolate XY data from Curve, Time Limits Extraction/Interpolation and Sequence Fit use
common interpolation methods, described below:

Linear Conducts a linear interpolation of the Y data for a specified number of X
points, within specified X limits.

Log (Absolute) Conducts a linear interpolation of the Y data for a specified number of log
X points, within specified X limits.

Log (Relative) Conducts a linear interpolation of the Y data for a specified number of
newly created log X points, within specified X limits. X points are created
using log steps starting from a specified start value.

Input X Conducts a linear interpolation of the Y data for given X values from XY
input data. For Time Limits Extraction/ Interpolation and Sequence Fit,

this method results in no interpolation.

The Interpolate Table Column object uses different interpolation methods (note that X data
must be in ascending order):

Linear Linearly interpolates a Y value corresponding to an X value equal to the
specified interpolant value.

Previous Obtains the Y value corresponding to the X value of the row above the
specified interpolant value.

Next Obtains the Y value corresponding to the X value of the next row below the
specified interpolant value.

Closest Obtains the Y value corresponding to the X value closest to the specified
interpolant value.

The interpolation methods used by Create Curve from XY Data, are described in Section 7.1.5.
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7.1.5 Curve Data Functions

When creating curve data (Create Curve from XY Data), several data functions or interpolation
methods are available. Examples based on the same set of XY data, are shown for each data
function.

Cubic Spline A piecewise polynomial approximation of XY data, continuous in the first
and second derivatives, provides a smooth approximation. Parameters are
available for this curve type to influence the function slopes at the extremes
of the function and the spline tension.

100

Figure 52. Cubic Spline of XY Data

Polynomial Linear regression of XY data at a specified polynomial order. A
polynomial order, between 1 to 10, is specified.

80/ e cynomial (209 Orven

0 5 50 75 100

Figure 53. Polynomial (2™ Order) of XY Data

Linear A series of straight lines joining consecutive XY points.

0 b

75 100

Figure 54. Linear of XY Data
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StepMid Step function with value change at the linear midpoint between adjacent
points.

Figure 55. StepMid of XY Data

StepFull Step function with value change at each XY point.

801 GtepFun

Figure 56. StepFull of XY Data

7.2 Data Object Summary

Due to the large number of data objects, it is not possible to list all data objects in a single
selection menu. Consequently, nSIGHTS categorizes data page objects and requires an additional
step (category selection) to get the actual object selection menu. The data object category menus
in nPre and nPost are as follows in figure 57:

nPre nPost
T cube Processng g
SR R . Qurve Processing ’
Cube Processing L Bit Specification »
Qurve Processing ¢ 4 GdProcessng »
| Btspecfcaon  *| | OSIGHTS Results Extracton *
{ GudProcessng ' | | Pens B Color Maps ’
PesBCoorMaps *| { Readirput :
| Beadinput P11 Real Processng ’
| Ped Processing Residud Processing *
| Teteoperatons *| | Tabke Processng +
1 welTestanayss *| || wel Test Anayss *
| xroaaprocessng *| | ¥vDamprocessng

Figure 57. nPre and nPost Data Object Category Menus
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Objects in each category are listed in the table below. Note that some objects appear in more than
one category (for example, Read Table File appears in both Read Input and Table Operations

categories).

Table 7.1: Data Object Summary

Category

Objects

nPre Objects

nPost Objects

Cube Processing

Extract Cube Indexes
Extract Grid
Histogram

Matrix Math
Normalize
Scale/Transform
Statistics

Select Range Cube

Curve Processing

Create Curve from XY Data
Interpolate XY Data from Curve

Write Curve File

Select Curve from File

Fit Specification (Basic) Single Fit Sequence Fit
Composite Fit
Grid Processing Extract XY Select Range Grid
Histogram
Matrix Math
Normalize
Scale/Transform
Statistics
nSIGHTS Results Extract Covariance
Extraction Matrices
Extract Jacobian
Extract Optimizer Results
Table
Extract Profile Grid
Extract Range Cube
Extract Range Grid
Extract Residuals
Extract XY from XY
Results
Pen and Color Maps Linear Color Map Write Color Map
Merge Color Maps
Pen Set
Read Color Map
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Read Input

Read Table File
Read XY Data
Read XYZ Label Data

Read Cube Data

Read Color Map

Read Curve File

Read Grid Data

Read nSIGHTS Optimizer
Results

Read nSIGHTS Profile
Results

Read nSIGHTS Range
Results

Information Only

Read nSIGHTS XY
Results
Read Sequence Time
Interval Data
Real Processing Create Real Value
Scale/Transform
Residual Processing Calculate Basic Residual
Calculate Residual
Diagnostic
Extract Residuals
Table Operations Enter Table Data Write Table File Jacobian to Table
i Extract Real from Table Table Column
Extract Table Rows Scale/Transform
Full Table Correlations Table Row Index Logic
Interpolate Table Columns
Real Value(s) To Table
Read Table File
Sum Tables
Table Column Correlations
Table Column Math
Table Column Statistics
Table Column To Histogram
Table Columns To XY
Table Row Statistics
View Table Data
Well Test Analysis Extract Sequence(s)
P(t) Derivative Calculation
P(t) Time Processing
Pulse Normalization
Time Limits
Extraction/Interpolation
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XY Data Processing

Add Noise Create XY Array Add XY to Array

Dual Scale/Transform Write XY File Array Scale/Transform
Enter XY Data

Extract Range

Fourier Transformon Y
Histogram

Integrate

Select XY from XY Array
Single Scale/Transform
Smooth/Filter

Statistics

Read XY Data

Reduction

Remove Duplicates
Transpose

Vector Math

View XY Data

7.3 Data Object Function Summary

Table 7.2 summarizes the function of all the data objects available. In addition, the required input
object or data type and the created output data type is specified. If the input or output is not an
object or external file (e.g. input from user), the input or output will be specified as none. Note
that for read objects, the default file extension is not required when opening a file.

Table 7.2: Data Object Function Summary

Object Function/Input

Add Noise Adds noise to Y data randomly based on a Uniform or Normal
distribution. Used to create synthetic data.
Input: XY data
Output: XY data

Add XY to Array Creates a collection of XY data from a single XY data object. Each

time a change is made in the specified XY data object, the new XY data
are added to the array. For example, if an Extract XY object
(extracts XY data from a grid) is used as input, each time the Extraction
Constant_Value in the Extract XY object is changed (including
pressing the Apply button), the new XY data will be added to the array.
Input: XY data

Output: XY array

Array Scale/Transform

Performs mathematical operations on XY array data types.
Input: XY array
Output: XY array

(Basic) Single Fit

Pairs field and simulated data to be selected as a constraint by the Fit
Selection tab in the Fit Specification nPre input window. Typically
used in the Fit Specification/Graphics tab of the Fit Specification nPre
input window.

Input: XY data
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OQutput: fit specification

Calculate Basic Residual

Processes residuals from selected residual data. Residuals can be sorted
in ascending (Up) or descending (Down) order, plotted versus the X
Value or the data Index, and/or standardized to make the data
comparable to a standard normal probability distribution.

input: [Extract Residuals
Output: XY data

Calculate Residual Diagnostic

Creates data to plot a Quantile Normal or Standard normal residual plot.
Input: Extract Residuals

Output: Two XY data sets, one containing the manipulated data, the
second a diagnostic line (Quantile Line or CumNormDist)

Composite Fit

Combines fit specification objects to be selected as one constraint by the
Fit Selection tab in the Fit Specification nPre input window. A fit
specification object contains a pair of field and simulated data to be
selected as constraint. Typically used in the Fit Specification/Graphics
tab of the Fit Specification nPre input window.

Input:  Single Fit or Composite Fit

Output: fit specification

Create Curve from XY Data

Creates functional approximations of XY data sets. The functions
available include: Linear, Cubic Spline, Polynomial, Step Mid and Step
Full (see Section 7.1.5 for details).

Input: XY data

Output: curve data

Create Real Value

Outputs a single user-specified value, which can be used as input for
many other objects.
Input: none

Output: real value

Create XY Array

Creates a collection of XY data.
Input: XY data
Output: XY array

Dual Scale/Transform

Performs mathematical operations on both the X and the Y of XY data.
Input: XY data
Output: XY data

Enter Table Data -

Allows the user to input or modify table data. Table data can be input or
modified by hand, pasted from the clipboard, or updated from another
table data-type object (see Section 7.1.2 for details).

Input: none or table data

Qutput: table data

Enter XY Data

Allows the user to input or modify XY data. XY data can be input or
modified by hand, pasted from the clipboard, or updated from another
XY data-type object (see Section 7.1.2 for details).

Input: none or XY data

Output: XY data

Extract Covariance Matrices

Extracts covariance matrices from one or multiple simulations of an
nSIGHTS Optimizer Results object. Estimated covariance matrices use
the estimated standard deviation specified by the user for each
parameter. The confidence limits of the covariance matrix can be
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plotted using the Confidence Limits plot object.

Input: nSIGHTS Optimizer Results
Output: covariance data

Extract Cube Indexes

Extracts cube indices from cube data within set limits, Cube indices are
used to define the cube data to be plotted in a 3D plot.

Input: cube data

Output: cube indices

Extract Grid

Extracts a grid from cube data such that every point of the grid
represents a specified constant value.

Input: cube data

Output: grid data

Extract Jacobian

Extracts Jacobian data from one or multiple simulations of an nSIGHTS
Optimizer Results object.

Input: nSIGHTS Optimizer Results
Output: Jacobian data

Extract Optimizer Results Table

Extracts a table containing optimized values, case parameters and/or
optimization status from one or multiple simulations of an nSIGHTS
Optimizer Results object.

Input: nSIGHTS Optimizer Results

Output: table data

Extract Profile Grid

Extracts a grid from one or multiple simulations of an nSIGHTS Profile
Results object.

Input: nSIGHTS Profile Results
Output: grid data
Extract Range Extracts XY data within a specified range.
Input: XY data
Output: XY data
Extract Range Cube Extracts cube data from one or multiple simulations of an nSIGHTS
Range Results object.
Input: nSIGHTS Range Results
Output: cube data
Extract Range Grid Extracts a grid from one or multiple simulations of an nSIGHTS Range

Results object.
Input: nSIGHTS Range Results
Output: grid data

Extract Real from Table

Extracts a table column property (number of rows, minimum value,
maximum value, last row value, or specified row value) and converts it
to a real data-type. The real value is displayed in the object property
window, in the Current Value frame.

Input: table data

Output: real value

Extract Residuals

Extracts residuals (XY data) from one or multiple simulations of an
nSIGHTS Optimizer Results object.

Input: nSIGHTS Optimizer Results
Output: XY data

Extract Sequence(s)

Extracts XY data for one or multiple sequences, based on the sequences
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defined by sequence time data.
Input: XY data and Sequence Time Interval Data
Output: XY data

Extract Table Rows

Extracts a range of rows from a table column based on specified limits.
Input: table data
Output: table data

Extract XY

Extracts all X data from a grid corresponding to a specified constant Y
value, or all Y data for a specified constant X value.

Input:  grid data

Output: XY data

Extract XY from XY Results

Extracts one set of XY data from one or multiple simulations of an
nSIGHTS XY Results object.

Input: nSIGHTS XY Results

Output: XY data

Fourier Transform on Y

Conducts a forward or inverse Fourier transform on Y data.
Input: XY data
Output: XY data

Full Table Correlations

Calculates the Pearson R or Spearman R correlation coefficients
between all column pairs within a table.

Input: table data

Output: table data

Histogram

Creates the input data for a histogram plot based on cube, grid or XY
data. The actual histogram is plotted using an XY Series plot object
on a plot page, with this object as the input. Note there are separate
objects for each data type.

Input: cube, grid or XY data

Output: cube, grid or XY data

Integrate

Takes the integral of XY data.
Input: XY data
OQutput: XY data

Interpolate Table Columns

Interpolates Y values based on a given value for X (the interpolant value
value). Values in the X table column must be in order of increasing
values.

Input: table data

Output: real value

Interpolate XY Data from
Curve

Interpolates XY values based on curve data, for a specified number of
points and specified limits. This allows curve data to be plotted.

Input: curve data and if inpuz X interpolation method, XY data
Output: XY data

Jacobian to Table

Converts Jacobian data to table data.
Input: Jacobian data
Output: table data

Linear Color Map

Creates a color map with a linear variation between starting and ending
RGB or HSV values.
Input: none

Output: color map

Matrix Math

Basic array mathematics (+,-,*,/) can be applied to two sets of cube data
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or grid data. Note there are separate objects for each data type.
Input: cube or grid data
Output: cube or grid data

Merge Color Maps

Combines two color maps.
Input: color map

Output: color map

Normalize

Normalizes cube and grid data within specified data limits, based on a
power value or both. Note there are separate objects for each data type.
Input: cube or grid data '
Output: cube or grid data

P(t) Derivative Calculation

Calculates the derivative of a pressure function (P(1)).
Input: XY data-
Output: XY data

P(t) Time Processing

Applies one of four time functions to X data (Horner, Agarwal, Horner
Super or Bourdet Super). Used to create plots that require a time

‘| function for the X axis, such as a Horner plot.

Input: XY data
OQutput: XY data

Pen Set

Creates a set of pens that can be used in plotting. Normally, the default
Standard Pen Set is all that is required.
Input: none

Output: pen set

Pulse Normalization

Normalizes pressure XY data based on one of two equations: (Pi-P(1)) /
(Pi-Po) and 1-(Pi-P(1)) / (Pi-Po), where Pi is the static pressure and Po is
the initial pulse pressure. Both Pi and Po are to be specified in the
object property window.

Input: XY data

Output: XY data

Read Color Map Reads a color map from a specially formatted text file (default file
extension: *.cmap). This allows creation of color maps outside
nSIGHTS (for example, in an Excel spreadsheet) to meet special
requirements.

Input: external file
Output: color map
Read Cube Data Reads cube data from an input file (default file extension: *.cube).

Input: external file
Output: cube data

Read Curve File

Reads a curve data file (default file extension: *.nCRV). A curve file
may contain several curve data sets.
Input: external file

Output: curve data file for Select Curve File

Read Grid Data

Reads grid data from an input file (default file extension: *.grd).
Input: external file
Output: grid data

Read nSIGHTS Optimizer
Results

Reads an nSIGHTS optimizer simulation results file (default file
extension: *.nOpt), specified in the Output File Setup nPre input
window,

Input:  external file

Output: optimizer results file to be used by Extract Covariance
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Matrices, Extract Jacobian, Extract Optimizer Results
Table and Extract Residuals

Read nSIGHTS Profile Results

Reads an nSIGHTS profile simulation results file (default file extension:
*.nPro), specified in the Output File Setup nPre input window.

Input: external file

Output: profile results file used by Extract Profile Grid

Read nSIGHTS Range Results

Reads an nSIGHTS range simulation results file (default file extension:
*.nRng), speciﬁed in the Output File Setup nPre input window.

Input: external file

Output: range results file used by Extract Range Cube and

Extract Range Grid

Read nSIGHTS XY Results

Reads an nSIGHTS XY simulation results file (default file extension:
* nXYSim), specified in the Output File Setup nPre input window.
Input:  external file

Output: XY results file used by Extract XY from XY Results

Read Table File

Reads tabular data from a file.
Input: external file
Output: table data

Read XY Data

Reads a list of XY points from a file (default file extension: *.dat).
Input: extemnal file

Output: XY data

Read XYZ Label Data

Reads a list of XYZ co-ordinates and associated text labels from a file.
Input: external file

Output: XYZ label

Real Value(s) To Table

Converts real values into table data.
Input: real value
Output: table data

Reduction

Reduces the number of XY points by skipping points or by only keeping
points with a change in value greater than a specified maximum.

Input: XY data

Output: XY data

Remove Duplicates

Removes duplicate values from X data, Y data or both. Duplicates can
be considered values that have differences less than a specified value.
Input: XY data

Output: XY data

Scale/Transform

Performs mathematical operations on a single real input value, cube data
or grid data. Note there are separate objects for each data type.
Input: real value, cube data or grid data

Output: real value, cube data or grid data

Select Curve from File

Selects a curve from a curve file. A curve file may contain several sets
of curve data.

Input: Curve File
Output: curve data

Select Range Cube

Used in real-time processing, allows the selection of a range cube data
set available during a run. Only for range mode simulations with three
variables specified as range variables.

Input: cube data
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Output: cube data

Select Range Grid

Used in real-time processing, allows the selection of a range grid data
set available during a run. Only for range mode simulations with two
variables specified as range variables.

Input: grid data

Output: grid data

Select XY from XY Array

Select an XY data set from an XY array. An XY array is a collection of
XY data sets.

Input: XY array

Output: XY data

Sequence Fit

Similar to (Basic) Single Fit, except the fit can be limited to a range of
time or sequences. The Y data may also be interpolated based on
synthetic X data (See Section 7.1.4 for details). No interpolation occurs
if Input X is selected as the Interpolation Method.

Input: XY data

Output: fit specification

Sequence Time Interval Data

Reads a sequence time data file (default file extension: *.seqt).
Input: external file

Output: sequence time data file for Extract Sequence(s)

Single Fit

See (Basic) Single Fit

Single Scale/Transform

Performs mathematical operations on either the X or the Y of XY data.
Input: XY data
Output: XY data

Smooth/Filter

Filters and smoothes XY data using one of the following methods: FFT
smoath, Median smooth, low pass and high pass.

Input: XY data

Output: XY data

Statistics

Calculates basic statistics (e.g. sum, mean, minimum, maximum, etc.)
for X, Y cube or grid data. Four basic statistics are selected for output
as real values, typically used as data labels on a plot.

Input: XY, cube or grid data

Qutput: 4 real values

Sum Tables

Sums the values between multiple tables. For example, the value in
column 2, row 1 of Table A will be added to column 2, row | of Table
B. A specified X column will not be summed.

Input: table data

Output: table data

Table Column Correlations

Calculates the Pearson R and Spearman R correlation coefficients
between two specified columns of a table.

Input: table data

Output: real values

Table Column Math

Basic mathematics (+,-,*,/) are applied to two table columns.
Input: table data
Qutput: table data

Table Column Scale/Transform

Performs mathematical operations on a specified column of a table.
Input: table data
Output: table data

Table Column Statistics

Displays basic statistics (e.g. sum, mean, minimum, maximum, etc.) for
a specified column of a table. Four basic statistics are selected for output
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as real values, typically used as data labels on a plot.
Input: table data
Output: 4 real values

Table Column To Histogram

Creates the input data for a histogram plot based on a specified column
of a table. The actual histogram is plotted using an XY Series plot
object on a plot page, with this object as the input.

Input: table data

Output: XY data

Table Columns To XY

Extracts two specified columns from a table to create XY data.
Input: table data
Output: XY data

Table Row Index Logic

Conducts Boolean Logic (AND, OR, XOR) between two sets of table
TOWS.

Input: Extract Table Rows

Output: table data

Table Row Statistics

Displays basic statistics (e.g. sum, mean, minimum, maximum, etc.) for
a specified row of a table. Four basic statistics are selected for output as
real values, typically used as data labels on a plot.

Input: table data

Output: 4 real values

Time Limits
Extraction/Interpolation

Extracts XY data for a range of sequences or time and within specified
data limits, and interpolates the extracted data.

Input: XY data and Sequence Time Interval Data if
Sequence Range Time Data selected.

Qutput: XY data

Transpose

Switches the X and Y data (i.e. output X = input Y and output Y = input
X).

Input: XY data

Output: XY data

Vector Math

Basic array mathematics (+,-,* /) can be applied to two sets of XY data.
Input: XY data
OQOutput: XY data

View Table Data

Allows the user to view table data created in another object.
Input: table data
Output: table data

View XY Data

Allows the user to view XY data created in another object.
Input: XY data
Output: XY data

Write Color Map

Writes a color map to a file.
Input:  color map
Output: external file

Write Curve File

Writes single or multiple curve data to a file.
Input: curve data
Output: external file

Write Table File

Writes a table to a file.
Input: table data
Output: external file
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Write XY File

Writes XY data to a file.
Input: XY data
Output: external file
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8 PLOTTING

nSIGHTS supports two basic types of plots: a 2D XY Plot and a 3D XYZ Plot.

When a plot page is created through the page menu, several things happen:
1) A new page is created in the object tree.
2) Default 6bjects are added to the new page tree.

3) A new top level window is created containing the basic plot. At creation the plot will
contain only axes and axes increment labels.

This section will provide a basic overview of nSIGHTS's plotting capabilities. Plot objects and
their function will be discussed, as well as user interaction with plots and plot output.

8.1 Plot Objects

Plot objects are objects that are placed on a plot page and create a visual representation on the plot
window. It is necessary to add plot objects before any meaningful visualization (other than bare
axes and axes/increment labels) is produced.

This section does not intend to detail every plot object. It will discuss plot object types, general
plot object concepts and summarize the available plot objects and their associated function. Each
plot object is described in detail in Appendix B.

8.1.1 Plot Object Types

Plot objects are categorized into the following object types:

Default Plot objects that are automatically created upon the creation of a
plot page. They control the general layout of the plot and provide a
user-interface for setting axes and formatting options.

Data display Plot objects that provide a visual representation of input objects
using the co-ordinate system defined by the plot axes. Visual
output is clipped within this co-ordinate system. Data display
objects cannot be selected with the cursor, although some data
display objects report values based on the cursor location.
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Annotation Plot objects that help explain the data display, such as a title or a
legend. Using a non-spatial 0 to 100 co-ordinate system for
placement, annotation objects can be located anywhere within the
plot window. When the cursor is over an annotation object, it will
be outlined with a red rectangle. After selecting the rectangle with
the left mouse button, the rectangle can be dragged to a new
position on the plot. nSIGHTS will not allow the rectangle to be

dragged out of the plot window.

Selection or Active Plot objects used to select, enter and/or modify data on the plot with

the mouse.

The different object types are differentiated by the available options in the Plot Settings box in the
upper-right corner of the object property window. All non-default plot object types have a Plot
toggle in the Plot Settings box, that determines whether the object is to be visible on the plot or not.

For 2D Data Display objects, a Layer drop-down box is used to set visibility (see Section 8.1.2.1
below). For data display objects with reporting capabilities, a Report toggle enables the objects

reporting function (see Section 8.1.2.2).

Plot Seflings —=—=—=———————= o= T ===7=7
|Layer[]1;F|i I Report 7 Plot

Figure 58. 2D Data Display Object Plot Settings Box

For 3D Data Display objects, the Poly Off value is used to fine-tune 3D object visibility (see Section

8.1.2.1 below).

3 Plot Seftings === ==

i Pohvoff [0.0E+00 N @) Plot

Figure 59. 3D Data Display Object Plot Settings Box

For Annotation objects, there are no options in the Plot Setting box except for the Plot toggle box.
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= Plot Setings = =
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Figure 60. Annotation Plot Settings Data Display Object

For Selection/Active objects, a Layer drop-down-box is used to set visibility, as with 2D data
display objects. If the Active toggle box is selected, the plot object will respond to mouse-clicks
when a plot is in selection mode. For example, for a Modify: Enter/Edit XY object, an XY point
will be created at the location of the mouse-click on the 2D window.

—Plot Settings ===

el Bjacive  @JPlot

Figure 61. Selection/Active Plot Settings Data Display Object

8.1.2 Plot Object Concepts

8.1.2.1 Plot Object Visibility

Objects are drawn on the plot in the order that they are created (the order that appears in the object
tree). On a 2D plot, any object plotted before and in the same location as an object that produces
a solid color fill, such as Color Block or Grid Color Fill, will be visually obliterated by the solid
color fill. For example, if a contour object (Grid Contour object) is created before a fit surface
object (Grid Color Block object), the contours will be hidden by the solid color fill on the plot.
If the fit surface object is created before the contours, both objects will be visible on the plot.

To address this issue for 2D plots, plot object visibility is controlled with Plor Layers. Every data
display and selection/active object in a 2D plot is assigned to a layer from 0 to 7. Objects are
plotted by ascending layer index (i.e. all layer 0 objects are plotted, followed by layer 1, followed
by layer 2, etc). Within a layer, objects are plotted in order of definition, except if 2D anti-
aliasing is effective (see Section 2.4.4). In this case, solid objects are plotted first, followed by
lines.

Annotation plot objects do not have a layer assignment. Conceptually, all annotation objects are
viewed as existing on layer 8. They are the last objects plotted, and they are plotted in order of
definition on each page.

For a 3D plot, object visibility is governed by geometry. An exception occurs when two objects
are plotted in the same place. In this case, the last object plotted will be visible. Another
exception occurs when lines are plotted at the edges of, or over, polygons. Because of
imprecisions in the OpenGL renderer, the lines may appear stitched, with intermittent visibility.
These stitched lines can be rectified through the use of a polygon offset (PolyOff in the Plot Settings
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Figure 62.

This field is only available for 3D plot objects that plot polygons. It slightly modifies the position
of the polygon, allowing the user to ensure that lines are visible. The effect of specific values
depends upon the version of OpenGL (1.0 or 1.1) and the depth in bits of the Z buffer. Generally,
if a polygon offset is required, a PolyOff value of 1.0 is acceptable.

There are special concerns for plot object visibility when producing Postscript output. These are
described in Section 8.3.1.

8.1.2.2 2D Plot Object Reporting

Many data display plot objects on 2D plots have a report capability. With the report capability
active (Report toggle checked in the Plot Settings frame), the object will display values associated
with the cursor position in the report area of the 2D plot window. For example, the Table Series
object will report the XY values of the data point closest to the cursor.

The report area is located in the control bar at the bottom of the 2D plot window, adjacent to the
XY cursor location display. The report area for an object will be framed and includes the object’s
ID at the top. The control bar, including the XY cursor location display and the report area, can be
turned off by selecting View=>Control Bar in the 2D plot window menu bar, or turning off the Show
Report Area toggle box in the Format frame of the 2D XY Main Menu object's property window.

8.1.3 Plot Object Summary

Available plot objects are summarized by type and availability in the following table.

Table 8.1: Summary of Plot Objects
Type Objects 2D Objects : 3D Objects
Default X Axis 2D-XY 3D-XYZ
Y Axis 2D Plot Anno Z Axis
3D Axes Label
3D Axes Format
3D Lighting
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Annotation Color Legend Extra Grid Lines XYZ Labels
Data Labels Sequence Grid Lines
Series Legend XY Labels
User Labels

Data Display | Confidence Limits (nPost only) Multiple Table Series Cube Color Block
Grid Color Block Single Table Series Cube Color Point
Grid Color Fill Table Histogram Table Series
Grid Color Point XY Array Horsetail (nPost only)
Grid Contour XY Histogram
Grid Fishnet
XY Series

Selection/ Modify: Enter/Edit XY

Active Analytics: Line Data

8.1.4 Default Plot Objects

Default plot objects control the general layout of the plot and provide a user-interface for setting
axes and formatting options. Default object property windows vary slightly according to plot

type, and are described in detail in Appendix B. Table 8.2 summarizes the default plot objects.

Table 8.2: Default Plot Objects Function Summary

Object I Function

2D Plots

2D XY Main Menu Controls the general layout and characteristics of 2D XY plots.

2D XY Axes Defines the plot axes. There is one object for the X axis and one for the Y axis,

each with identical object property windows.

2D Plot Annotation

Provides control over axes labelling and the general appearance of all 2D XY
plots.

3D Plots

3D XYZ Main Menu | Controls the general layout and characteristics of 3D XYZ plots.

3D XYZ Axes Defines the plot axes. There is one object for the X axis, one for the Y axis and
one for the Z axis, each with identical object property windows.

3D Axes Labels Provides control over axes labelling for 3D plots.

3D Axes Format Provides control over general formatting of 3D plot axes.

3D Lighting Provides control over Open GL lighting used on all 3D plots.

8.1.5 Data Display Plot Objects

Table 8.3 summarizes the function of all the data display plot objects available. In addition, the
object input required for each object is specified.

Table 8.3: Data Display Plot Objects Function Summary

Object

Function/Input

Confidence Limits

Plots single or dual confidence limits of a covariance matrix.

Input: Extract Covariance Matrices
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Cube Color Block

Plots color blocks around each cube data value for specified cube indices within
specified cube value limits.
Input: cube data, cube indexes and color map

Cube Color Point Plots color points at each cube data value for specified cube indices within specified
cube value limits.
Input: cube data, cube indexes and color map

Grid Color Block Plots color blocks around each node of the grid within specified grid value limits.
Input: grid data and color map

Grid Color Fill Plots color filled contours of the nodes of a grid within specified grid value limits.

Input: grid data and color map

Grid Color Point

Plots color points representing each node of the grid within specified grid value limits.
Input: grid data and color map

Grid Contour Plots single color contours of the nodes of a grid at specified grid values.
Input: grid data

Grid Fishnet Plots grid lines of the grid, connecting all nodes of the grid. The number of grid lines
can be reduced, based on an X and Y modulus.

Multiple Table Series Plots one X and one Y column from multiple selected tables using symbols and/or
lines.
Input: table data

Single Table Series Plots selected columns from single table using symbols and/or lines. Only one column
is selected as the X data column. Multiple columns can be selected for the Y data.
Input: table data

Table Histogram Plots two columns of table data as bars in a standard histogram format.
Input: table data

Table Series Plots selected columns from single table using symbols and/or lines in a 3D plot. Only

one column is selected for each the X, Y and Z data columns.
Input: table data

XY Array Horsetail

Plots all XY data sets contained within an XY array. Within the Horsetail Color
frame, selection of Pen will draw all data set lines in the same color, whereas selection
of Color Map will draw each data set line in a different color.

Input: XY array

XY Histogram Plots XY data as bars in a standard histogram format.
Input: XY data
XY Series Plots multiple XY data sets using symbols and/or lines.

Input: XY data

8.1.6 Annotation Plot Objects

Table 8.4 summarizes the function of the annotation plot objects available. In addition, the object
input required for each object is specified. If the input is none, the input required for the object is
to be typed by the user.

Table 8.4: Annotation Plot Objects Function Summary

Object

Function/Input

Color Legend

Plots a color bar to indicate the color associated with each value.
Input: Color Cube Block, Color Cube Point, Color Grid Block, Color Grid Fill,

Color Cube Point, XY Array Horsetail.
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Data Labels Creates a label block showing the status/value of selected object parameters. For real
valued labels, the label format can be specified.
Input: many objects produce one or more label outputs
Extra Grid Lines Plots a grid line at a specified X or Y value. The grid line may also be labelled.
Input: none
Sequence Grid Lines Plots grid lines to define sequence intervals.
Input: Sequence Time Interval Data
Series Legend Creates a legend block containing line/symbol information from one or more input
objects.
lni)ut: Confidence Limits, Grid Contour, Grid Fishnet, Multiple Table Series,
Single Table Series, Table Series, XY Array Horsetail, XY Series.
User Labels Creates a text block containing user entered text.
Input: none
XY Labels Plots 3D labels in a 2D data space.
Input: Read XYZ Labels, Create XYZ Label for Real
XYZ Labels Plots 3D labels in a 3D data space.
Input: Read XYZ Labels, Create XYZ Label for Real

8.1.6.1 Plot Labels

Plot labels are generally created using annotation plot objects, although certain default and data
display objects contain plot label options. Within these plot objects, text boxes are available for
the user to type specific labels (e.g. a legend title).

nSIGHTS supports special formatting of labels by embedding non-printing codes in the text used
to create the labels. This allows for subscripts, superscripts, and special characters and formatting
control. The codes are outlined in Table 8.5.

Table 8.5: Special Formatting Codes

iﬂ:f;:ltting Code Description
Superscripts <“text™> Text will appear as superscript. Superscripts cannot be nested.
Subscripts < text > Text will appear as subscript. Subscripts cannot be nested.
Superscript and | \SSSNNN Subscript/superscript size ratio where NNN is ratio to base font size (100 =
Subscript Control 1.00). NNN must be between 030 and 100. Default is 060.
\SPONNN Superscript offset. Position above baseline that superscript starts where NNN
is ratio to base font size (100 = 1.00). NNN must be between 050 and 100.
Default is 060.
\SBONNN Subscript offset. Position below baseline that subscript starts where NNN is
ratio to base font size (100 = 1.00). NNN must be between 010 and 050.
Default is 030.
Line Spacing | \LSNNN Position between baselines of adjacent lines where NNN is ratio to base font
Control for size (100 = 1.00). NNN must be between 020 and 900. Default is 130. This
multi-line labels control remains in effect until another LS control is encountered.
Special \C=NNN NNN is character code between 000 and 255.
Characters
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New Lines \n Single line text fields can produce multiple line labels by embedding new-line
codes. This is useful for axes labels.

For example, the following shows the text entered in a User Label object, and the resulting
display on the plot, shown in figure 63:

\LS200Analysis Results:\nK=6.1 x 10<*-12"> m/s

Analysis Results:
K=6.1 x 1072 m/s

8.1.7 Selection/Active Plot Objects

Selection/active plot objects use the mouse to select, enter and/or modify data. They are only
available for 2D plots.

In order to select, enter or modify data on a 2D plot using a selection/active plot object, the cursor
must be in selection mode and the selection/active object must be in active mode. Selection mode

is enabled if the selection button, lﬂ.] in the 2D plot window toolbar, is selected. Active mode for
a selection/active object is enabled by a check marked Active toggle in the object’s Plot Settings
frame.

Once in selection mode, the pop-up menu for the 2D plot window is modified to an object specific
pop-up menu.

Table 8.6 summarizes the function of the selection/active plot objects available. In addition, a
description of the object pop-up window and the required object input is provided. If the object
input is none, the input required for the object is based on mouse actions in the 2D plot window.

Table 8.6: Selection/Active Plot Objects Function Summary

Object Function/Input

Analytics: Line Data Allows the user to create a straight line on a 2D plot interactively. A line with 5
points is automatically created upon creation of the object. Each point in the line can
be dragged to move, rotate, extend or shrink the line. The location of the line, in
addition to its length, slope and Y intercept, are provided in the object property
window. Apply and Reset commands are available on the pop-up menu (right-click
on the 2D window to access this menu).

Input: none

Modify: Enter/Edit XY Allows the user to create a new XY data set or add and delete points from an existing
data set interactively. Use the update button to refresh the points to the specified XY
data. To switch from enter to delete mode, use the commands in the pop-up menu
(right-click on the 2D plot window to access this menu). The pop-up menu also
includes Apply, Cancel and Delete All commands.

Input: none or XY data
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8.2 Plot Interaction

8.2.1 Plot Cursor

2D plots display a small cross-hair cursor: + . If the control bar is enabled, the current cursor
location is given in the lower left corner of the window. If reporting is enabled for a plot object,
the report values for the current cursor position are also shown in the control bar.

The cursor on 3D plots is used only to adjust the position of plot annotation data.

8.2.2 Zoom and Selection mode

The cursor can be in one of two modes, zoom or selection. Zoom mode allows the user to change
the plot view (see Section 8.2.3), whereas selection mode allows the user to enter, modify or delete
data from selection/active objects interactively. Currently, selection mode has no significance
within a 3D view, as there are no selection/active objects available within a 3D view.

Each cursor mode has a button on the 2D plot window toolbar:
Selecting the @ button enables zoom mode.
Selecting the |71 button enables selection mode.

The last selected button will remain pressed in, indicating the current cursor mode.

8.2.3 Plot View

Both 2D and 3D plots use the concept of a view.

For a 2D plot, the view is defined by the axes limits of the plot. In zoom mode, the user can
change the view by dragging the mouse to outline a rectangle within the axes area (the cursor will
change to a magnifying glass), and releasing the mouse button. The view will zoom in on the
rectangle, with the axes maximizing to fit the available window space. The 2D plot window pop-
up menu also provides zoom and pan options, based on the location of the cursor upon activation
of the menu (see Section 8.2.4).

In a 3D plot, the view includes the axes limits, plus the attitude and translation of the plot. Plot

attitude describes the viewer’s perspective in the plot co-ordinate system and is defined in terms
of:
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elevation The angle above the plot of the viewer co-ordinate. An elevation of 90
degrees means the viewer is looking directly down on the plot.

azimuth The rotation of the plot. Azimuth 0 means the plot is not rotated and
(assuming +x is east and +y is north) the viewer is looking due north. For
example, azimuth -45 means the viewer is looking NW and +22.5 is NNE.

scale The size of the plot data in the window. The absolute values of scale are
plot projection and data limits dependent. Small values of scale mean the
plot looks far away, larger values zoom-in on the plot.

Plot translation moves the position of the looked at point within the plot co-ordinate system. The
effect of absolute values are plot dependent.

All 3D plots have a control bar at the bottom of the window that contains sliders and buttons used
to change the view:

—0 s =
- - P §§y 3 [oo0s
T e e .. = I@J‘ _Z.'-E @d

Figure 63. 3D Plot Control Bar

Attitude and Translation are controlled by the sliders shown in the figure above. The Reset buttons
are used to set attitude (At button) and translation (Tran button) to default values. At sets EI/Az/Sc
to 90/0.0/1.0, while Tran sets X/Y/Z to 0.0/0.0/0.0.

Normally the plotted view updates as the sliders are adjusted. This can be a slow process in
complex plots. If the Opt toggle is selected, the view will not update until the slider stops moving.
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8.2.4 Plot Pop-Up Menus

Right clicking the mouse on a 2D plot (assuming the mouse is in zoom mode), or anywhere on the
screen in a 3D plot, will bring up the menu shown below in figure 64:

Views
Zoomanx 1.1

Zoom4nx 2
Zoomnx 5

IOOM-G.‘K x i.l
Zoom-outx 2
Zoom-outx 5

1 Axes->Datalimis

Pan

Ccp;' To Cbboxd

Figure 64. Plot Pop-Up Menu

For a 2D plot, the available zoom-in and zoom-out options will make the current cursor position
the centre of the new axes and then perform the selected action. The axes aspect ratio will remain
the same. On a 3D plot, the axes limits will be adjusted according to the zoom selection and
offset according to the current translation.

Other options on the pop-up menu are:

Axes > Data Limits ~ The axis limits are set to display all data associated with plot objects.

Pan Redraws the plot with the axes centred on the current cursor location.

Copy to Clipboard Places a bitmap containing the plot in the clipboard, where it can be pasted
into other applications such as Power Point or Word.

If a plot is in selection mode, the right click pop-up menu may be selection/active object specific.
For example, the Modify: Enter/Edit XY object produces the following menu, in figure 65, when
active:

[ Enei/Edi XY
Apply

Cancel
Entey mode:

et Ay

Figure 65. Modify: Enter/Edit XY Menu

Information Only




See individual descriptions of selection/active objects for details on these pop-up windows in
Appendix B.

8.2.5 Plot Tool Bar

Both 2D and 3D plot windows contain a tool-bar for performing common plotting functions.

ERERE SN K] AT 1) S ]
The first three buttons help manage plot views. As the view is changed through zooming or
panning for 2D or 3D plots, or attitude/translation for 3D, nSIGHTS remembers previous views,

in a view stack.

These views are accessed through the tool bar buttons:

@ inicial view Returns to the first view in the view stack.
[@  Previous view Restores the previous view.
IB]  Reset view Re-checks the limits of each object on the plot and performs an

autoscaling operation to reset the axes limits. Also clears the view
stack. This button needs to be used as you add new objects to a
plot with axes auto-scaling that are outside the current axes
range.

The next two buttons set and reset preferred views:

18] Setaxes Sets the current plot axes to manual and sets the manual axes limits
to the current plotted axes limits.

[#]  Reset axes Resets the axes limits to the preferred limits. This button will not
be available until Set axes has been pressed at least once.

The next three buttons help manage plot animation and bitmap file output (see Section 8.3.2):
[A]  Set AutorManual dump When pressed in, the bitmap output method is set to Auto
and a new bitmap file will be created every time the plot is
redrawn. When toggled out, the bitmap output method is

Semi-Auto.
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(&]

(6]

Plot Dump

Reset increment

Outputs the current plot as a bitmap file, and increments the bitmap
file counter. Note that multiple files will be created if the mode is
Semi-Auto and Dump frame count on the Bitmap Output File Setup dialog
is greater than 1.

Resets the next output increment to 0. Useful for restarting an
animation sequence after a mistake.

The next group of three buttons have special purposes:

B

Propagate view

Propagate size

Full screen

Updates other plot windows of the same type with the current view.

Changes the horizontal and vertical size (in pixels) of all other plot
windows to match that of the current window.

Toggles the plot window between full-screen mode and normal
mode.

The next two buttons toggle the plot between zoom and selection mode. At any time, only one of
the two buttons will be pressed in:

(2]

The final two buttons are:

@

&)

Zoom

Select

Print

Refresh

Mouse actions are zoom/unzoom.

Mouse actions depend on active selection objects.

Sends the plot bitmap to the default printer. Use File - Print Setup
on the main nSIGHTS window to select the printer and
corresponding settings.

Redraws the plc;t.

8.2.6 Plot Object Control

Selecting the Plot Control item in the Control menu of the plot window will cause a new dialog
window to appear, as shown in figure 66.
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Figure 66. Plot Object Control Menu

This dialog allows the user to change the Plot toggle setting of all plot objects on a single plot

without using each object's property window. The plot control dialog lists all objects defined

for

a plot and specifies their current Plot setting with a toggle box control. This provides an easy

method for turning multiple objects off or on simultaneously. Other button usage is as follows:

Clear Turns off all defined plot objects.

Set Turns on all defined plot objects.

Close Closes the dialog menu.

Apply Applies changes within the control dialog.

8.3 Plot Output

nSIGHTS provides two basic types of graphics output: resolution independent postscript, and
bitmap files. Still output images are produced using either PostScript or bitmap files, and

animations are recorded using bitmap graphics output.

For all types of plot output, the plot window below the button bar and above the reporting area

(2D plot) or attitude control area (3D plot) is extracted.

8.3.1 Postscript Output

Postscript output consists of Postscript (PS), Encapsulated Postscript (EPS), computer graphics
metafile (CGM) or Hewlett Packard Graphics Language (HPGL) commands written to an output
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file which can then be printed or imported into another application. For convenience sake, in this
manual all resolution independent output will be described as Postscript.

Postscript output is created by selecting Postscript from the Output menu bar item on any plot

window:

File Format
PS

i
o
w

|

EPS/Win

®)
)
<

HPGL
Orientation

Portrait

Landscape

Output Size and Margins

Controls
Line Width Multiplier

The specific output file format.

Vanilla postscript. This format can be read by most postscript
viewers and can be converted to pdf by Adobe Distiller. It also
prints cleanly on tested PostScript printers. PS format input has
been tested successfully with Corel Draw. Note that PS input files
do not contain a preview image.

Encapsulated postscript. Imports cleanly into Adobe Distiller and
Corel Draw. No preview image.

Encapsulated postscript with Windows compatible preview image.
Imports cleanly into MS Word and Corel Draw. Contains preview
image. Note that the preview image may be distorted. This is a
known bug. _

Computer graphics metafile - experimental capability only. Not
tested or supported.

Hewlett Packard Graphics Language - experimental capability only.

" Not tested or supported.

Plot is not rotated. The horizontal dimension of the plot (in pixels)
1s mapped to the page width (minus left and right margins) and the
vertical to the page height (minus top and bottom margins). Aspect
ratio of the plot is preserved with the plot window origin at the
bottom left of the page.

Plot is rotated 90 degrees counter-clockwise. The horizontal
dimension of the plot (in pixels) is mapped to the page height
(minus top and bottom margins) and the vertical to the page width
(minus left and right margins). Aspect ratio of the plot is preserved
with the plot window origin at the bottom right corner of the page.

The defined size (in inches) of the plot mapping area.

Maps OpenGL line widths specified in pixels to Postscript line
widths specified in points (1 point = 1/72 inch). The default setting
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Gamma Correction

Z Buffer Multiplier

Text Multiplier
Output File

is usually OK for 8.5 x 11 inch output. Larger output may require a
larger value.

Corrects color for the differences between printed and displayed
output. Values in the range of 1.0 to 4.0 seem to produce
acceptable output.

The postscript routines reduce the size of Postscript files by
removing hidden polygons. The algorithm used to do this relies
upon a software Z buffer. In some cases, small polygons may be
missed during the sorting process. They will appear as dropouts on
the final image. If this happens, a message will be written to the
terminal window of the form: Possible occlusion culling dropouts - check
output. In this case, the value of the Z buffer multiplier should be
increased by a factor of 2 to 4. Note that increasing this parameter
uses a lot of extra memory. Using a value of -1.0 will disable
hidden polygon removal.

Occasionally, there are minor differences between the metrics of the
bitmapped fonts displayed with OpenGL and the Postscript fonts.
nSIGHTS will ensure that font heights are correct (i.e. same ratio to
window size). However, font widths may differ slightly. These
differences will manifest typically as annotation text which may
exceed the enclosing frame size of an annotation object or runs off
the page. This parameter can be adjusted until text output in the
Postscript file looks correct.

The file that the postscript is written to when the Print button is
pressed.

Notes on Object Visibility in Postscript Output:

For 2D output, you cannot rely on the order of plotting within a layer to affect visibility. Use
separate layers to ensure visibility is correct.

For 3D plotting the postscript routines do not support polygon offset. With the exception of
outlines around symbols and polygons, plot objects must be specified to be unambiguously visible
if Postscript output is to be created correctly. All 3D data display plot objects have a field called
Offset where an offset value can be added to the X, Y, and/or Z components of a plot object. The
user-entered value is added to the normal plotted values after all co-ordinate system
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transformations have been completed. The smallest possible values to overcome renderer-
induced stitching effects should be used.

8.3.2 Bitmap Output

Bitmap output can be written to a file, or copied to the clipboard. Copying the plot image to the
clipboard, using the Copy To Clipboard command in the plot pop-up window, places a bitmap
containing the plot in the clipboard, where it can be pasted into other applications such as Power
Point or Word.

Bitmap file output is supported as TGA file or JPEG file format. The output set-up dialog is
accessed by selecting Bitmap from the Output menu bar item on the plot window:

Output File Format Specifies the output format for the bitmap file:
TGA TGA output is primarily used to create Windows AVI animations
(see below).
JPEG JPEG (or JPG) output is useful for e-mailing example results as it

generally results in smaller file size, and is more commonly used.

Output Method For animation support. The method used to animate output is to
create successive frames of an animation in nSIGHTS and then to
convert the frames to an animation using a third party tool (see
Section 8.3.3). For example, to create a five frame animation called
test.avi, the third party tool requires a sequence of files as follows:
test0000.tga, test0001.tga, test0002.tga, test0003.tga, test0004.tga.

Auto Creates a new bitmap file after each plot redraw. The file name is
created from the base file name in the box Root File Name and the
increment number, right justified with leading zeroes in a 4 digit
field. After the file is written, the increment number is incremented
by 1.

Semi-Auto File name and increment as for auto, however the file is created
when the Plot Dump button on the plot window tool bar is pressed.

Manual Pressing the Plot Dump button will bring up a file selection box
where the output file name can be entered.

Root File Name The first portion of the file name and (optionally) the file directory.
Next increment The value used in constructing the numeric component of the next

file name generated.
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Dump frame count The number of identical bitmap files created when the Plot Dump
button is pressed in Semi-Auto mode. This is useful for displaying a
fixed image for a specified time period in an animation.

Special Note For Bitmap Output:

Bitmap output is created by extracting data from the plot window below the button bar and above
the reporting area (2D plot) or attitude control area (3D plot). The output routine will extract
whatever appears within this area, including overlapping windows and screen-savers. Before
creating animations, make sure that the window is clear of obstructions and that the screen saver
is turned OFF.

8.3.3 Plot Animations

The method used to animate output is to create successive bitmap frames of an animation in
nSIGHTS (see Section 8.3.2) and then to convert the frames to an animation using a third party
tool. For example, to create a five frame animation called test.avi, the third party tool requires a
sequence of files as follows: test0000.tga, test0001.tga, test0002.tga, test0003.tga, test0004.tga.

Currently, the best available tool is a shareware product called VideoMach. VideoMach reads
sequences of TGA files and produces AVI animations. The shareware product is available at:
http://www.gromada.com.

In general, 2D nSIGHTS animations use a limited number of colors and should be constructed
using the Microsoft RLE compressor. This is a lossless compressor which yields very small AVI
files if the 256 color option is selected. U
3D animations with OpenGL lighting frequently use more than 256 colors. Lossless AVI
coder/decoders (codecs) such as Microsoft Video 1 (with 100% compression quality and temporal
quality ratio of 1.0) give the best quality, albeit with larger output file sizes. Lossy compressors,
such as MPEG, frequently leave unattractive visual artifacts. = The most effective lossless
animation format (in terms of smallest file sizes) is the proprietary HAV format created by VM.
However, it is not supported for use in other third-party tools such as Director or Power Point and
requires use of the freeware HAV file player (also available from www.gromada.com). The HAV
file play is superior to the Windows Media player in many ways.

8.3.4 View Animation Control

For 3D plot windows, selecting the View Animation item on the Control menu will cause a new top-
level dialog window to appear, as shown. This menu is used to control the view-related aspects of
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the 3D display independently of the slider bars, including smooth transitions from one view to
another. This feature, shown in figure 67, is useful for animations.
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Figure 67. View Animation on the Control Menu

Each row on the menu gives two values for one element of a view. These correspond to the start
and end values for the view transition.

A toggle box item specifies whether log (on) or linear (off) increments are to be used for the scale
component of the view.

The other data item on the menu, # of frames, controls the size of the increment used in each step of
the transition.

The push buttons perform the following:

Step Add one increment to each element of the current view. Increments are calculated
as increment = (end value - start value) / # of frames. Step is most often used with
a small # of frames (20 or less) to verify the view transition before performing an
animation.

Anim. Set the current view to the start view then perform # of frames steps as described
above. This is most often used in conjunction with Aautomatic@ TGA output (see
Section 8.3.2) to produce individual frames for creating an animation. While
animating, the text on the button will change to AStop@. Pressing the button will
stop the current animation.

2Start Changes the current view to the start view.

2End Changes the current view to the end view.
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Set Start

Set End

End2Start

Close

Sets the start view in the dialog to the current plot view.

Sets the end view in the dialog to the current plot view.

Copy all end values to start values. This feature is useful when performing

multiple view change animations.

Closes the dialog.
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9 NPOST LISTS

nPost has a list page with functionality similar to the List menu in nPre (see Section 2.3.5.8). The
list page has an associated top-level window, which displays text information regarding the list
objects within the list page. Whereas the list window in nPre displayed input information, in
nPost, the list window displays output information.

Table 9.1 provides a summary of the available list objects, and the type of information displayed
in the List window. List objects are described in detail in Appendix C.

Table 9.1: List Objects Function Summary

Object

Description

Covariance List

Provides the values of the covariance matrix.
Input: Extract Covariance Matrices

Jacobian List

Displays Jacobian data, as well as each parameter’s and each fit's percentage
of the total sensitivity.

Input: Extract Jacobian Data

Optimization Results

Details Optimizer Results output, including a summary of the simulation, fit
value data, fitted parameter values, parameter correlation values and 95%
confidence intervals.

Input: nSIGHTS Optimizer Results
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10 NPOST OUTPUT

nPost also has an output page, with its own set of objects. Some of these objects are available as
data objects in nPre. The page and its objects are for the sole purpose of exporting nSIGHTS data
into a text file, for use with nSIGHTS or other software packages.

Table 10.1 provides a summary of the available output objects, the type of data exported, and if
applicable, the nSIGHTS default file extension. Output objects are described in detail in Appendix

D.

Table 10.1: Output Objects Function Summary
Object Description

Write Color Map File Writes a color map to a file.

Input: color map
File Extension: *.cmap

Write Curve File

Writes single or multiple curve data to a file.
Input: curve data
File Extension: *.nCRV

Write Grid File

Writes grid data to a file in standard, surfer or xyz format.
Input: table data
File Extension: *.grd

Write Table to File

Writes a table to a file.
Input: table data

Write XY Data to File

Writes XY data to a file.
Input: XY data
File Extension: *.dat
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11 TUTORIAL

The tutorial in this section provides a guide to the process of developing an nSIGHTS application
for well test analysis. There are many ways nSIGHTS may be used to conduct well test analysis,
and this tutorial will focus on the optimization of a constant-rate pumping test.

It should be noted that the focus of this tutorial is accessing the many tools available in nSIGHTS,
and not the interpretation of well-test results. The tutorial covers the following topics:

e The set up of a model run and the creation of diagnostic plots (Entering Model Input).
e The execution of the model (Executing the Model).

e Evaluating model results, through a variety of different types of plots and text output
(Evaluating Model Results).

Field data for the tutorial is required, and is provided as a text file (PMP.DAT).

11.1 Test Description

The tutorial will use the draw-down period of a constant-rate pumping test for analysis. Details of
the test are summarized below.

e Pressure units are kPa

e Time units are hours

e Duration of test is 100 hours

e Test zone is isolated by packers

e Test zone length (or formation thickness b) is 10 m
® Pumping rate is -5 gpm (i.e. withdrawal of water)

e Static formation pressure is 2000 kPa.

11.2 Entering Model Input

The first step in conducting well test analysis within nSIGHTS is to enter the well test
characteristics. nPre is the nSIGHTS module where data are input, and the model executed.

Start nPre. The nPre main menu will appear, as shown in figure 68.
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Figure 68. Entering Model Input on nPre Main Menu
The main menu contains a list of nPre input windows within the nPre control bar. Each input
window contains dialogs for data input that describe the well test model. The default input

window is the Configuration input window. Note that the object description area displays
“Configuration — Main”.

The tutorial will now proceed through the different input windows requiring input for this

example. Some windows have defaults that are sufficient for this example, and are therefore not
described.

11.2.1 Configuration Input

As most of the defaults apply to the well test, changes only need to be made in the Main tab and
the Default Units tab:

@)) Main Tab: Select Optimization as the Simulation Type.

(2) Default Units: Select hour for the Time units, and USgpm for the Volumetric flow rate.

It is also wise to enter a description of the model run in the Test Description tab.

Save the model configuration as Tutorial.nPre, using the standard Windows save button, or
File>Save. Remember to save the configuration file from time to time.

11.2.2 Field Data Input
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At this point, existing field data are imported and plotted using the Auto Setup->Field Data Plots
command.

(1) Select the Auto Setup->Field Data Plots.

(2) A dialog will appear as shown in figure 69:

fruto ricdvatondpirsenp )
[ ] I Concet
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Inpu File Type
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Plots To Creato
l' F;Pressure ) Flow J

Figure 69. Automated Field Data and Plot Setup Window

Keep the defaults, and select OK.

(3)  Two pages will be created in the Field Data object tree window: one data page and one
plot page. In the first data page, P_input, select the Read XY Data object, f/PDAT.
e Use the browse button to find the file “PMP.DAT".
e Select the Apply button. Data Status will indicate that 251 point have been read.
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Figure 70. Read XY Data

(4)  Within the P_Cartesian plot page, select the Pressure XY Data Series object. Auto setup
has already selected the field data pressure and the simulated data pressure. Upon
selection of the object, its status will be updated to normal.
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Figure 71. XY Data Series

(5) The Sequences Sequence Grid Lines object will plot grid lines defining the
beginning/ending of all sequences, once sequences are defined.

(6)  To view the field data plot, select the 2D plot window (Window->Fld::P_Cartesian). The
window should appear blank, with both axes set at a scale of 0 to 10. To re-scale the axes,

select the Reset View button (L_l) or Axes->Data Limits from the 2D pop-up menu (right
click within the 2D plot window).
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Figure 72. Cartesian 2D Plot Window

(7 To add axes labels to the plot, select the 2DplotAnno object in the P_Cartesian 2D plot
page. In the Format frame, toggle on the Axis Labels checkbox. In the Labels frame, type
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Time (hours) for the X Axis label, and Pressure (kPa) for the Y Axis label. Select the
Apply button. For the Y axis’labels to fit within the plot window, the left margin may need
to increased in the 2D-XY object.
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Figure 73. 2DPlot Annotation

(8)  To change the title of the plot, select the Title User Labels object in the P_Cartesian 2D
plot page. Change the Enter Title text to Field Pressure Data Time Series. Select the
Apply button.

11.2.3 Sequence Input

Sequences define a time period that describes one set of well-bore conditions. For the example
test, only one sequence occurred: the draw-down period (a flow sequence). Sequence input
options are located under Sequence in the UI window.

Once sequences are defined, diagnostic plots of the simulated data can be generated (using Auto

Setup->Sequence Plots). These plots can be defined even though the simulation output does not yet
exist. The display of simulation output objects will remain empty and plot objects will show

incorrect object properties status (3 ), until a simulation has been executed.

11.2.3.1  Defining the sequence

(1) In the Sequences tab, keep the default sequence type and designation. Click in the Duration
cell, and type 100. The sequence duration is therefore 100 hours.

(2)  Double click on the Sequence Data cell (currently says “BAD”). A dialog will appear in a
separate window, as shown in figure 74:
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Figure 74. Flow Sequence Setup Dialog
This dialog describes the time stepping to occur within the sequence, as well as the
sequence well-bore boundary conditions:
e Type -5 in the Fixed flow text box.

e Change the Wellbore storage to /solated.
e As the remaining defaults are fine, select the OK button.

3) The Sequence Data cell should now read “OK”. The sequence has now been defined.
11.2.3.2  Generating diagnostic plots
(1)  Select Auto Setup=>Sequence Plots.

(2) A dialog will appear as shown in figure 75:
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Figure 75. Sequence Data and Plot Setup

e In the Flow Sequences frame, select Extract and Std Diagnostic checkboxes.
e Select OK.

(3)  One data page and one plot page will be created.
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Figure 76. Extract Sequence Interval Window
The data page, F_01_process, will contain two Extract Sequence(s) objects:

e F 0]_fPDAT contains the field pressure change data for the flow sequence F_01. The
pressure change is calculated from the pressure field data with the Adjust start and the
ABS(Y) checkboxes. Adjust start, with the start at 0.0, will subtract the initial pressure
from subsequent pressures, and ABS(Y) will take the absolute value of the offset
pressure. This is the same transform applied to the field pressure data in the dP
Scale/Transform object within the Field Data input window.

o F 0] _sPDAT contains the simulated pressure change data for the flow sequence F_01.
Pressure change is calculated as above.

The data page F_0] process will also contain two P(t) Derivative Calculation objects,
F_01_fdP/dint and F_01_sdP/dInt, which calculate the derivative of the field and
simulated pressure changes, respectively, for the F_01 flow sequence.

The plot page, F_01_diag, plots field and simulated pressure change, as well as their
derivatives.

To increase the line width of the simulated pressure change:
e Select the P object.

e Change the line width of the simulated data to 3 pix.

e Select Apply.

As well, the colors for the derivative objects should be changed, in order to differentiate

between pressure change and the derivative of pressure change. The line width of the
simulated derivative will also be increased, to correspond with the line width of the
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simulated pressure data.

e Select the dInP object.

In the first color drop-down list (currently selecting Red), select Biue.

In the second color drop-down list (currently selecting Green), select Magenta.
Change the line width of the simulated data to 3 pix.

Select Apply.
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Figure 77. Sequence — Process/Plot XY Data

(8) To add a legend to the plot, create a new object in the F_0I_diag plot page. Select
Object>New->Anno: Series Legend. The Object menu is accessed by selecting any of the
objects in the F_0]_diag plot page, and right-click to bring up the Object pop-up menu.
Alternatively, use the Object menu in the menu bar.
¢ Check the top toggle box, and select Series Legend P F_01_diag Sequence from the

drop-down list. Check the second toggle box, and select Series Legend dinP
F 0] diag Sequence from the drop-down list.
e Select the Apply button.
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Figure 78. Series Legend Sequence Process/Plot Window

To add axes labels to the plot, select the 2DplotAnno object in the F_01_diag plot page.
In the Format frame, toggle on the Axis Labels checkbox. In the Labels frame, type Log
Elapsed Time (hours) for the X Axis label, and Log Pressure Change (kPa) and
Derivative for the Y Axis label. Select the Apply button. For the Y axis labels to fit within
the plot window, the left margin may need to increased in the 2D-XY object.

To change the title of the plot, select the Tit/le User Labels object in the F_0/_diag 2D
plot page. Change the Enter Title text to Standard Diagnostic. Select the Apply button.

The Optinfo Data Labels object in the F_0] diag plot page will force the plot to be
updated with each step of the optimization. By default, this label is not plotted (i.e. the Plot

toggle is off).

To view the plot, select the plot window using the Window->Seq::F_01_diag command.
Alternatively, select Window=>Window List (or F11), which brings up a window containing
a menu of all available windows, shown in figure 79.

Figure 79. Windows Available List Window
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Select Seq::F_01_diag in the menu, and the window will be brought to the top. The window
list menu window is a convenient way to switch between the main and plot windows.

(13)  The plot window should appear blank, with both axes set at a scale of 0 to 10. To re-scale

the axes, select the Reset View button (@j), or Axes->Data Limits from the 2D pop-up menu
(right click within the 2D plot window). The legend and data labels may be moved by
selecting the objects within the window, and dragging. Note that only field data is plotted,
since simulation data has not yet been created.
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Figure 80. Plot Window

11.2.4 Parameter Input

Parameter values are entered into the tables provided in the tabs of this input window. Only
parameters required (based on the current model configuration) will be shown.
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Figure 81. Parameter Input Window

The parameter value is entered into the Value cell. Before entering the parameter value, the units
should be defined in the Units cell. Changing the Units cell after the Value cell will cause the value

to be converted to the new units.

Enter the parameter values, as specified in the following table
(check the units!). For parameters not specified, keep the default values.

Parameter | Value | Units
Formation tab

Formation thickness 10 m
Flow dimension 1.6

Static formation pressure 2000 kPa
External boundary radius 1.0e+05 m
Formation conductivity 1.0e-05 m/s
Formation spec. storage 1.0e-07 1/m
Test-zone tab

Well radius 4 in
Volume change from normal 0.0 m’
Test-zone compressibility 3.0E-08 1/Pa

While entering the parameters, the width of the Value column may need to be adjusted in order to
view the value. Place the cursor on the table heading of the Value column, and double click. The
column will be automatically adjusted to fit the values entered within the column.

Each parameter also has a type, specified in the Type column. The default type is Constant. For an
optimization simulation, fitting parameters are specified by changing the parameter type to
Optimize. Fitting parameters are the parameters the model adjusts in order to obtain an optimal fit

to field data.

Information Only

128




Once a parameter type has been changed to Oprimize, the Value cell will read “BAD”. Double
clicking on the Value cell will bring up an Optimized Value Dialog, with the inputs required for the
parameter. Once the optimized parameter inputs are completed correctly, and the dialog OK
button selected, the Value cell will read “OK”.
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Minimum veluo |- [ P
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i Stepping v .- [Dneer ~] ;

Figure 82. Optimized Value Dialog Window

For this tutorial, change the parameter Type to Oprimize for the parameters specified in the table
below. Then for each fitting parameter, double click on the corresponding Value cell, and
complete the required inputs of the Optimized Value Dialog, also specified in the table below. Note
that the Best Estimate Value is automatically the parameter value that was previously entered.

Parameter Minimum | Maximum | Best Stepping Estimated

Value Value Estimate std. dev.
Value

Formation Tab

Flow dimension 1.0 3.0 1.6 Linear 1.0

Static formation | |50 yp, | 2500kPa | 2000kPa | Linear 1.0

pressure .

SN 1.0E-6m/s | 1.0E-4m/s |10E-Sm/s |Logarithmic | 1.0

conductivity

Formation

: 1.0E-8 m/s | 1.0E-6 m/s 1.0E-7 m/s | Logarithmic 1.0
specific storage

Test-zone tab

Test-zone
compressibility

1.0E-9 m/s 1.0E-7m/s | 3.0E-8 m/s | Logarithmic 1.0

11.2.5 Fit Specification Input

Within this input window, the field and simulated data sets to be compared are specified using the
Auto Setup>Basic Fits command. These specified fits between field and simulated data are also
called constraints. The nSIGHTS model will adjust the specified fitting parameters in order to
achieve a match between the field and simulated data. The Fit Specification options are located
under Fit Specification in the Ul window and is only available when the Simulation type is set to
“optimization” and/or Simulation sub-type to “range”.

In general, multiple constraints will reduce the uncertainty of parameter estimates. However, to
give each constraint equal weight in the regression process, the range of Y values for each
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constraint must be equal or very similar. For a set of constraints that varies over several orders of
magnitude, the log of the constraint may be used.

Two constraints will be used in this example: pressure change and the derivative of pressure
change. As the Y value of the two constraints vary over several orders of magnitude, the log of
each constraint will be used.

(1)  Select Auto Setup->Basic Fits.

(2) A dialog will appear as shown in figure 83:
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Figure 83. Fit Specification Input Setup Window

In the Cartesian Fits frame, remove the Fit selection.

In the Flow Sequence Fits frame, select Fit, log Pressure, log dPressure, and Combined
checkboxes.

e Select OK.

(3)  One data page will be created:
e Four Single Scale/Transform objects take the log of field and simulated pressure
change and the derivative of pressure change.
e Two Single Fit objects pair field and simulated data, one fit for pressure change, and
the second fit for the derivative of pressure change.

¢ A Combined Fit object combines the two single fits, to be solved simultaneously by
the model.
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Figure 84. Fit Selection Tab of the Fit Specification Input Window

As well, within the Fit Selection tab, three Optimize? checkboxes will be selected, and the

adjacent drop-down lists will select each single fit, and the composite fit.

For this

example, we only want to use the composite fit (i.e. we want the model to fit all three

constraints simultaneously).

unselected, leaving only the composite fit selected.
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Figure 85. Fit Selection Tab with Optimize Fit Selected
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Therefore, the first two Optimize? checkboxes should be
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11.2.6 Output File Setup Input

Within this tab, the available output files are specified. The Output File Setup option is located on
the UI window.

(1) In the Optimization tab, select the checkbox Write omimizuli(.:m outpult,

2) In the File name box, use the browse button to specify the output file location. Name the
file Tutorial.nOpt.

3) Select yes for Store residuals and Store Jacobian data drop-down-boxes.
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113 Executing The Model

Before executing the model, save the nPre configuration file.

To execute the model, select the Verbose command from the Run menu. A window will appear,
tracking the model as it conducts the simulations.
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Figure 86. Combined Optimization Fit ID Screen

As there is only one case in this example, there is no progress bar (a progress bar tracks the
number of cases completed for runs with multiple cases).

To view the real-time progress of plots developed in the Processing Setup input window, select the
Minimize button. The run window and the main window will be minimized, leaving only plot
windows on the screen.

The model run should take less than a minute. Once it is finished, look at the Seq:F 0] _diag plot,
which should now show data for simulated pressure and its derivative:
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Figure 87.

After examining this plot, close nPre.

11.4 Evaluating Model Results

Many tools are available in nSIGHTS to evaluate test results. The simulation mode used dictates
a test's output and consequently has a bearing on the analysis tool used. For example, a range grid
is only output for range runs. Due to the great number of tools, and the myriad of ways of
implementing these tools, only a few analysis tools will be examined in this tutorial. As the
tutorial model ran in optimization mode, the model results evaluation will be specific to
optimization mode.

Within this tutorial, a process for evaluating uncertainty in the well test simulation developed in
nSIGHTS will be followed, as described in an article by R. M. Roberts, R. L. Beauheim and J. D.
Avis (Quantifying Parameter Uncertainty in Well-Test Analysis, In Proceedings of International
Groundwater Symposium, pg 238-239, Lawrence Berkeley National Laboratory, Berkeley, CA,
March 25-28, 2002). The focus of the tutorial will be the steps required to produce the various

plots, and not on interpretation of the results. The user is referred to the article above for details
on interpretation of results.

The steps in the uncertainty analysis are summarized as follows:

¢ Evaluation of constraints and fitting parameters based on the sensitivity of fitting parameters
to the chosen constraints.

* Residual analysis to determine whether the conceptual model adequately reproduces observed
data.
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e Quantifying uncertainty in the estimates of fitting parameters, through:

evaluation of joint confidence regions
perturbation analysis
uncertainty distributions for non-fitting parameters

Most of this analysis is conducted in nPost, designed as a post-processor for the nSIGHTS model.
The last two methods, perturbation analysis and uncertainty distributions for non-fitting
parameters, require the model to be run again under different conditions, and therefore are partly
conducted in nPre.

11.4.1Evaluation of Constraints and Fitting Parameters

Within nPost, a plot of the Jacobian matrix is used to evaluate the sensitivity of fitting parameters
to the constraints. The sensitivity of a fitting parameter to a constraint indicates the effectiveness
of a constraint in providing an estimate of that fitting parameter.

(M
)

)

(4)

®)
6

Open nPost.

Rename the default data page Input Data (by changing the object ID of the DataPgDesc
object).
\

Create a new object: Object->New->Read Input->nSIGHTS Optimizer Results.

The Object menu is accessed by selecting any of the objects in a page, and right-click to
bring up the Object pop-up menu. Alternatively, use the Object menu in the menu bar.
Note that the Object menu is page type specific.

The optimization results output file of the model run will be imported within this object.
e Select the file Tutorial.nOpt using the browse button.
e Select Apply.

Create a new data page. Rename the page Jacobian Data.

In the Jacobian Data data page, create a new object: Object->New>nSIGHTS Results
Extraction Extract Jacobian. Select Apply.
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Figure 88. Select Jacobian Data Window

7 Create a new object: Object->New->Table Processing->Jacobian to Table.
e Change the Object ID to Jacobian log P.

* In the Fit(s) drop-down-box, select F 0/ _logP.
e Select Apply.
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Figure 89. Jacobian to Table Window
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(8) Create a 2D plot page (Page>New 2D XY Plot).

e Inthe 2D XY object, change the name of the page to Jacobian Iog P Plot, and change

the left margin to 100. Select Apply.
¢ Inthe X Axis object, change the Axis Type to Logarithmic.
e Select the 2D Plot Anno object.

Check the Axis Labels box, and type Log Elapsed
Time (hours) for the X axis and Sensitivity for the Y axis labels. Select Apply.

(9)  Create a new object in the Jacobian log P Plot plot page: Object»New->Data: Single Table

Series.

e The Table Data should already select /og P Jacobian.

e Select the first five check boxes. The five fitting parameters should be automatically

selected in the drop-down-boxes (e.g. Test-zone compressibility).

e Select Apply.

Il W2 Tulorial.nPost - nPost

j Fle Object Page View W

w1

[|&-8 Input Data::Data ;
! - Input Data; :DataPgDe;

i ‘ '—n Tutorial 1.nOpt: :ReadO

€3 Jacobian Data::Data

{| |33 selectoptiacob: Sekect
,l Ellﬂlacoumlogppbt::w I
[ i ¥ Jacoblan log P Plot::2C
4t 1D Axes::X Axis I

~3t 1D Axes::Y Axis y
-1t 2DPlotAnno:: 2DPIOtAN
[ [Tebieseries T TebleSene

41 F-4t dacobian Data::Datarg)|

-3% log P Jacoblan::Jacobk|

TS v L™
ISohd E; " v &
v‘.‘ 1]

——— T

= |—z-:u "

rObject ID— -t
|Tahre$enas T
-TableData o i
| log P Jacobian
~Optiona - =
! Z3Piotell rows LI A
= o - = n_m-
7 --ITesl—:onu coi' |_i > I- Red = I'
) g T T
CNew Labal
= “
I [Farmation cuﬂ'-'li -
§ A S et - e ————
- IsNew Lebel :
i ’El F} ’ i - _. y
]Stubc fUrmﬂlllj' h S -
| «_TNewlebel -
(| - _ Tu )
1 |FTWdimBn5i‘ - L- ] Ma ; Ir
! A e L e
! "jNew Labsl
e ' ine i
| T
|| g IForrnntion spll® II I- Ovan .‘;'-‘IJ
et e
i ' JNewLabel
il ' | Line.
i |Furm=lion sp'_]l 10g lagk !j_:ﬂ
I QNewLahel

e Vit = g it S e S S —

(10) Create a legend for the plot: Object->New->Anno: Series Legend.
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Figure 90. Table Data Series Window
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e Select the first checkbox. The table series should already be selected in the adjacent
drop-down-box (Series Legend TableSeries Jacobian log P Plot).

e Change the Legend Font Size to /2 point.

e Select Apply.

(11)  View the plot by selecting the Jacobian log P Plot plot page from the Window menu, or
from the Window List window. The axes limits will need to be reset (select Axes->Data
Limits in the 2D window pop-up menu), and the legend moved to an appropriate location
(simply drag with the mouse).
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Figure 91. Jacobian Log P Plot

(12) Steps (7) through (11) can be repeated for the F 0/ log dP fit.

Now is a good time to save the nPost configuration file. Name the file Tutorial.nPost.
11.4.2Residual Analysis

Residuals are analyzed to determine whether the conceptual model sufficiently describes the
observed data. Residuals should reflect random noise in the data, and be approximately randomly
distributed (assuming the random noise to have a normal distribution). If the data are not normal,
the conceptual model needs to be re-examined, or a reason for the non-normal behavior found
(e.g. equipment problems that cannot be included in the conceptual model).

(1) . Create a new data page. Rename the page Residual Data.

(2) In the Residual Data page, create a new object: Object>New=>nSIGHTS Results
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Extraction>Extract Residuals. Residuals are obtained from the optimization results file,
already imported into nPost.

e Change the Object 1D to log P Residuals.

e Select the first fit, Run #1 Only Case Combined F_01 logP.

e Select Apply.

Create a new object: Object->New->Residual Processing->Calculate Residual Diagnostic.
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Figure 92. Residual Diagnostic Calculation Window

e Change the Object ID to log P Res Diag.
e Keep the default input and settings, and select Apply.

Create a 2D plot page (Page->New 2D XY Plot).

e Change the name of the page to log P Res Diag and change the left margin to 125.
Select Apply.

e In the X Axis object, change the Increment Label Format to Decimal and 0.000, and select
Apply. :

e Inthe Y Axis object, change the Increment Label Format to Decimal and 0.000, and select
Apply.

e Select the 2D Plot Anno object. Check the Axis Labels box, and type Normal
Distribution for the X axis and Residuals for the Y axis labels. Select Apply.

Create a new object in the log P Res Diag plot page: Object->New->Data: XY Series.

e Select the first two check boxes. Select Quantile-Normal log P Res Diag and QuantileLine log
P Res Diag in the adjacent drop-down-boxes.
Change the Quantile-Normal log P Res Diag XY Data representation from Line to Symbol.
Select Apply.
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Figure 93. Data XY Series

Create a legend for the plot: Object->New=>Anno: Series Legend.

o Select the first checkbox. Select SeriesLegend XY Data log P Res Diag from the adjacent
drop-down-box.

e Change the Legend Font Size to /2 point.

e Select Apply.

View the plot by selecting the log P Res Diag plot page from the Window menu, or from
the Window List window. The axes limits will need to be reset (select Axes->Data Limits in
the 2D window pop-up menu), and the legend moved to an appropriate location (simply
drag with the mouse).
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Figure 94. Log P Residual Dialog Plot

(8)  Steps (2) through (6) can be repeated for the F 01 log dP fit.

11.4.3Evaluation of Joint Confidence Regions

Joint confidence regions delineate areas that have a specified probability of containing the true
parameter values. They evaluate the uncertainty in fitting parameter values due to fitting
parameter correlations and data noise. This section will describe how confidence regions are
plotted. Correlation coefficients are only calculated if there are multiple cases (e.g. perturbation
analysis or sampling mode), and the viewing of correlation coefficients will be shown in Section
11.4.4 on perturbation analysis.

(1) Create a new data page. Rename the page Confidence Region Data.

(2) Within the Confidence Region Data data page, create a new object:
Object->New->nSIGHTS Results Extraction>Extract Covariance Matrices. Joint confidence
regions are obtained from the covariance matrix, stored in the optimization results file
already imported into nPost.

e Keep the defaults, and select Apply.

(3) Create a 2D plot page (Page>New 2D XY Plot).
e In the 2D-XY object, change the name of the page to K and n Confidence Region,
change the left margin to 100. Select Apply.
¢ In the X Axis object, change the Increment Label Format to Scientific and 0.0E+00, and
select Apply.
e In the Y Axis object, change the Increment Label Format to Scienrific and 0.000E+00, and
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(4)

®)

(6)

)

select Apply.

e Select the 2D Plot Anno object. Check the Axis Labels box, and type Hydraulic
Conductivity (m/s) for the X axis and Flow Dimension for the Y axis labels. Select
Apply.

Create a new object in the K and n Confidence Region plot page: Object->New->Data:

Confidence Limits.

o Select Formation Conductivity for the X Variable and Flow Dimension for the Y Variable.

e Select Dual as the Limit Type. This will create an ellipse surrounding the confidence
region. Single will display an error bar for each axes.

e Select Apply.

Create a legend for the plot: Object->New->Anno: Series Legend.

e Select the first checkbox. Select SeriesLegend Covar Limits K and n Confidence Region from
the adjacent drop-down-box.

e Change the Legend Font Size to /2 point.

e Select Apply.

View the plot by selecting the K and n Confidence Region plot page from the Window
menu, or from the Window List window. The axes limits will need to be reset (select
Axes>Data Limits in the 2D window pop-up menu), and the legend moved to an
appropriate location (simply drag with the mouse). As well, the plot may need to be
resized in order to see the X axis increments (simply drag a corner of the plot window).
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Figure 95. K and n Confidence Region Plot

Steps (3) to (6) can be repeated for other parameter combinations.
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11.4.4Perturbation Analysis

Perturbation analysis consists of executing a model run in nPre with many simulations; the initial
estimates of fitting parameters for each simulation are randomly perturbed (i.e. initial estimate is
slightly increased or decreased) and the model re-optimizes the fitting parameters from these
perturbed estimates. If each perturbation simulation results in a fitting parameter value close to
the initial estimate, the problem solution is unique and well-constrained.

In this tutorial, it will be demonstrated how to conduct a perturbation model run, and to create
three useful plots for analyzing perturbation results: a histogram, XY scatter plot and XYZ scatter
plot. As well, it will be shown how to view the correlation coefficients in a list page window.

It should be noted that the execution of the model for this example will take considerably more

time than the simple optimization run (e.g. approximately 20 minutes on a 1GHz dual-processor
Pentium I1I equipped with 2GB of RAM).

11.44.1 To conduct a perturbation model run
(1) Open nPre.

(2)  Open the configuration file Tutorial.nPre (File>Open or the standard Windows open file
button).

(3)  Select the Optimization input window. Select the Perturbation tab.
e Check the Do optimization perturbation box.
e Change the Perturbation span to 0.40.
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Figure 96. Perturbation Optimization Input Window

4) In the Output File Setup input window, Optimization tab, change the file name to
TutorialPerturb.nOpt.

(5) Select the Verbose command from the Run menu. As the model executes, a window will
track the progress of the model. Note that the estimated time remaining will fluctuate
considerably until several perturbation simulations have been conducted.

:'I|:I||| ization: Perld 019 ['ll(:onmﬁl!cﬂt
| [Concet | I Mamie |
{w——————
i Time elapsed D.00.07:11 Est. time remaining 0.0012.46

Number of simulations W}
i P

I Optienized variabin Best Fit Value  Current Fit Value

|| Test.zone comprossibity | ZM;{ __1_‘ TIZEDBY|  |1py)

| Fomation conductiety  [ISEEGEY [ATIBETH  jovaac)

Static formation prossure 1999.562 4 i____‘_ 19MOE ] (kP

Flow dimension '___\.51\791_9;.*| 128

Fomation spec. slorage ._551__0_{2_5_9!;!  BIIWEDTY]  [um)

o

Figure 97. Optimization: Pert#019 Fit: CompositeFit
(6) Exit nPre.

11.4.4.2  To create a histogram plot

(1) Within nPost, and the Input Data page, create a new object: Object>New=>Read
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Input->nSIGHTS Optimizer Results.” The optimization results output file of the perturbation
model run will be imported within this object.

e Select the file TutorialPerturb.nOpt using the browse button.

e Select Apply.

(2)  Create a new data page. Rename the page Perturb Results.

(3)  Within the Perturb Results data page, create a new object: Object->New-=> nSIGHTS Results

Extraction=>Extract Optimizer Results Table.

e Select SimOptResults TutorialPerturb.nOpt as the nSIGHTS Opt Results to Select From.

e At the bottom of the property input window, select the All button. All cases included
within the optimizer results file will be selected. '

o Select the Optimization status checkbox. This will include fit value data within the table
(e.g. SSE).

o Select Apply.
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Figure 98. Data — Select Results

(4)  Within the Perturb Results data page, create a new object: Object->New->Table
Processing=> Table Column To Histogram.

Change the Object ID to KTableHistogram.

Select SelectOptResults Perturb Results as the Table Data To Use.

Select Formation conductivity from the Table Column drop-down-box.

Select Apply.
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Figure 99. Data — Table Column Histogram Window

Create a 2D plot page (Page>New 2D XY Plot).

¢ In the 2D-XY object, change the name of the page to K Perturb Histogram. Select
Apply.

e In the X Axis object, change the Increment Label Format to Scientific and 0.0E+00, and
select Apply.

e Select the 2D Plot Anno object. Check the Axis Labels box, and type Hydraulic
Conductivity (m/s) for the X axis and Frequency for the Y axis labels. Select Apply.

Create a new object in the K Perturb Histogram plot page: Object->New=->Data: XY

Histogram.

e Select the first checkbox, and select X Table Histogram Perturb Results from the
corresponding drop-down-box.

e Select %A4vail for Histogram Width. Check P/or in Edges box.

e Select Apply.

View the plot by selecting the K Perturb Histogram plot page from the Window menu, or

from the Window List window. The axes limits will need to be reset (select Axes->Data
Limits in the 2D window pop-up menu).

-
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Figure 100. K Perturb Histogram

(8) Histogram plots can be created for other parameters, by repeating steps (4) to (7).
11.4.4.3 To create an XY scatter plot

(1)  Create a 2D plot page (Page>New 2D XY Plot).

e Change the name of the page to K and n Perturb Scatter and change the left margin
to 100. Select Apply.

e In the X Axis object, change the Increment Label Format to Scientific and 0.0E+00, and
select Apply.

e Inthe Y Axis object, change the Increment Label Format to Decimal and 0.000, and select
Apply.

e Select the 2D Plot Anno object. Check the Axis Labels box, and type Hydraulic
Conductivity (m/s) for the X axis and Flow Dimension for the Y axis labels. Select
Apply. '

(2)  Create a new object in the K and n Perturb Scatter plot page: Object->New->Data: Single
Table Series.
e Select Formation conductivity as the X Data Column.
e Select the first checkbox, and select Flow Dimension from the corresponding drop-down-
box.
Change the Line to Symbol.
Select Apply.

(3)  View the plot by selecting the K and n Perturb Scatter plot page from the Window menu,
or from the Window List window. The axes limits will need to be reset (select Axes->Data
Limits in the 2D window pop-up menu).
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Figure 101. K and n Perturb Scatter Plot

A useful addition to the XY data plot are the confidence regions for each perturbation.
Return to the Perturb Results data page, and add an Extract Covariance Matrices object

(Object->New>nSIGHTS Results Extraction=>Extract Covariance Matrices).

e Select SimOpiResults TutorialPerturb.nOpt from the nSIGHTS Opt Results To Select From

drop-down list.

e (Check the Multiple checkbox in the Index Selection Value Source frame.

Press the All button.
e Select Apply.

Return to the X and n Perturb Scatter plot page, and add Object->New->Data: Confidence

Limits.

e Select Perturb Results as the Covariance Data.

Select Limit Type Dual.
Select Apply.

View the K and n Perturb Scatter plot page again.

Select Formation conductivity as the X variable, and Flow dimension as the Y variable,

Information Only
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Figure 102. K and n Scatter Plot

(7) XY scatter plots can be created for other parameter combinations, by repeating steps (1) to

(6).
11.4.4.4

To create an XYZ scatter plot

(1)  Create a 3D plot page (Page>New 3D XY Plot).

Change the name of the page to K and n XYZ Scatter. Select Apply.

In the X Axis object, change the Increment Label Format to Scientific and 0.0E+00, and
select Apply.

Select the 3D Axes Label object. Check the Axis Labels box, and type Hydraulic
Conductivity (m/s) for the X axis, Flow Dimension for the Y axis labels and SSE for
the Z axis labels. Select Apply.

(2)  Create a new object in the K and n XYZ Scatter plot page: Object->New->Data: Table Series.

L]
L]

Select Formation conductivity as the X Data Column, select Flow Dimension as the Y Data
Column, and select SSE as the Z Data Column.

Change the Line to Symbol. Change the symbol to Filled C.

Select Apply. ;
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Figure 103. 3D Table Data Series Window

View the plot by selecting the K and n XYZ Scatter plot page from the Window menu, or
from the Window List window. The axes limits will need to be reset (select Axes->Data
Limits in the 2D window pop-up menu). As well, the plot’s view can be adjusted, using

the slider controls at the bottom of the window.
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Figure 104. K and n XYZ Scatter Plot
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(4) XYZ scatter plots can be created for other parameter combinations, by repeating steps (1)
to (3). Confidence limits may also be added, if all three parameters are fitting parameters.

11.44.5 Viewing Correlation Coefficients
To view a table showing the correlation coefficients between parameters:
(1)  Create a list page (Page->New List).

(2)  Within the list page, create a new object: Object->New->Optimization Results. The page will
automatically be named the object ID of this object.
e Select the SimOptResults TutorialPerturb.nOpt from the Optimization Results to List drop-
down-box. :
Select Runt# in the Selected Runs to List frame.
Select only the Parameter correlations checkbox in the Listing Selections frame.
Select Apply.

(3)  View the list page by selecting the OptRun:List page in the Window menu or the Window
List window menu. The list page will contain text, providing the correlation coefficients
between parameters.

Josmur View

&l R : v
nPost 0.90P iTi

Version date 24 Jun 2002 {
Listing date 27 Jun 2002
1 @n status QA: no (beta) i
config file  C:\nSights\Tutoriel\Tutorial.nPost . {

H

|

4

Run#1/Combined : 50 Perturbations f.

i

Parameter Corvelations 3}
i

{ PeacsonR ctz K_fm P fo n  ss_fa FitValue '_u
c_tz 1.000  0.586 -0.043 -0.047 -0.899 -0.950 i
1Kt 1.000 -0.002 -0.765 -0.6683 -0.376 5
7 1.000 -0.037 0.030  0.032 It
in 1.000  0.370 -0.220 H
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Figure 105. OptRun:List page in the Window Menu or the List Windows Window
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11.4.5 Uncertainty Distributions for Non-fitting Parameters

As with perturbation analysis, examining the uncertainty in fitting parameter uncertainty due to
non-fitting parameter estimates requires running many simulations in nPre. For each simulation, a
set of non-fitting parameters are determined randomly from an uncertainty distribution (i.e.
optimization-sampling mode) and the model re-optimizes the fitting parameters. Correlations
between non-fitting and fitting parameters can be observed from the results.

In this tutorial, it will be demonstrated how to conduct an optimization-sampling model run. As
with perturbation analysis, a useful plot is the XY or XYZ scatter plot. Variables in an XY or
XYZ scatter plot may be optimized parameters or sampled parameters. Extraction of results and
creation of XY scatter plots is described in the perturbation analysis section. During extraction of
the optimization results table (Extract Optimizer Results Table object), the Case Parameters
checkbox should be selected in order to include sampled parameters in the resulting table data.

It should be noted that the execution of the model for this example will take considerably more
time than the simple optimization run (e.g. approximately 10 minutes on a 1GHz dual-processor
Pentium III equipped with 2GB of RAM).

To conduct an optimization-sampling model run:
(1) Open nPre.

(2)  Open the configuration file Tutorial.nPre (Filel—>0pen or the standard Windows open file
button).

3) Select the Optimization input window. Select the Perturbation tab.
e Uncheck the Do optimization perturbation box.

)] Select the Configuration input window. In the Main tab, select Sampling as the Simulation sub-
type.

(5) In the Parameter tab, select non-fitting parameters to be sampled. For the parameters
outlined in the following table, select Sample in the Type cell, and double click on the Value
cell to bring up the Sample Value Dialog. Enter the parameters provided in the table below.

Parameter Distribution Distribution Definition

Formation thickness | Uniform Low limit 8 m Upper limit 15 m
External boundary | Normal Mean 1E05 m St.dev. 100m
radius

Well radius Normal Mean 4 in St.dev. 0.5 in

(6) In the Sampling tab, select no for User specified variable correlations.
(7) In the Output File Setup input window, Optimization tab, change the file name to
TutorialSampling.nOpt.
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(8) Select the Verbose command from the Run menu. As the model executes, a window will
track the progress of the model. Note that the estimated time remaining will fluctuate

considerably until several perturbation simulations have been conducted.

Figure 106. Optimization Sample # 005 Fit: CompositeFit Window

(9)  ExitnPre.

Optirnization: Sampleg 005 Fit: CompositeFit

e oy
v Cancel | | Minimize I

Number of simulations | 3}

Optimized variable Best Fit Value  Currant Fit Value

Frestz0ne compressibility rml |WMC§1 [1/Pa)

Formation conductivity w m! [m/sac]
0018674 |, WRONS (kPa)

Static formaticn pressure
Floi Simanvien [ 1sssissy [ vseasiy g
Fommation spec slorage I 2.25276E08 | RMZ?E}@J (Vi)

Il.:_— s Bl e S EEER N, o TELo e P mvei T ;.f‘.'__'_,__’
Time elapsed 0000125 Est. time remaining 0.00.34.00 3.
Optimizing ...

To create XY and XYZ scatter plots in nPost, refer to Section 11.4.4. The following is an
example of an XYZ plot:

DK, nand b X¥YZ Scalter

fstndrd Output  Control * View > .
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Figure 107. K, n and XYZ Scatter Plot in nPost
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12 APPENDIX A - DATA OBJECT DESCRIPTIONS

12.1 Add Noise
What: Adds noise to Y data randomly based on a Uniform or Normal distribution.
Why: Used to create synthetic data.
Used By: Any object using XY data.
Appearance':
; t‘éﬁﬂe;f: B il vt e R eies Rl e =l |
fm-:ummm [Unitorm =i
:Slmdurd Cevintion W
| Noiss Ranas [ﬁ‘—_
| Random Seed —HW
.-Dm.lh" i . i
- e————— = )

Input Data: XY data
Output Data: XY data

Properties:
Add Noise

Noise Distribution

Standard Deviation
Noise Range
Random Seed

Output Description

Figure 108. Add Noise Option

A Uniform or Normal distribution can be selected.

For a normal noise distribution, the standard deviation limits
the range of the added noise.

For a uniform distribution, the noise added to the data is
limited to the entered range.

The random seed used to generate the noise in the data is
entered, in order to be able to reproduce the added noise.

Provides a description of the object, which will be used as
the object type in drop-down lists, and the label of the object
in a Series Legend.
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12.2 Add XY to Array

What: Creates a collection of XY data from a single XY data object. Each time the
Apply button is selected within the specified input XY data object, new XY data
are added to the array. For example, if an Extract XY object (extracts XY data
from a grid) is used as input, XY data for different Extraction Constant Value can
be added to the array by changing the Extraction Constant Value in the Extract XY
object and pressing the Apply button.

Why: To create an XY array from a data source containing many sets of XY data, but
not in an XY array format (e.g. a grid, a curve file or a table).

Used By: Any object using an XY array, such as Array Scale/Transform or XY Array
Horsetail.

Appearance:
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Figure 109. XY to Array

Application: nPost

Input Data: XY data

Output Data: XY array

Properties:

Input XY Data Select the input XY data source for the array. Each time the input
XY data source is changed (i.e. the Apply button is selected for the
input XY data object), the new XY data will be added to the array.

Status

# of rows Indicates the number of XY data sets in the array. Each XY data set

is one row within the array.
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12.3 Array Scale/Transform

What: Performs mathematical operations on XY array data types.
Why: Unit conversions or other data manipulations.
Used By: Any object using an XY array, such as XY Array Horsetail or Select XY
from XY Array.
Appearance:
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Figure 110. Array Scale/T ranstlonn
Application: nPost
Input Data: XY array
Output Data: XY ‘array
Properties:

XY Array Input Data The input XY array data set that is scaled and/or transformed is
selected.

Data Components to Operate On
X Data If selected, the X data of the array are scaled and/or transformed.
Y Data If selected, the Y data of the array are scaled and/or transformed.

The remaining scale/transform options are described in Section 7.1.3.
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12.4 (Basic) Single Fit

What: Pairs field and simulated data to be selected as a constraint. Typically used in
the Fit Specification/Graphics tab of the Fit Specification nPre input window.
Why: Used to determine the field data that simulated data should be compared to
during an optimization or range simulation.
Used By: Fit Selection tab of the Fit Specification nPre input window.
Appearance:
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Figure 111. Single Fit Object Window
Input Data: XY data
Output Data:  fit specification
Properties:
Field Data Select XY or table data representing field data.

Simulation Results

Std dev of measurement error

Field X Limits

Fit Status

Calculated Fit Value

Field Data Info

Information Only

Select XY or table data representing simulation data.

The standard deviation is used in the calculation of the Chi-squared
minimization function.

The X limits of the data, usually time, can be limited between X min

and X max if the limited checkbox is selected.

Once simulation results have been generated, the calculated fit value
for the specified field and simulated data will be displayed.

Provides basic information about the field data selected, including
the total number of points, points before and after the simulation,
and the minimum and maximum X values.
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Simulation Data Info Provides the same information as Field Data Info, but for the selected
simulation data. Will not be active until simulation results have been
generated.
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12.5 Calculate Basic Residual

What:

Why:
Used By:

Appearance:

Application:
Input Data:
Output Data:

Properties:

Processes residuals from selected residual data. Residuals can be sorted in
ascending or descending order, plotted versus the X Value or the data Index,
and/or standardized to make the data comparable to a standard normal
probability distribution.

To manipulate residuals for the creation of specific plots.

XY Series plot object.
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Figure 112. Calculate Basic Residual Window
nPost
Extract Residuals

XY data

Residual Data  Select the residual data to be processed.

Sorting

Options

Standardize

The residual data are not sorted.
The residual data are sorted in ascending order.

The residual data are sorted in descending order.

The X value of the resulting residuals will be equal to the X value of the
input.

The X value of the resulting residuals will be equal to the index of the
input.

If selected, the residuals will be standardized to make the data comparable
to a standard normal probability distribution.
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12.6 Calculate Residual Diagnostic

What: Manipulates selected residual data for a Quantile Normal or Standard normal
residual plot.

Why: To plot a quaniile normal or standard normal residual plot.
Used By: XY Series plot object.
Appearance:
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Figure 113. Calculate Residual Diagnostic Object Window
Application: nPost
Input Data: Extract Residuals

Output Data: Two XY data sets, one containing the manipulated data, the second a
diagnostic line (Quantile Line or CumNormDist)

Properties:

Residual Data The residual data set manipulated is selected.

Diagnostic Type

Quantile-Normal Residual data are manipulated for a quantile-normal plot.
Standard Residual data are manipulated for a standard-normal plot.

Points in Normal Distribution ~ The number of points for the resulting normal distribution is
entered.
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12.7 Composite Fit

What:

Why:
Used By:

Appearance:

Input Data:

Output Data:

Properties:

Combines fit specification objects. A fit specification object contains a pair of
field and simulated data to be selected as a constraint. Typically used in the Fit

Specification/Graphics tab of the Fit Specification nPre input window.
The model will fit all fits specified in this object simultaneously.

Fit Selection tab of the Fit Specification nPre input window.
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Figure 114. Composite Fit Window
Single Fit, Sequence Fit or Composite Fit

fit specification

For each checkbox selected, a fit object is selected. The additional box provides the calculated fit

value for each selected fit object, once simulation results have been generated.

Fit Status

Calculated Fit Value

Information Only

Once simulation results have been generated, the calculated fit value
for the composite fit will be provided.
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12.8 Create Curve from XY Data

What: Creates functional approximations of XY data sets. The functions available
include: Linear, Cubic Spline, Polynomial, Step Mid and Step Full. Each curve
type is described in Section 7.1.5.
Why: Used to represent well-bore boundary conditions as a function of time, and
parameters as a function of radius or pressure.
Used By: The Sequence tab and Parameter tab.
Appearance:
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Figure 115. Curve Functions from XY Data
Input Data: XY data
Output Data:  curve data
Properties:

Curve Input XY Data

Curve Type

Polynomial Order

Spline Settings

Slope

Start Slope

End Slope

Tension

The XY data set to be used as input data for the curve is selected.

The curve type is selected: Cubic Spline, Polynomial, Linear, StepMid and
StepFull. Each curve type is described in Section 7.1.5.

For polynomial curve types, the order of the polynomial, between 1 to 10,
is entered.

For cubic spline curve types, the shape of the curve may be modified by
specifying the function slope at the extremes of the function or the spline
tension.

Function slopes at the extremes of the function are specified by the user
(User is selected), or are not forced to any specific slope (Natural is selected).

For user set slopes, the slope at the start of the function is specified.
For user set slopes, the slope at the end of the function is specified.

Used to modify the shape of the function, increasing the tension factor has
an effect similar to pulling on either ends of a piece of string, whereas
decreasing the tension factor has the effect of providing slack to the piece

. of string.
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12.9 Create Real Value

What: Outputs a single user-specified value.
Why: Used as input for many other objects.
Used By: Many other objects.
Appearance:
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Figure 116. Creating a Real Value Object Number
Input Data: none |

Output Data:  real value

Properties:
Real Value Source Specifies Master/Slave and expose properties. See Section 6.3 for more
information on these properties.
Real Value A real value is entered.
Output Description Provides a description of the object, which will be used as the object type in

drop-down lists, and the label of the object in a Series Legend.
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12.10 Create XY Array

What: Creates a collection of XY data.

Why: Used to create custom XY output from nPre. For example, data processing in
nPre can be output so that the same processing does not need to be repeated in
nPost.

Used By: XY Data tab of the Output File Setup input window.

Appearance:
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Figure 117. Create XY Array Window
Application: nPre
Input Data: XY data
Output Data: XY array
Properties:

XY data sets are added to the array by selecting a checkbox, and selecting an XY data object from
the corresponding drop-down list. A text box is also provided where a short description of the
XY data set may be entered.
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12.11 Data Page Description

What: Contains documentation information. This object does not appear on any
object selection menu. It is automatically created when a data page is created,
and is always the first object on a data page.

Why: To document data processing and visualizations. The object ID for these
objects is also used as the page identifier on the associated page button.

Used By: Nothing (no object output).

Appearance:

S i et e —_—

Figure 118. Data Page Description Window
Input Data: none
Output Data:  none
Properties:

Data Page Description A large text box where up to 20 lines of text can be entered.
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12.12 Dual Scale/Transform

What: Performs mathematical operations on both the X and the Y of XY data.
Why: Unit conversions or other data manipulations.

Used By: Any object using XY data.

Appearance:

Figure 119. Dual Scale/Transform

Input Data: XY data
Output Data: XY data
Properties:

Options

+ve X only If selected, the scale/transform options are only performed on positive X
values, and their corresponding Y values.

The remaining scale/transform options are described in Section 7.1.3.
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12.13 Enter Table Data

What: Allows the user to input or modify table data. Table data can be input or
modified by hand, pasted from the clipboard, or updated from another table
data-type object.

Why: Used to input or modify table data.
Used By: Any object using table data.
Appearance:
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Figure 120. Enter Table Data Screen

Input Data: none or table data
Output Data: table data
Properties:
Input Table Data Table data from an object selected in this drop-down list may be

entered into the table by selection of the Update button.

Update Upon selection of this button, the table will be replaced by the table
values of the object selected as the Input Table Data.

Data Format Specifies the numeric format of the data. Number formatting
options are described in Section 6.3.3.

Entering data into the table, and the object specific pop-up window are described in detail in
Section 7.1.2.

Information Only




12.14 Enter XY Data

What: Allows the user to input or modify XY data. XY data can be input or modified
- by hand, pasted from the clipboard, or updated from another XY data-type
object.
Why: Used to input or modify XY data.
Used By: Any object using XY data.

Appearance:
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Figure 121. Input or Modify XY Data Screen

Input Data: none or XY data

Output Data: XY data
Properties:

Input XY Data

Update

Data Format

XY data from an object selected in this drop-down list may be
entered into the table by selection of the Update button.

Upon selection of this button, the table will be replaced by the XY
values of the object selected as the Input XY Data.

Specifies the numeric format of the data. Number formatting
options are described in Section 6.3.3.

Entering data into the table, and the object specific pop-up window are described in detail in

Section 7.1.2.
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12.15 Extract Covariance Matrices

Extracts covariance matrices from one or multiple simulations of an nSIGHTS

Optimizer Results object. The confidence limits of the covariance matrix can

For the plotting of confidence limits or the viewing of the covariance matrix in

Confidence Limits plot object, or Covariance List list object.

iy Caee | ° —_ﬁl-—r-"r."']:

Figure 122. Extract Covariance Matrices

What:
be plotted using the Confidence Limits plot object.
Why:
a list page.
Used By:
Appearance:
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Application: nPost
Input Data: nSIGHTS Optimizer Results
Output Data:  covariance data
Properties:

nSIGHTS Opt Results To Select From The optimizer results from which the covariance

Options

Fit components

Estimated
Actual

Index Selection Value Source

Information Only

matrices are to be extracted is selected.

Allows the covariance matrix of sub-fits to be
extracted. A sub-fit is a single fit of a composite fit.

Covariance matrices use the estimated standard
deviation specified by the user for each parameter.

Covariance matrices use the actual standard

deviation calculated during the simulation.

A selection box containing a list of the available
simulations allows the user to select the
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None

All

Run

Case

Fit

Master

Expose

Multiple

simulation from which to extract the covariance
matrix. One or multiple selections may be made.

Selection of the simulations may be slaved to another
extraction object. See Section 6.3.1 for more
information on Master/Slave controls.

Selection of the simulations may be exposed. See
Section 6.3.2 for more information on exposed
controls.

Multiple simulations may be selected if this
checkbox is selected.

Only for multiple selections, no simulations will be
selected.

Only for multiple selections, all simulations will be
selected.

Only for multiple selections, all simulations with the
same run identifier as the currently selected
simulation will be selected.

Only for multiple selections, all simulations with the
same case identifier as the currently selected
simulation will be selected.

Only for multiple selections, all simulations with the
same fit as the currently selected simulation will be
selected.

Information Only




12.16 Extract Cube Indexes

What: Extracts cube indices from cube data within set limits.

Why: Cube indices are used to define the cube data to be plotted in a 3D plot.
Used By: 3D plot objects for cube data, Cube Color Block and Cube Color Point.
Appearance:

Input Data: cube data
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Figure 123. Extract Cube Indexes

Output Data:  cube indices

Properties:
Cube Input

Operation

:

A only

A Value Source

A Value

A Operation

The cube data set from which indices will be extracted is selected.

The cube data can be limited by two variables, A and B,
representing the values at each point in the cube. If no data
limitations are desired, select A only, and ensure the A Operation and
A value will include all data.

Values are extracted if the value complies with both A
restrictions and B restrictions.

Values are extracted if the value complies with either A restrictions
or B restrictions.

Data are only limited by the A value.

Master/Slave and expose controls for the A value. See Section 6.3
for more information on these controls.

A value for the A variable is entered.

» (13

Cube data are limited to values “greater than”, “greater than or

Information Only




equal to”, “less than”, or “less than or equal to” the A Value.

B Value Source Master/Slave and expose controls for the B value. See Section 6.3
for more information on these controls.

B Value A value for the B variable is entered.

B Operation Cube data are limited to values “greater than”, *“‘greater than or

equal to”, “less than”, or “less than or equal to” to the B Value.

Information Only




12.17 Extract Grid

What: Extracts a grid from cube data such that every point of the grid represents a
specified constant grid axes value.
Why: To view a slice of the cube data.
Used By: Any object using grid data.
Appearance:
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Figure 124. Extract Grid Screen
Input Data: cube data
Output Data:  grid data
Properties:

Cube Input Data

Extraction Options
Grid X
Grid Y

Interp on log data

Extraction Constant Value Source

Extraction Constant Value

The cube data set from which a grid is extracted is selected.

The cube variable used as the grid X is selected.
The cube variable used as the grid Y is selected.

Linear interpolation between cube points is based on the log
of the cube point values.

Master/Slave and expose controls. See Section 6.3 for more
information on these controls.

The grid is extracted for cube variable values at this entered

value (the cube variable is assumed to be the cube variable
not specified as the grid X or grid Y). If the cube variable
value occurs between cube points, the resulting grid point is
linearly interpolated.
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12.18 Extract Jacobian

What: Extracts Jacobian data from one or multiple simulations of an nSIGHTS
Optimizer Results object.

Why: Jacobian data can be viewed in a list page, or converted to a table for plotting.
Used By: Jacobian to Table data object and Jacobian List list object.
Appearance:
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Figure 125. Extract Jacobian Data Screen

Application: nPost
Input Data: nSIGHTS Optimizer Results
Output Data:  Jacobian data
Properties:

nSIGHTS Opt Results To Select From The optimizer results from which the Jacobian

Index Selection Value Source

Master

Expose

matrix is to be extracted is selected.

A selection box containing a list of the available
simulations allows the user to select the simulation

from which to extract the Jacobian matrix.

Selection of the simulation may be slaved to another

extraction object.
information on Master/Slave controls.

See Section 6.3.1 for more

Selection of the simulation may be exposed. See
Section 6.3.2 for more information on exposed .

controls.

Information Only
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12.19 Extract Optimizer Results Table

What: Extracts a table containing optimized values, case parameters and/or
optimization status from one or multiple simulations of an nSIGHTS Optimizer
Results object.

Why: To examine optimization results.
Used By: Any object using table data, and the Optimization Results list object.

Appearance:
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Figure 126. Extract Optimizer Results Table Screen
Application: nPost
Input Data: nSIGHTS Optimizer Results
Output Data:  table data
Properties:

nSIGHTS Opt Results To Select From The optimizer results from which the optimization
results are to be extracted is selected.

Table Columns

Optimized values If selected, includes optimized values in the
extraction.
Case parameters If selected, includes the values of case parameters

(e.g. suite, range or sampled values for the
simulation) in the extraction.

Optimization status If selected, includes optimization status in the
extraction.
Index Selection Value Source A selection box containing a list of the available

simulations allows the user to select the simulation
from which to extract the optimization results. One
or multiple selections may be made.

Master Selection of the simulations may be slaved to another
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extraction object. See Section 6.3.1 for more
information on Master/Slave controls.

Expose Selection of the simulations may be exposed. See
Section 6.3.2 for more information on exposed
controls.
None All simulations are unselected.
All ' - All simulations are selected.
Run All simulations with the same run identifier as the

currently selected simulation are selected.

Case All simulations with the same case identifier as the
currently selected simulation are selected.

Fit All simulations with the same fit as the currently
selected simulation are selected.
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12.20 Extract Profile Grid

What: Extracts a grid from one or niultip!e simulations of an nSIGHTS profile results
object. The grid will have time and radius for axes, with a pressure value at
each point of the grid.

Why: To examine pressure results as a function of time and radius, spatially.

Used By: Any object using grid data.

Appearance:

o §

Figure 127. Extract Profile Grid Screen

Application: nPost

Input Data: nSIGHTS Profile Results

Output Data:  grid data
Properties:

nSIGHTS Profile Results To Select From

Index Selection Value Source

Master

Expose

Information Only

The profile results from which the profile grid is to
be extracted is selected.

A selection box containing a list of the available
simulations allows the user to select the simulation
from which to extract the profile grid.

Selection of the simulation may be slaved to another
extraction object. See Section 6.3.1 for more
information on Master/Slave controls.

Selection of the simulation may be exposed. See
Section 6.3.2 for more information on exposed
controls.
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12.21 Extract Range

What: Extracts XY data within a specified range.
Why: To examine a specified interval within XY data.
Used By: Any object using XY data.
Appearance:
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Figure 128. Extract Range Screen
Application: nPost
Input Data: XY data
Output Data: XY data
Properties:

Data Component to Operate On

Operation

A and B

A only

A Value Source '

A Value

A Operation

The XY range is extracted based on a range for
either X data or Y data. The limits of the range are
described by two variables, A and B.

The data are limited by two variables, A and B.

Values are extracted if the value complies with both
A restrictions and B restrictions.

Values are extracted if the value complies with either
A restrictions or B restrictions.

Data are only limited by the A value.

Master/Slave and expose controls for the A value. .
See Section 6.3 for more information on these
controls.

A value for the A variable is entered.

XY data are limited to values “greater than”, “greater
than or equal to”, “less than”, or “less than or equal
to” to the A Value.

Information Only




B Value Source Master/Slave and expose controls for the B value.
See Section 6.3 for more information on these

controls.
B Value A value for the B variable is entered.
B Operation XY data are limited to values “greater than”, “greater

than or equal to”, “less than”, or “less than or equal
to” the B Value.

Output Description Provides a description of the object, which will be
used as the object type in drop-down lists, and the
label of the object in a Series Legend.
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12.22 Extract Range Cube

What: Extracts cube data from one or multiple simulations of an nSIGHTS range
results object.

Why: To examine the results of a range simulation with three range variables.

Used By: Any object using cube data.

Appearance:
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Figure 129. Extract Cube Da;ta Screen

Application: nPost

Input Data: nSIGHTS Range Results
Output Data:  cube data
Properties:

nSIGHTS Range Results To Select From

Index Selection Value Source

Master

Expose

The range results from which the range cube
is to be extracted is selected.

A selection box containing a list of the
available simulations allows the user to select
the simulation from which to extract the
range cube.

Selection of the simulation may be slaved to
another extraction object. See Section 6.3.1
for more information on Master/Slave
controls.

Selection of the simulation may be exposed.
See Section 6.3.2 for more information on
exposed controls.

Information Only




|
‘ 12.23 Extract Range Grid
|

What: Extracts a grid from one or multiple simulations of an nSIGHTS range results
object.
Why: To examine the results of a range simulation with two range variables.
| Used By: Any object using grid data.
Appearance:

Application: nPost
Output Data:  grid data

Properties:

nSIGHTS Range Results To Select From

Index Selection Value Source

Master

Expose

Input Data: nSIGHTS Range Results

Information Only

Figure 130. Extract Range Grid Screen

The range results from which the range grid
is to be extracted is selected.

A selection box containing a list of the
available simulations allows the user to select
the simulation from which to extract the
range grid. '

Selection of the simulation may be slaved to
another extraction object. See Section 6.3.1
for more information on Master/Slave
controls.

Selection of the simulation may be exposed.
See Section 6.3.2 for more information on
exposed controls.
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12.24 Extract Real from Table

What: Extracts a table column property (number of rows, minimum value, maximum
value, last row value, or specified row value) and converts it to a real data type.
The real value is displayed in the object property window, in the Current Value
frame.
Why: To examine table column properties.
Used By: Any object using real values.
Appearance:
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Figure 131. Extract Range From Table Screen
Input Data: table data
Output Data:  real value
Properties:

Table Data To Use The table property is extracted from the selected
table.

Table Column The table property is extracted from the selected
table column.

Operation The table property extracted is selected: number of
rows, minimum column value, maximum column
value, last row value or specified row value.

Index of row to select (0 based) If Specified row value is the table property extracted, the
row is specified according to the entered row index.

Current Value Displays the extracted table property value.

Information Only




12.25 Extract Residuals

What:

Why:
Used By:

Appearance:

Application:
Input Data:
Output Data:
Properties:

Extracts residuals (XY data) from one or multiple simulations of an nSIGHTS

Optimizer Results object.

To examine optimization residuals.

Any object using residuals, such as Basic Residual or Calculate Residual
Diagnostic, as well as any object using XY data.

Figure 132. Extract Residuals Screen

nPost

nSIGHTS Optimizer Results

XY data

nSIGHTS Opt Results To Select From

Index Selection Value Source

Master

The optimizer results from which the residuals are to
be extracted is selected.

A selection box containing a list of the available
simulations allows the user to select the simulation
from which to extract the residuals.

Selection of the simulation may be slaved to another
extraction object. See Section 6.3.1 for more
information on Master/Slave controls.

Selection of the simulation may be exposed. See
Section 6.3.2 for more information on exposed
controls.

Information Only




What:

Why:

Used By:

Appearance:

Input Data:
Output Data:
Properties:

12.26 Extract Sequence(s)

Extracts XY data for one or multiple sequences, based on the sequences
defined by sequence time data.

To examine simulation results within one or a set of defined sequences.

Any object using XY data.
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Figure 133. Extract Sequence Screen

XY data and sequence time interval data

XY data

XY Data To Extract From

Sequence Time Data

# of Sequences

Time Adjustment

Adjust Start

Pressure/Flow Rate Adjustment

The XY data set from which data are extracted is
selected.

The sequence time data set is selected. In nPre, the
sequence time data set is by default a global object
defined in the Sequence input window. In nPost, the
sequence time data must be read in with a Sequence
Time Interval Data object, or with XY or profile
simulation results.

Single or Multiple sequences may be selected.

The extracted X values, or time, may be adjusted by
resetting the start time, or by removing duplicate
times.

The extracted Y values, or pressure or flow rate,
may be adjusted.

If selected, all pressure or flow rate values are

Information Only -




ABS(Y)

log10(Y)

Set final

Start Sequence Value Source

End Sequence Value Source

Information Only

decreased by the starting pressure/flow rate value, or
offset by the entered value.

Pressure/flow rates are decreased by the starting
pressure/flow rate value

Pressure/flow rates are offset by the value entered in
the adjacent text box.

If selected, the extracted Y values are the absolute
value of the adjusted pressure/flow rates.

If selected, the log of the adjusted pressure/flow rates
is extracted.

If selected, the final pressure/flow rate is specified in
the adjacent text box.

The sequences available in the specified Sequence
Time Data are listed, and the starting sequence is
selected. XY data will be extracted starting at this
sequence.

The sequences available in the specified Sequence
Time Data are listed, and if multiple sequences were
specified, the end sequence is selected.
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12.27 Extract Table Rows

What: Extracts a range of rows from a table column based on specified limits.

Why: To examine a subset of the data.

Used By: Any object using table data.

Appearance:
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Figure 134. Extract Table Rows Screen

Input Data: table data
Output Data:  table data
Properties:

Table Data To Use

Table Column

Operation

Aand B

AorB

A only

A Value Source

A Value

A Operation

Table rows are extracted from the selected table.

Table rows are extracted from the selected table
column.

The table rows are extracted according to a range of
values, specified by two limit variables, A and B.

Rows are extracted if the value complies with both A
restrictions and B restrictions.

Rows are extracted if the value complies with either
A restrictions or B restrictions.

Rows are extracted if the value complies the A
restriction.

Master/Slave and expose controls for the A value.
See Section 6.3 for more information on these
controls.

A value for the A variable is entered.

Values are limited to values “‘greater than”, “greater
than or equal to”, “less than”, or “less than or equal

Information Only




to” to the A Value.

B Value Source Master/Slave and expose controls for the B value.
See Section 6.3 for more information on these
controls.

B Value A value for the B variable is entered.

B Operation Values are limited to values “greater than”, “greater

than or equal to”, “less than”, or “less than or equal
to” the B Value.
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12.28 Extract XY

What: Extracts data from a grid corresponding to a specified constant X or Y value.
The resulting X value will be based on one of the grid axes, and the resulting Y
value is based on the value at each grid point.

Why: To view a slice of grid data.
Used By: Any object using XY data.
Appearance:
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Figure 135. Extract XY Data from Grid Screen

Input Data: grid data
Output Data: XY data
Properties:

Grid Input Data

Extraction Options

Constant:

Interp on log data

Extraction Constant Value Source

Extraction Constant Value

The grid data set from which the XY data are
extracted is selected.

The grid axes to be used as the extraction constant is
selected.

Linear interpolation between two grid points is based
on the log of the grid point values.

Master/Slave and expose controls. See Section 6.3
for more information on these controls.

X and Y values are extracted for constant values of
the grid axes specified as Constant: at this entered
value. If the constant value occurs between two grid
points, the resulting XY point is linearly interpolated.
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12.29 Extract XY from XY Results

What:

Why:
Used By:

Appearance:

Application:
Input Data:
Output Data:

Properties:

Extracts one set of XY data from one or multiple simulations of an nSIGHTS
XY Results object.

To examine simulation results (e.g. pressure as a function of time).

Any object using XY data.
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Figure 136. Extract XY Data from XY Results Screen

nPost
nSIGHTS XY Results
XY data

nSIGHTS XY Results To Select From  The XY simulation results from which the XY data

are extracted is selected.

XY Data to Select Select the XY data from the XY data sets available

in the simulation file.

Index Selection Value Source A selection box containing a list of the available

simulations allows the user to select the simulation
from which to extract the XY data. One or multiple
selections may be made.

Master Selection of the simulations may be slaved to another
extraction object. See Section 6.3.1 for more
information on-Master/Slave controls.

Expose Selection of the simulations may be exposed. See
Section 6.3.2 for more information on exposed
controls.

Multiple Multiple simulations may be selected if this

checkbox is selected.
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None

All

Run

Case

Fit

Only for multiple selections, no simulations will be
selected.

Only for multiple selections, all simulations will be
selected.

Only for multiple selections, all simulations with the
same run identifier as the currently selected
simulation will be selected.

Only for multiple selections, all simulations with the
same case identifier as the currently selected
simulation will be selected.

Only for multiple selections, all simulations with the
same fit as the currently selected simulation will be
selected.
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12.30 Fourier Transformon Y

What: Conducts a forward or inverse Fourier transform on Y data.
Why: To observe frequency components of a test response.
Used By: Any object using XY data.
Appearance:
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Figure 137. Fourier Transform on Y Screen
Input Data: XY data
Output Data: XY data
Properties:

XY Fourier Transform

Operation

Inverse Options

Output Description

# of FFT points

Information Only

The XY data set to apply the Fourier transform is
selected.

Either a forward or inverse Fourier transform is
calculated.

For inverse Fourier transforms only, Y may be scaled
by 2/n, and X may be scaled by the entered value.

Provides a description of the object, which will be
used as the object type in drop-down lists, and the
label of the object in a Series Legend.

The number of calculated Fourier transform points is
displayed.
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12.31 Full Table Correlations

What: Calculates the Pearson R or Spearman R correlation coefficients between all
column pairs within a table. For example, for a table with three columns, the
correlation coefficient is calculated between column 1 and column 2, column 1
and column 3 and column 2 and column 3.

Why: Determines the correlation between table columns.

Used By: Any object using table data. The resulting coefficients can be viewed with the
View Table Data object.

Appearance:
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Figure 138. Full Table Correlations Screen
Input Data: table data

Output Data:  table data: the correlation coefficients using column 1 are within column 1 or
row 1, the correlation coefficients using column 2 are within column 2 or row
2, etc., such that the correlation coefficient between column 1 and column 3
can be found in row 1, column 3 or row 3, column 1.

Properties:

Table Data To Use The input table data set is selected.

Correlation Type ' The correlation coefficient to be calculated is
selected: Pearson R or Spearman R. Other is for future
use and is not currently supported.

Options

log Data If the table data are log transformed, toggle the
checkbox on.

" Information Only "




12.32 Histogram
What:

Creates the input data for a histogram plot based on cube, grid or XY data. The

actual histogram is plotted using an XY Series plot object on a plot page, with
this object as the input. Note there are separate objects for each data type.

Why:

Used By:
plot the histogram.

Appearance:

Manipulates data in order to plot a histogram.

Any object using XY data. In particular, the XY Series plot object is used to

The appearance is identical for each data type, except for the name of the input

data frame, and an extra frame for XY data. The appearance is shown for XY

data:
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Figure 139. Histogram Screen

Input Data: cube, grid or XY data

Output Data:  cube, grid or XY data

Properties:

Cube/Grid/XY Input Data
Data Components to Operate On
Histogram Limits
Automatic.
# of bins

Output X Value

Bin Minimum Value Source

Bin Minimum Value

The input data set to be converted to a histogram is
selected.

XY data only. The value frequency of X data or Y
data may be calculated for the histogram.

Bin minimum and maximums are

Specified or

The number of bins for the histogram are entered in
the text box.

The X value of the histogram is the Bin Value or the
Bin Index.

Master/Slave Controls for the bin minimum, if
specified. See Section 6.3.1 for more information on
Master/Slave controls.

If specified, the bin minimum is entered in the text

Information Only




Bin Maximum Value Source

Bin Maximum Value

Options

Log Histogram

Cumulative

Normalize

box.

Master/Slave Controls for the bin maximum, if
specified. See Section 6.3.1 for more information on
Master/Slave controls.

If specified, the bin maximum is entered in the text
box.

The log of the X or Y data is calculated before the
value frequency is calculated.

Cumulative value frequencies are calculated.

Value frequencies are normalized.

Information Only




12.33 Integrate

What: Calculates the integral of XY data.
Why: To find the area under an XY curve.
Used By: Any object using XY data.
Appearance:

v =

I

g il e " s iy | A b e s ~'—g

Figure 140. Integrate XY Data
Input Data: XY data
Output Data: XY data

Properties:
XY Data to Integrate The XY data set to be integrated is selected.
Output Description Provides a description of the object, which will be

used as the object type in drop-down lists, and the
label of the object in a Series Legend.
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12.34 Interpolate Table Columns

What: Interpolates Y values based on a given value for X. Values in the X table
column must be in ascending order.
Why: To determine a Y value based on any given X value.
Used By: Any object using real values.
Appearance:
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Figure 141. Interpolate Table Columns Screen
Input Data: table data
Output Data: 2 real values, one X value (interpolant value) and one Y value (interpolated
value).
Properties:

Table Data To Use

X Data Column
Y Data Column

Interpolant Value Value Source

Interpolant Value Value

Interpolation Method

Options

Interpolation Results

Table columns are interpolated from the selected
table.

Table column to be used as the X value.
Table column to be used as the Y value.

Master/Slave controls for the interpolant value. See
Section 6.3 for more information on these controls.

The X value used to interpolate the Y value is
entered.

Interpolation method is selected, described in detail
in Section 7.1.4.

The log of the X or Y value may be taken after
interpolation.

Displays the resulting interpolated Y value.

Information Only




12.35 Interpolate XY Data from Curve

What: Interpolates XY values based on curve data, for a specified number of points
and specified limits.
Why: This object allows curve data to be plotted.
Used By: Any object using XY data.
Appearance:
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Figure 142. Interpolate XY Data from Curve Screen
Input Data: curve data and if inpur X interpolation method, XY data
Output Data: XY data
Properties:

Curve to Interpolate

Interpolation Method

Number of points

Log relative start

Limit Settings

Specified

From Input

Input X

Information Only

The curve to interpolate is selected.

Interpolation method is selected, described in detail
in Section 7.1.4.

For all interpolation methods except /npuwr X,
determines the number of equally spaced X values
and corresponding interpolated Y values.

For Log (Relative) interpolation method only,
determines the value of the first log X value.

For all interpolation methods except /nput X.

The minimum and maximum X values are specified
in the Minimum and Maximum text boxes.

Determines the minimum and maximum X values
automatically from the input data.

For the /mpur X interpolation method, XY data are
selected from which the X values are used to
calculate an interpolated Y value.
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12.36 Jacobian to Table

What:
Why:
Used By:

Appearance:

Converts Jacobian data to table data.
To examine Jacobian data.

Any object using table data.
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Figure 143. Jacobian to Table Screen

Application: nPost

Input Data: Jacobian data
Output Data:  table data
Properties:

Jacobian Data To Convert

Table Columns

Fit(s)

Parameter(s)

Column 1 Data

Index

X value

Options

The Jacobian data set to convert is selected.

The resulting table columns will contain Fiis or
Parameters.

For parameter table columns, the fit for which
parameters will be extracted is selected. All fits or
any individual fit may be selected.

For fits table columns, the parameter for which fits
will be extracted is selected. All parameters or any
individual parameter may be selected.

The first column of the table will contain the fit or
parameter index.

The first column of the table will contain the fit or
parameter value.

Calculates the absolute value of sensitivity
(sensitivity is calculated as the derivative of the
parameter value with respect to the residual).

Information Only




12.37 Linear Color Map

What: Creates a color map with a linear variation between starting and ending RBG or
HSV values. g
Why: Used to support mapping of values to colors.
Used By: Any object using color maps such as Merge Color Maps or color plot objects.
Appearance:
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Figure 144. Linear Color Map Method

Input Data: no input

Output Data:  color map

Properties:
Color Specification Method How end-point colors are defined.
Red/Green/Blue Use RGB method of primary color components.
Hue/Saturation/Value Use HSV method.
Number Of Colors In Map Color maps may consist of 5 to 256 separate colors.

Color Map Limits
The RGB or HSV components of the color at the

Map Start
start of the map.

Map End The RGB or HSV components of the color at the end
of the map.
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12.38 Matrix Math

What: Basic array mathematics (+,-,*,/) can be applied to two sets of cube data or grid
data. Note there are separate objects for each data type.
Why: Data manipulations.
Used By: Any object using cube or grid data.
Appearance: The appearance is identical for each data type. The appearance is shown for
grid data:
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Figure 145. Matrix Math Screen
Input Data: cube or grid data
Output Data:  cube or grid data
Properties:

Data Source A

Data Source B

Operation

Output Description

The first cube/grid data set is selected.

The second cube/grid data set is selected. Data
source A and B must be of the same size (i.e. same
number of nodes in the grid or cube data).

The math operation between data source A and B is
selected. The two data sources can be added,
subtracted, multiplied, or divided.

Provides a  description of the object,
which will be wused as the object type
in drop-down lists, and the label of
the object in a Series Legend.

Information Only




12.39 Merge Color Maps

What:

Why:
Used By:

Appearance:

Input Data:
Output Data:
Properties:

Combines two color maps. The two colors maps are joined together, such
that the beginning of map B is placed after the end of map A.

Provides flexibility in color map specification.

Any object using color maps, including itself (a Merge Color Map may be
input for another Merge Color Map object).
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Figure 146. Merge Color Maps Screen

two color maps

color map

The color maps are selected in the Map A and Map B drop-down lists. The total number of colors
in the input maps must be less than 256.
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12.40 Normalize

What: Normalizes cube and grid data within specified data limits, based on a power
value or both. Note there are separate objects for each data type.
Why: For manipulating data, in particular for normalized plots.
Used By: " Any object using cube or grid data.
Appearance: The appearance is identical for each data type, except for the name of the input
data frame. The appearance is shown for cube data:
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Figure 147. Normalize Cube & Grid Data Screen
Input Data: cube or grid data
Output Data:  cube or grid data
Properties:

Cube/Grid Input Data

Normalize Specification

Normalize Operation
Limits
Power

Both

Limit Specification

Power Value Source

Information Only

The input data set to be normalized is selected.

Master/Slave  controls for the normalize
specifications. For more information on
Master/Slave controls, refer to Section 6.3.1.

Data are normalized within specified data limits.
Data are normalized based on a power value.

Data are normalized based on a power value within
specified data limits.

For limit specified normalization, the input minimum
and maximum limits are automatically determined or
specified, and the output minimum and maximum
limits are specified.

Master/Slave and expose controls for the power
value. For more information on these controls, refer
to Section 6.3.
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Power Value For power value normalization, the power value is
entered in the text box.
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12.41 P(t) Derivative Calculation

What: Calculates the derivative of a pressure function (P(t)).

Why: In particular, used to create constraints based on the derivative of pressure.
Used By: Any object using XY data.

Appearance:
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Figure 148. P(t) Derivative Calculation Screen

Input Data: XY data, and if superposition of time is used, the output of a P(t) Time
Processing object

Output Data: XY data

Properties:

Input P(t) Data The derivative is calculated for the selected input
pressure time series data.

Derivative Specification Master/Slave  controls  for the  derivative
specifications. For more information on
Master/Slave controls, refer to Section 6.3.1.

Derivative Type . One of four derivative types is selected: d)/aX,
dY/dlog10(X), dlog]0(Y)/dlog10(X), or dY/dIn(X).

Derivative Calculation All derivative calculation procedures calculate the

derivative at each data point based on a subset of
data points on either side of the data point. The
derivative calculation will smooth noisy input data
before the derivative calculation in order to produce
a useful derivative.

Benween The derivative is calculated based on the slope
between two adjacent data points. The X value for
the derivative is the linear average of the X value of

Information Only =




2 Point

Window

Log % Span

Lin % Span

Log Value Span

Lin Value Span

Windowed Calculation

# points in Window

Log Epsilon

Information Only

the two data points. Only useful for very smooth
data.

The derivative is calculated based on the average
slope between the data point and two data points on
either side of the data point. The # points in Window
parameter determines which point on either side of
the data point to use. For example, if the # of point in
Window is 1, the points adjacent to the data point are
used. If the # of point in Window is 2, the second point
from the data point will be used. Only useful for
very smooth data.

The data points within a window surrounding the
data point are used in the derivative calculation.

All points within a specified log X distance of the
data point are used in the derivative calculation. The
distance is specified by a percentage of the log range
of the entire data set (log(Xmax)-102(Xmin))-

All points within a specified X distance of the data
point are used in the derivative calculation. The
distance is specified by a percentage of the linear
range of the entire data set (Xmax-Xmin)-

All points within a specified X distance of the data
point are used in the derivative calculation. The
distance is specified as an absolute log range of the
entire data set (log(Xmax)-10g(Xmin))-

All points within a specified X distance of the data
point are used in the derivative calculation. The
distance is specified as an absolute linear range of
the entire data set (Xmax~Xmin)-

For Window, Lin/Log % Span and Lin/Log Value
Span methods, determines the derivative calculation
algorithm used. Linear, Clark and Simmons
algorithms are available.

For 2 Point and Window calculations only,
determines which points to use for a 2 Point
calculation or the number of data points in the
window for a Window calculation.

Minimum Y value allowed for a log transform. Ifa’ Y
value is less than log epsilon, the derivative is not
calculated for that point.
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Y Offset

Lin/Log % Span Value Source

Lin/Log % Span Value

Lin/Log Span Value Source

Lin/Log Span Value

Time Multiplier

None

1=

delta T

Time Processing

Use Superposition

Options

ABS(derivative Y)

Adjusts Y values above the log epsilon (e.g.
increases values above zero to allow log
calculations).

Master/Slave and expose controls for the lin/log %
span value. For more information on these controls,
refer to Section 6.3.

For Lin/Log % Span methods, the percentage of the
linear/log range of the entire data set is entered.

Master/Slave and expose controls for lin/log span
value. For more information on these controls, refer
to Section 6.3.

For Lin/Log Value Span methods, the absolute
linear/log range of the entire data set is entered.

The resulting Y value of the object is the calculated
derivative.

After the derivative has been calculated, the
derivative is multiplied by time for the Y output.

After the derivative has been calculated, the
derivative is multiplied by delta time for the Y
output.

Superposition may be conducted on time. The output
of a P(t) Time Processing object is selected in the
adjacent drop-down-box.

If selected, the absolute value of the calculated
derivative Y value is output.

Information Only




12.42 P(t) Time Processing

What: Applies one of four time functions to X data (Horner, Agarwal, Homer Super or
Bourdet Super).
Why: Used to create plots that require a time function for the X axis such as a Horner
plot.
Used By: Any object using XY data.
Appearance:
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Figure 149. P(t) Time Processing Screen

Input Data: XY data
Output Data: XY data
Properties:

Input P(t) Data

Time Processing Specification

Time Processing

Horner/Agarwal T Value Source

Horner/Agarwal T Value

Superposition Input Q(t) Data

Options

Time processing is calculated for the X value of the
selected input pressure time series data.

Master/Slave controls for the time processing
specifications. ~ For more information on
Master/Slave controls, refer to Section 6.3.1.

One of four time processing functions is selected:
Horner, Agarwal, Horner Super and Bourdet Super.

Master/Slave and expose controls for the
Horner/Agarwal T Value. For more information on
these controls, refer to Section 6.3.

For Horner or Agarwal time processing, the Horner
time or Agarwal time is entered in the text box.

For Horner Super or Bourdet Super time processing,
the flow data to use in the time calculation is
specified in the drop-down list.

For Horner Super or Bourdet Super time processing,
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the final value can be replaced.
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12.43 Pen Set

What: Defines a set of pens to be used in plotting. Each pen set consists of 24 pens,
each of which may be defined to be different colors. Normally, the default
Standard Pen Set is all that is required.

Why: Establishes the color of plot objects.
Used By: All plot definitions.
Appearance:

Figure 150. Pen Set Screen
Input Data: no input
Output Data:  pen set
Properties:

Each pen is defined by an ID and a color. Selecting a color causes the color’s current settings to
be shown on the sliders in the Pen Color Settings frame. Subsequent slider adjustments update the

selected color.

Pen Color Method RGB or HSV
Pen Color Settings The RGB or HSV values for the currently selected
pen.
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12.44 Pulse Normalization
What:

Normalizes pressure XY data based on one of two equations: (Pi-P(1)) / (Pi-Po)

and 1-(Pi-P()) / (Pi-Po), where Pi is the static pressure and Po is the initial pulse
pressure. Both Pi and Po are to be specified in the object property window.

Why: Standard well test analysis normalization.

Used By: Any object using XY data.

Appearance:
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Figure 151. Pulse Normalization Screen

Input Data: XY data

Output Data: XY data

Properties:

Input P(t) Data

Pulse Normalization Type

PO(initial pulse pressure) Value Source

PO(initial pulse pressure) Value

Pi(static pressure) Value Source

Pi(static pressure) Value

Options

Information Only
.

The pressure Y values are normalized for the
selected input pressure time series data.

Pressure is normalized based on one of two
equations: (Pi-P(1)) / (Pi-Po) or 1-(Pi-P(1)) / (Pi-Po).

Master/Slave and expose controls for the initial pulse
pressure. For more information on these controls,
refer to Section 6.3.

The initial pulse pressure is entered in the text box.

Master/Slave and expose controls for the static
pressure. For more information on these controls,
refer to Section 6.3.

The static pressure is entered in the text box.

Y can be multiplied by X.
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12.45 Read Color Map

What: Reads a color map from a specially formatted text file (default file extension:
*.cmap).
Why: Allows creation of color maps outside nSIGHTS (for example, in an Excel
spreadsheet) to meet special requirements.
Used By: Any object using a color map.
Appearance:
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_ Figure 152. Read Color Map Screen
Input Data: external file containing a color map definition

Output Data:  color map

Properties:
Color Map File Format The format of the data in the input file (see File
Formats below).
mView output format The format produced by the object Write Color
Map.
. PV _Wave native format PV Wave format.
Color Map File The name of the file (including the file path)

containing the color map data is entered in the text
box or the Browse button is used to find the file using
the standard Windows open file dialog.

Once the color map is read, the color map defined in the file will display in the color window.
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File Formats:

mView Output

The mView color map file format is as follows:
Line 1:  ncolor "~ #of RGB data in file (max 256)
Line2:  Red 1 Green 1 Blue 1 RGB values (reals 0.0 to 1.0)

Line n+1: Red n Green n Blue n.
PV Wave
The PV Wave color map file format is as follows:

Line 1: Red 1 Green 1 Blue 1 RGB values (integers 0 to 255)

Line n: Red n Green n Blue n n maximum 256.

Information Only
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12.46 Read Cube Data

What: Reads cube data from an input file (default file extension: *.cube).
Why: Allows use of cube data created or manipulated outside the current nSIGHTS
application (for example, in another nSIGHTS application).
Used By: Any object using cube data.
Appearance:
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Figure 153. Read Cube Data Screen

Application: nPost

Input Data: external file containing cube data

Output Data:  cube data
Properties:

Cube Data File

File Format

Standard

Other

Options

Data Status

The name of the file (including the file path)
containing the cube data is entered in the text box or
the Browse button is used to find the file using the
standard Windows open file dialog.

The format of the data in the input file.
Standard format output from nSIGHTS.
For future use, not currently supported.

If X, Y or Z is a log value in the cube data file, it
should be specified in the appropriate checkbox. X
ID, Y ID and Z ID are used as the respective object
types in drop-down lists, and labels in a Series
Legend.

Once the cube data file is loaded, the number of X, Y
and Z values are displayed.

Information Only




12.47 Read Curve File

What: Reads a curve data file (default file extension: *.nCRV). A curve file may
contain several curve data sets.

Why: Allows use of curve data created or manipulated outside the current nSIGHTS
application (for example, in another nSIGHTS application).
Used By: Select Curve File
Appearance:
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Figure 154. Read Curve File Screen
Application: nPost
Input Data: external file containing curve data
Output Data:  curve data file for Select Curve File
Properties:

Curve Data File The name of the file (including the file path)
containing the curve data is entered in the text box or
the Browse button is used to find the file using the
standard Windows open file dialog. The curve file
format is based on the file format written by the
Write Curve File object.

Data Status - Once the curve data file is loaded, the number of
curves in the curve file is displayed.

Information Only




12.48 Read Grid Data

What:

Reads grid data from an input file (default file extension: *.grd).
Why: Allows use of grid data created or manipulated outside the current nSIGHTS
application (for example, in another nSIGHTS application).
Used By: Any object using grid data.
Appearance:
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Figure 155. Read Grid Data Screen
Application: nPost
Input Data: external file containing grid data
Output Data:  grid data
Properties:

Grid Data File

File Format

Decimation

Information Only

The name of the file (including the file path)
containing the grid data is entered in the text box or
the Browse button is used to find the file using the
standard Windows open file dialog.

One of four file formats can be selected. See the File
Formats section below for standard and XYZ list
file formats.

The standard format produced by the object Write
Grid File.

The grid format produced by Surfer Version 7
software. Select GS ASCII (*.grd) as the file format.

List of XYZ points.
For future use, not currently supported.

The grid file is reduced based on the decimation
factor entered in the text box: every n grid points in
both X and Y are kept, where n is the decimation
factor.
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Options _ If X or Y is a log value in the grid data file, it should
' be specified in the appropriate checkbox. X ID and
Y ID are used as the respective object types in drop-

down lists, and labels in a Series Legend.

Data Status ) Once the grid data file is loaded, the number of X
and Y points in the grid are displayed.

File Formats:

For all grids, X1 and Y1 is at the bottom left hand corner (e.g. X1=0,Y1=0).

Standard

The format produced by the object Write Grid File. The standard grid file format is as follows:
Line 1:  file heading
Line2: nXnY  nX=number of X points, nY=number of Y points
Line 3:  Grid Value at X1,Y1 ... Grid Value at X1,Y20

Line a: Grid Value at X1,(nY-19) ... Grid Value at X1,nY
Line a+1: Grid Value at X2,Y1 ... Grid Value at X2,Y20

Last Line: Grid Value at nX,(nY-19) ... Grid Value at nX,nY

XYZ list

The XYZ list grid file format is as follows:
Line 1: X1, Y1, Grid Value at X1,Y1
Line 2: X1, Y2, Grid Value at X1,Y2

Line nY: X1, nY, Grid Value at X1,nY
Line nY+1: X2, Y1, Grid Value at X2,Y1 nY= number of Y points

Line nX*nY: nX, nY, Grid Value at nX,nY nX=number of X points

Information Only




12.49 Read nSIGHTS Optimizer Results

What: Reads an nSIGHTS optimizer simulation results file (default file extension:
*.nOpt), specified in the Output File Setup nPre input window.

Why: To examine optimization results created in nPre within nPost.

Used By: Extract Covariance Matrices, Extract Jacobian, Extract Optimizer Results
Table and Extract Residuals.

Appearance:
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Figure 156. Read nSIGHTS Optimizer Results Screen
Application: nPost
Input Data: optimizer simulation results file

Output Data:  optimizer results file

Properties:

Optimizer Results Data File The name of the file (including the file path)
containing the optimizer results is entered in the text
box or the Browse button is used to find the file using
the standard Windows open file dialog.

File Status Once the optimizer results file is loaded, the number

of runs, cases and fits in the file, as well as the type
of optimization runs (e.g. Sampled) and the contents
of the file (e.g. Contains Residuals yes) are
displayed.
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12.50 Read nSIGHTS Profile Results

What: Reads an nSIGHTS profile simulation results file (default file extension:
* nPro), specified in the Output File Setup nPre input window.

Why: To examine simulation results created in nPre within nPost.
Used By: Extract Profile Grid

Appearance:
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Figure 157. Read nSIGHTS Profile Results Screen
Application: nPost
Input Data: profile simulation results file

Output Data:  profile results file

Properties:

Profile Simulation Results Data File The name of the file (including the file path)
containing the profile results is entered in the text
box or the Browse button is used to find the file using
the standard Windows open file dialog.

File Status Once the profile results file is loaded, the number of

runs and cases in the file are displayed.

Information Only




12.51 Read nSIGHTS Range Results

What: Reads an nSIGHTS range simulation results file (default file extension:

*.nRng), specified in the Output File Setup nPre input window.

Why: To examine range results created in nPre within nPost.
Used By: Extract Range Cube and Extract Range Grid
Appearance:
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Figure 158. Read nSIGHTS Range Results Screen

Application: nPost

Input Data: range simulation results file
Output Data:  range results file
Properties:

Range Results Data File

File Status

The name of the file (including the file path)
containing the range results is entered in the text box
or the Browse button is used to find the file using the
standard Windows open file dialog.

Once the range results file is loaded, the number of
runs, the number of grids or cubes in the file, and the
type of data (i.e. grid or cube data) are displayed.

Information Only
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12.52 Read nSIGHTS XY Results

What: Reads an nSIGHTS XY simulation results file (default file extension:
* nXYSim), specified in the Output File Setup nPre input window.

Why: To examine XY simulation results created in nPre within nPost.
Used By: Extract XY from XY Results
Appearance:
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Figure 159. Read nSIGHTS XY Results Screen
Application: nPost
Input Data: XY simulation results file
Output Data: XY results file

Properties:

XY Simulation Results Data File The name of the file (including the file path)
containing the XY results is entered in the text box
or the Browse button is used to find the file using the
standard Windows open file dialog.

File Status Once the XY results file is loaded, the number of
- runs and cases in the file are displayed.

Information Only




12.53 Read Sequence Time Interval Data

What: Reads a sequence time data file (default file extension: *.seqt).
Why: Contains time information for sequences defined in nPre, which are required
for nPost objects.
Used By: Extract Sequence(s) and Time Limits Extraction/Interpolation
Appearance:
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Figure 160. Read Sequence Time Interval Data Screen
Application: nPost
Input Data: external file containing sequence time data

Output Data:  sequence time data

Properties:

Sequence Time Data File The name of the file (including the file path)
containing the sequence time data is entered in the
text box or the Browse button is used to find the file
using the standard Windows open file dialog.

Data Status Once the sequence time file is loaded, the number of

sequences in the file is displayed.
File Format:
The sequence time data file format is as follows:
Line I:  SeqID StartingTime
Line2:  SeqlD StartingTime

Line n: SeqlD StartingTime EndTime n=number of sequences

Note: The sequence ID cannot contain embedded spaces.

Information Only




12.54 Read Table File

What: Reads tabular data from a file.
Why: Allows use of table data created or manipulated outside the current nSIGHTS
application (for example, in another nSIGHTS application or a spreadsheet).
Used By: Any object using table data.
Appearance:
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Figure 161. Read Table File Screen
Input Data: external file containing tabular data
Output Data:  table data
Properties:

Table File The name of the file (including the file path)
containing the table data is entered in the text box or
the Browse button is used to find the file using the
standard Windows open file dialog.

File Format One of four file formats can be selected.

Basic Table values are separated by spaces, each line
representing one row. If Read Column IDs is selected,
the first row is assumed to have column IDs
separated by spaces or commas, with no embedded
spaces. If Read Row IDs is selected, the first value in
each row is considered the row ID.

CSv Same as Basic file format, except that commas
separate table values.

Tecplot Standard Tecplot output table.

Other For future use, not currently supported.

Options If column and/or row IDs are present in the table

- Information Only

data file (Basic or CSV file formats), the appropriate
checkbox is selected.
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Data Status

Once the table file is loaded, the number of columns

and rows in the table are displayed.

Information Only
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12.55Read
What:

XY Data

Reads a list of XY points from a file (default file extension: *.dat).

Why: Allows use of XY data created or manipulated outside the current nSIGHTS
application (for example, in another nSIGHTS application or a spreadsheet).
Used By: Any object using XY data.
Appearance:
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Figure 162. Read XY Data Screen
Input Data: external file containing XY data
Output Data: XY data
Properties:

XY Data File The name of the file (including the file path)
containing the XY data is entered in the text box or
the Browse button is used to find the file using the
standard Windows open file dialog.

File Format One of three file formats can be selected.

Basic XY values are separated by commas or spaces, one
row per line. All data after the first two values of
each line are ignored. If ID from Column Header is
selected, the first line of file contains column header
names, without embedded spaces.

Table XY values are separated by commas or spaces, one
row per line. Columns selected as the X data and the
Y data are specified in the X column index and Y
column index fields. If ID from Column_ Header is
selected, the first line of file contains column header
names, without embedded spaces.

Other For future use, not currently supported.

Options

Information Only




ID from Column Header

D

X column index
Y column index

Data Status

Information Only

If selected, the ID is obtained from the Y column
header.

If not obtained from the column header, the ID is
specified in the text box. The ID is used as the
object type in drop-down lists, and the label in a
Series Legend. s

For table file formats, the table column to use for X
data is specified.

For table file formats, the table column to use for Y
data is specified.

Once the XY data file is loaded, the number of XY
points is displayed.
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12.56 Read XYZ Label Data

What: Reads a list of XYZ co-ordinates and associated text labels from a file.
Why: Used to specify 3D labels for plotting.

Used By: 3D plot object XYZ Labels.

Appearance:
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Figure 163. Read XYZ Label Data Screen
Input Data: external file containing XYZ co-ordinates and associated text labels

Output Data:  XYZ label

Properties:

XYZ Label Input File The name of the file (including the file path)
containing the XYZ label data is entered in the text
box or the Browse button is used to find the file using
the standard Windows open file dialog.

File Format One of two file formats can be selected.

Points List of XYZ points and text separated by spaces. See
the File Formats section below for details on the file
format.

Other For future use, not currently supported.

Data Status Once the XYZ label file is loaded, the number of

labels in the file is displayed.
File Formats:
Points
The Points file format is as follows:
Line 1 X1 1Y11Z1 1 FirstLabelText
Line 2 Xl 2Y¥1 2Z1 2 SecondLabelText

Information Only




Line n
Line n+1

Line n+2

X1 nYl n Z1 n nthLabelText
[blank]
X2 1Y2 122 1 Group2Labell Text

Information Only
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12.57 Real Value(s) To Table
What:

Converts real values into table data.

Why: Collects real values from an object with changing input (e.g. uses exposed
controls) and configures the real values in table format. For example, the
statistics of an XY slice of a grid can be stored in a table for several different

grid slices.
Used By: Any object using table data. In particular, the table may be viewed using the
View Table Data object.
Appearance:
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Figure 164. Real Value(s) Converted to Table Screen
Input Data: real value
Output Data: t table data
Properties:
Table Options
Clear Rows Clears the table. A subsequent change in the real
values defined in the Table Columns frame will add a
new row to the table.
Save table data Saves the current table values in the nSIGHTS

Table Columns

Status

# of rows

# of columns

configuration file.

In each line, a real value object can be selected from
the drop-down list. The column header is input into
the adjacent text box. The line is
activated/deactivated with the checkbox at the
beginning of the line.

The number of rows represents the number of table
rows created.

The number of columns will reflect the number of

Information Only




Apply

table columns defined in the Table Columns frame.

Will add one row to the table, containing the current

values of the real values in each table column.

Information Only

229




12.58 Reduction

What: Reduces the number of XY points by skipping points or by keeping points such
that the change in value between consecutive points is maximized below a
specified maximum.

Why: Reduces very large XY data sets into a data set of a more manageable size.

Used By: Any object using XY data.

Appearance:
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Figure 166. Reduction Screen

Input Data: XY data

Output Data: XY data

Properties:

XY Data Reduction

Operation

Data Reduction Operation

Skip

Maximum Change

Both

Point Skip Interval

The XY data set to be reduced is selected in the
drop-down list.

The method of reducing the XY data is selected.

Values in the XY data set are skipped, according to
the specified interval.

Points are removed such that the difference between
consecutive point values is maximized below a
specified maximum, for both X and Y data.

Values are skipped, unless the difference between
consecutive point values is greater than the specified
maximum.

For skip data reduction, the interval at which points
are skipped are entered. For example, with a point
skip interval of 2, every other point remains within
the data set.

Information Only




log X change

Maximum X Change

log Y change

Maximum Y Change

Output Description

Reduction Status

Information Only

For maximum change data reduction, the maximum
change in X values is based on log X if this
checkbox is selected.

For maximum change data reduction, the maximum
difference in values between two consecutive X
points is entered.

For maximum change data reduction, the maximum
change in Y values is based on log Y if this
checkbox is selected.

For maximum change data reduction, the maximum
difference in values between two consecutive Y
points is entered.

Provides a description of the object, which will be
used as the object type in drop-down lists, and the
label of the object in a Series Legend.

The number of input points and output points are
displayed, indicating the extent of the data reduction.
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12.59 Remove Duplicates

What: Removes duplicate values from X data, Y data or both. Duplicates are
considered values that have differences less than a specified value.

Why: Reduces the size of the data set, or improves its appearance in plotting.

Used By: Any object using XY data.

Appearance:
[ L e— il
Fomovetupieas 1| [apmaovoler, =)
I-l::::'\:nunnmiviw : ; € No v Yos
Dats Reduction. Onecavon I"i"““l-"'!' :-.I
Duplicata X Limit 1_I|'E_-'ﬂ5_- R
Fatmave Ot ol Secuence 7 Polnic e No: © res
-H:na::anunliuwv.\fam: . . ’ " GrNo vm_
| Oupliceta Y Limpt _ ]
5 ﬂ'rilt o g I - -~ ._¢
- Removel Stetus — —_— —
#clinput m #oloutout e

Figure 167. Remove Duplicates Screen

Input Data: XY data

Output Data: XY data

Properties:

XY Remove Duplicate Duplicates will be removed from the XY data
selected in the drop-down list.
X Values

Remove Duplicate X Values X duplicates are only removed if Yes is selected.

Data Reduction Operation Determines which duplicate X value to keep: the
Minimum, Maximum, Average, First or Last Y value.

Duplicate X Limit Duplicates are considered values that have
differences less than this specified value.

Remove Out of Sequence X Points X points are assumed to be ordered in ascending
order. Points that do not fit within this ascending
order will be removed if Yes is selected.

Y Values

Remove Duplicate Y Values Y duplicates are only removed if Yes is selected.

Duplicate Y Limit Duplicates are considered values that have
differences less than this specified value.

3
Output Déscription Provides a description of the object, which will be

Information Only




used as the object type in drop-down lists, and the
label of the object in a Series Legend.

Reduction Status " The number of input points and output points are
displayed, indicating the number of duplicates
removed.

Information Only




12.60 Scale/Transform

What: Performs mathematical operations on a single real input value, cube data or
grid data. Note there are separate objects for each data type.

Why: Unit conversions, other data manipulations.
Used By: Any object using real values, cube data or grid data.

Appearance: The appearance is identical for each data type, except for the name of the input
data frame. The appearance is shown for cube data:
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Figure 168. Cube Scale/Transform Screen
Input Data: real value, cube data or grid data
Output Data:  real value, cube data or grid data
Properties:

Real To Scale/Transform or Cube/Grid Input Data  The input data set to be scaled and/or
transformed is selected.

The remaining scale/transform options are described in Section 7.1.3.
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12.61 Select Curve from File

What:

Why:

Used By:

Appearance:

Application:
Input Data:
Output Data:

Properties:

Curve File To Select From

Index Selection Value Source

Selects a curve from a curve file. A curve file may contain several sets of
curve data.

Allows manipulation or plotting of one curve stored within a curve file.

Any object using curve data.
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Figure 169. Select Curve from File Screen
nPre
Read Curve File

curve data

The curve file from which the curve data are
extracted is selected.

A selection box containing a list of the available
curve data sets allows the user to select the curve
data to extract.

Master Selection of the curve data may be slaved to another
object. See Section 6.3.1 for more information on
Master/Slave controls.

Expose Selection of the curve data may be exposed. See

Section 6.3.2 for more information on exposed
controls.
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12.62 Select Range Cube

What: Used in real-time processing, allows the selection of a range cube data set
available during a run. Only for range mode simulations with three variables
specified as range variables.

Why: Used to plot simulation range cube data during the simulation.
Used By: Any object using cube data.
Appearance:
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Figure 170. Select Range Cube Screen
Application: nPre
Input Data: cube data
Output Data:  cube data

Properties:

Index Selection Value Source A selection box containing a list of the available
range cube data sets allows the user to select the
range cube data to extract.

Master Selection of the range cube data may be slaved to
another object.  See Section 6.3.1 for more
information on Master/Slave controls.

Expose Selection of the range cube data may be exposed.
See Section 6.3.2 for more information on exposed
controls.

Information Only




12.63 Select Range Grid

What: Used in real-time processing, allows the selection of a range grid data set
available during a run. Only for range mode simulations with two variables
specified as range variables.

Why: Used to plot simulation range grid data during the simulation.
Used By: Any object using grid data.
Appearance:
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Application: nPre
Input Data: grid data
Output Data:  grid data
Properties:

Index Selection Value Source A selection box containing a list of the available
range grid data sets allows the user to select the
range grid data to extract.

Master Selection of the range grid data may be slaved to
another object.  See Section 6.3.1 for more
information on Master/Slave controls.

Expose Selection of the range grid data may be exposed. See
Section 6.3.2 for more information on exposed
controls.
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12.64 Select XY from XY Array

What: Select an XY data set from an XY array. An XY array is a collection of XY
data sets.
Why: To examine, manipulate or plot one XY data set within an XY array.
Used By: Any object using XY data.
Appearance: ‘
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Figure 172. Select XY for XY Array Screen

Input Data: XY array
Output Data: XY data

Properties:
XY Data Array To Select From The XY array from which the XY data are extracted
is selected.
Index Selection Value Source A selection box containing a list of the available XY

data sets in the array allows the user to select the XY
data to extract.

Master Selection of the XY data may be slaved to another
object. See Section 6.3.1 for more information on
Master/Slave controls.

Expose " Selection of the XY data may be exposed. See
Section 6.3.2 for more information on exposed
controls.
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12.65 Sequence Fit

What: Similar to (Basic) Single Fit, except the fit can be limited to a range of time or
sequences. The Y data of both field and simulated data may also be
interpolated based on synthetic X data (See Section 7.1.4 for details). No
interpolation occurs if /mpur X is selected as the Interpolation Method. Typically
used in the Fit Specification/Graphics tab of the Fit Specification nPre input

window.
Why: Used to determine the field data that simulated data should be compared to
during an optimization or range simulation, limited within defined sequences.
Used By: Fit Selection tab of the Fit Specification nPre input window.
Appearance:
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Figure 173. Sequence Fit Screen
Application: nPre
Input Data: XY data
Output Data:  fit specification

Properties:
XY Field Data Select XY data representing field data.
Simulation Results Select XY or table data representing simulation data.

Time Data To Use

All Input Field and simulation data are not limited by time or
sequences, i.e. all data are used for interpolation.

Sequence Range Field and simulation data are limited by one or more
sequences, as defined in the Sequence Range frame.
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Time Range

Sequence Range

Seq times

4
(]
=

Time Range
Minimum
Maximum

Interpolation Method

Number of points

Log relative start

Limit Settings

Specified

From Input

Std dev of measurement error

Fit Status

Field and simulation data are limited by a time range
defined by a minimum and maximum time in the
Time Range frame.

The sequence time data set to be used is selected. By
default, the sequence time data are a global object
defined in the Sequence input window.

The sequences available in the specified Sequence
Time Data will be listed in the drop-down-box, and
the starting sequence is selected. Field and
simulation data starting at this sequence are included
in the fit.

The sequences available in the specified Sequence
Time Data will be listed in the drop-down-box, and
the ending sequence is selected.  Field and
simulation data up to the end of this sequence are
included in the fit.

Minimum time of the time range included in the fit.
Maximum time of the time range included in the fit.

Interpolation method is selected, described in detail
in Section 7.1.4. If no interpolation is desired, select
the /mpur X method. Interpolation and related options
apply to both field and simulated data.

For all interpolation methods except /npur X,
determines the number of equally spaced X values
and corresponding interpolated Y values.

For Log (Relative) interpolation method only,
determines the value of the first log X value.

For all interpolation methods except /npur X

The minimum and maximum X values are specified
in the Minimum and Maximum text boxes.

Determines the minimum and maximum X values
automatically from the input data.

The standard deviation is used in the calculation of
the Chi-squared minimization function.

Information Only




Calculated Fit Value

Information Only

Once simulation results are generated, the calculated
fit value for the specified field and simulated data
will be displayed.
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12.66 Single Fit

See (Basic) Single Fit

Information Only




12.67 Single Scale/Transform

What: Performs mathematical operations on either the X or the Y of XY data.
Why: Unit conversions or other data manipulations.

Used By: Any object using XY data.

Appearance:
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Figure 174. Single Scale/Transform Screen
Input Data: XY data
Output Data: XY data
Properties:

XY Input Data The input XY data set that is scaled and/or
transformed is selected.

Data Components to Operate On
X Data If selected, the X data are scaled and/or transformed.
Y Data If selected, the Y data are scaled and/or transformed.

The remaining scale/transform options are described in Section 7.1.3.
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12.68 Smooth/Filter

What: Filters and smoothes XY data using one of the following methods: FFT smooth,
Median smooth, low pass and high pass.
Why: Smoothes and filters anomalies within data for improved data approximations
or plotting.
Used By: Any object using XY data.
Appearance:
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Figure 175. Smooth/Filter Screen

Input Data: XY data
Output Data: XY data
Properties:

XY Smooth/Filter

Smooth/Filter

Smooth/Filter Operation

FFT Smooth

Median Smooth

Low Pass
High Pass

EFT Smooth Parameter

# of points in half window

The input data set that is smoothed and filtered is
selected in the drop-down-box.

The method of smoothing and filtering is selected in
the drop-down-box. '

A fast Fourier transform is applied to the data,
removing high frequency values.

Takes the average value within a window. The
larger the window, the greater the smoothing.

Removes high frequency components.
Removes low frequency components.

For FFT Smooth, indicates the strength of the
smoothing:  the greater the magnitude of the
parameter, the greater the smoothing.

For Median Smooth, determines the number of
points in half a window.
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# of FFT points to keep For Low or High Pass, determines the number of
points to keep: the greater the number of points kept,
the less smoothing of the data.

Output Description Provides a description of the object, which will be
used as the object type in drop-down lists, and the
label of the object in a Series Legend.
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12.69 Statistics
What:

Calculates basic statistics (e.g. sum, mean, minimum, maximum, etc.) for XY,

cube or grid data. Four basic statistics are selected for output as real values,
typically used as data labels on a plot.

Why: . For examination of data. Can also be included as labels for plots.

Used By: Any object using real values.

Appearance: The appearance is identical for each data type, except for the name of the input
data frame, and an extra frame for XY data. The appearance is shown for XY
data:
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Figure 176. Statistics Screen

Input Data: XY, cube or grid data

Output Data: 4 real values

Properties:

Cube/Grid/XY Input Data

Data Components to Operate On

Data to Output

Result Values
Sum
Minimum
Maximum
Mean

Variance
Std. dev.

Information Only

Statistics are computed for the input data selected.

XY data only. Statistics are calculated for X data or
Y data.

The statistics to output as real values are selected
from four drop-down-boxes (four real values are
output).

The total of all non-null values.

Minimum non-null value.

Maximum non-null value.

Sum/N

Sum((y; - Mean)?) /N, where y; = ith non-null value.

Sqrt(Sum((y; - Mean)?) /(N -1))
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Range Maximum - Minimum

N Number of non-null data.
N null Number of null data.
% non-null N/(N + N_null) * 100.

Note that only N, N Null and % non-null will be calculated if N = 0. Variance and Std. dev. are
only calculated if N > 1.

Information Only  *©




12.70 Sum Tables

What:

Why:
Used By:

Appearance:

Input Data:

Output Data:

Properties:

Base Table

Sums the values between multiple tables. For example, the value in column 2,
row 1 of Table A will be added to column 2, row 1 of Table B. A specified X
column will not be summed. A maximum of 24 tables may be summed,
including the base table.

To combine data within a table.

Any object using table data.
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Figure 177. Sum Tables Screen
table data

table data

Selects the table to which the tables specified in the
Tables to Add frame are added. The X column and
table size are obtained from this base table.

X Column Processing

skip X column If selected, the specified column in the drop-down-

box will be excluded from table addition. The
column will appear in the output table as it appears
in the base table.

Tables to Add A checkbox and associated drop-down-box indicates

the tables to sum with the base table. Each table
selected must be the same size as the base table (i.e.
equal number of rows and columns).
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12.71 Table Column Correlations

What: Calculates the Pearson R and Spearman R correlation coefficients between two
specified columns of a table.

Why: Determines the correlation between table columns. .
Used By: Any object using real values.
Appearance:
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Figure 178. Table Column Correlations Screen
Input Data: table data

Output Data: 4 real values: Pearson R, Spearman R, X column ID and the Y column ID

Properties:
Table Data To Use The input table data set is selected.
| X Table Column The table column to be used as the X value is
selected.
Y Table Column The table column to be used as the Y value is
selected.
Options
log X If the X data are log transformed, toggle the
checkbox on.
log Y If the Y data are log transformed, toggle the
checkbox on.
Results Once the Apply button is selected, the calculated
Pearson R and Spearman R correlation coefficients are
displayed.
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12.72 Table Column Math

What: Basic mathematics (+,-,*,/) are applied to two table columns.
Why: Data manipulations.
Used By: -Any object using XY data.
Appearance:
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Properties:

Table Data To Use
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Math Operations

Options

log X
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Result Column 1D

Figure 179. Table Column Math Window

The input table is selected.
The column to be used as X data is selected.
The column to be used as Y data is selected.

The math operation between column X and Y is
selected. The two columns can be added, subtracted,
multiplied or divided.

The X data can be log transformed before the math
operation is conducted.

The Y data can be log transformed before the math
operation is conducted.

If selected, the output table will contain all the
columns of the input table, with an additional
column containing the math results. If not checked,
the output table will contain three columns, one X
column, one Y column and one math results column.

The column containing the math results will have a
column ID as specified in the text box.
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12.73 Table Column Scale/Transform

What: Performs mathematical operations on a specified column of a table.
Why: Unit conversions, other data manipulations.
Used By: Any object using table data.
Appearance:
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Figure 180. Table Column Scale/Transform Window

Application: nPost
Input Data: table data
Output Data:  table data
Properties:

Table Data To Use The input table data set that is scaled and/or
transformed is selected.

Table Column The table column that is scaled and/or transformed.

The remaining scale/transform options are described in Section 7.1.3.
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12.74 Table Column Statistics

What: Calculates basic statistics (e.g. sum, mean, minimum, maximum, etc.) for a
specified column of a table. Four basic statistics are selected for output as real
values, typically used as data labels on a plot.

Why: For examination of table column data. Can also be included as labels for plots.
Used By: Any object using real values.
Appearance:
F Objed iD= — el 7
o || foowomiobe _————————— 1]
E-Tabde Column
va_ -1
k- Data To Output: - -
Outout#1 [som  ix]i Ououez o [inimum ]
| Outout#3 [Mesmum {v]” Outour 4 Moen  Iv|;
Besull Velues — - s |
Sum Irufc_ e e ] Sta.dev I\fa 1
Mirmerumn hh e o _.l Ronpe ’\.’a e
P [ — [
temn lr\iq e Mol |'\!a 1
Venance ll?c':_i__' _ 4] Fermn mal I'\f_ iy

Figure 181. Table Column Statistics Window
Input Data: table data

Output Data: 4 real values

Properties:
Table Data To Use Statistics are calculated on a column of the table data
selected.
Table Column Statistics are calculated on the specified table
column.

The remaining options are described in the Statistics object description in this Appendix.
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12.75 Table Column To Histogram

What: Creates the input data for a histogram plot based on a specified column of a
table. The actual histogram is plotted using an XY Series plot object on a plot
page, with this object as the input.

Why: Manipulates data in order to plot a histogram.
Used By: Any object using XY data. In particular, the XY Series plot object is used to
plot the histogram.

Appearance:
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Figure 182. Table Column to Histogram Window
Input Data: table data
. Output Data: XY data

Properties:
Table Data To Use Selects the input table data from which a column is
converted to a histogram.
Table Column The value frequency of the table column selected is

calculated for the histogram.

The remaining options are described in the Histogram object description in this Appendix.
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12.76 Table Columns To XY

What: Extracts two specified columns from a table to create XY data.
Why: To convert table data to XY data.
Used By: Any object using XY data.
Appearance:
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Figure 183. Table Columns to XY Window
Input Data: table data
Output Data: XY data

Properties:
Table Data To Use XY data are extracted from columns of the table data
selected.
X Data Column The specified table column is used as the X data.
Y Data Column The specified table column is used as the Y data.
Output Description Provides a description of the object, which will be

used as the object type in drop-down lists and the
label of the object in a Series Legend.
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12.77 Table Row Index Logic
What: _ Conducts Boolean Logic (AND, OR, XOR) between two sets of table rows.

Why: Used to limit selection of simulations according to several parameter values,
using the Master/Slave facility (the object’s Index Selection Value Source will be a
slave to this Table Row Index Logic object). For example, extraction of
optimization results can be limited to simulations with a hydraulic conductivity
and a flow dimension greater than specified values.

Used By: Any object using table data.
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Figure 184. Table Row Index Logic Window
Application: nPost
Input Data: output from Extract Table Rows
Output Data:  table data

Properties:

Row Index Source A Select table rows, extracted from an Extract Table
Rows object, to be compared with the table rows
specified as Source B.

Row Index Source A Select table rows, extracted from an Extract Table
Rows object, to be compared with the table rows
specified as Source A.

Operation One of three Boolean logic operators may be selected:

A AND B Row Indexes that occur in both A and B are output
(i.e. only indexes common to A and B).

AORB Row Indexes that occur in either A or B are output (i.e.
all A indexes and all B indexes).

AXORB Row Indexes that occur in either A or B, but not both,
are output (i.e. all indexes in A and B except those
indexes common to A and B).
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12.78 Table Row Statistics

What: Calculates basic statistics (e.g. sum, mean, minimum, maximum, etc.), as well
as confidence limits and the median, for all rows of a table. The statistics are
output in table format, and may be viewed as a table with the View Table Data
object.

Why: For examination of table row data. Can also be included as labels for plots.

Used By: Any object using real values.

Appearance:
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Figure 185. Table Row Statistics Window

Input Data: table data

Output Data:  table data

Properties:

Table to Summarize A table data object is selected, from which statistics

will be calculated for each row of the table.

X Column Processing

Options

skip X column If selected, the specified column in the drop-down-
box will be excluded from the row statistics.

Each option determines the statistics calculated. The
statistics calculated are viewed by viewing the
resulting table data with a View Table Data object.
If multiple options are selected, the mean, min and
max are only output once.
All statistics If selected, outputs the statistics outlined for the
Statistics object for each table row.
confidence limits If selected, outputs the following statistics for each
table row:
Mean (sum of all non-null values)/(number of non-null
data)
Min Minimum non-null value.
Max Maximum non-null value.
Upper95 Upper 95% confidence limit.
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Lower95

median

Mean

Min

Median

Information Only

Lower 95% confidence limit.

If selected, outputs the following statistics for each
table row:

(sum of all non-null values)/(number of non-null
data)

Minimum non-null value.
Maximum non-null value.

The middle number of non-null data, i.e. half the
non-null data have values greater than the median,
and half have values less than the median. If the
number of non-null data is even, the median is the
average of the two middle numbers.
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12.79 Time Limits Extraction/Interpolation

What: Extracts XY data for a range of sequences or time and within specified data
limits, and interpolates the extracted data.

Why: Allows the examination of XY within a specified time frame.
Used By: Any object using XY data.
Appearance:
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Figure 186. Time Limits Extraction/Interpolation Window

Input Data: XY data and sequence time interval data if Sequence Range time_data selected.
Output Data: XY data
Properties:

XY Input Data

Time Data To Use

All Input

Sequence Range

Time Range

Sequence Range

Seq times

Select XY data to extract and/or interpolate.

XY data are not limited by time or sequences, i.e. all
data are used for interpolation.

XY data are limited by one or more sequences, as
defined in the Sequence Range frame.

XY data are limited by a time range defined by a
minimum and maximum time in the Time Range
frame.

The sequence time data set to be used is selected. In
nPre, the sequence time data are by default a global
object defined in the Sequence input window. In
nPost, the sequence time data must be read in with a
Sequence Time Interval Data object, or with XY or
profile simulation results.
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Limit Settings
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Information Only

The sequences available in the specified Sequence
Time Data will be listed in the drop-down-box, and
the starting sequence is selected. XY data starting at
this sequence is extracted.

The sequences available in the specified Sequence
Time Data will be listed in the drop-down-box, and
the ending sequence is selected. XY data up to the
end of this sequence is extracted.

Minimum time of the time range extracted.
Maximum time of the time range extracted.

Interpolation method is selected, described in detail
in Section 7.1.4. If no interpolation is desired, select
the /npur X method.

For all interpolation methods except /npur X,
determines the number of equally spaced X values
and corresponding interpolated Y values.

For Log (Relative) interpolation method only,
determines the value of the first log X value.

For all interpolation methods except /nput X

The minimum and maximum X values are specified
in the Minimum and Maximum text boxes.

Determines the minimum and maximum X values
automatically from the input data.
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12.80 Transpose

What: Switches the X and Y data (i.e. output X = input Y and output Y = input X).
Why: To manipulate data.

Used By: Any object using XY data.

Appearance:

Figure 187. Transpose Window
Input Data: XY data
Output Data: XY data

Properties:
XY Transpose Selects the XY input data for which the X and Y will
be transposed.
Output Description Provides a description of the object, which will be

used as the object type in drop-down lists and the
label of the object in a Series Legend.
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12.81 Vector Math

What: Basic array mathematics (+,-,*,/) can be applied to two sets of XY data.
Why: Data manipulations.
Used By: Any object using XY data.
Appearance:
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Figure 188. Vector Math Window

The first XY data set is selected.

The second XY data set is selected. Data source A
and B must be of the same size (i.e. same number of

XY points).

The math operation between data source A and B 1s
selected. The two data sources can be added,

subtracted, multiplied or divided.

Provides a description of the object, which will be
used as the object type in drop-down lists, and the

label of the object in a Series Legend.

Information Only
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12.82 View Table Data
What: Allows the user to view table data.

Why: Used to view table data created in another object, such as Real Values(s) to
Table or Table Row Statistics.

Used By: Any object using table data.

Appearance:
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Figure 189. View Table Data Table Window

Input Data: table data
Output Data:  table data

Properties:
Input Table Data Table data from the object selected are viewed in this
property window.
Data Format Specifies the numeric format of the data. Number

formatting described in Section 6.3.3.

Data are viewed in the table once the Apply button has been selected. To modify table data, use
the Enter Table Data object.
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12.83 View XY Data

What: Allows the user to view XY data.

Why: Used to view XY data created in another object, such as Read XY Data or

Dual Scale Transform.

Used By: Any object using XY data.

Appearance:
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Figure 190. View XY Data Window

Input Data: XY data
Output Data: XY data
Properties:

Input XY Data

X/YData Format

XY data from the object selected are viewed in this
property window.

Specifies the numeric format of the X and Y data.
Number formatting options are described in Section
6.3.3.

Data are viewed in the table once the Apply button has been selected. To modify XY data, use the

Enter XY Data object.

Information Only
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12.84 Write Color Map

What: Writes a color map to a text file.
Why: Allows a color map to be used or manipulated outside the current nSIGHTS
application.
Appearance:
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Figure 191. Write Color Map Window
Application: nPre, nPost as an output object
Input Data: color map
Output Data:  text output file containing color map information compatible with Read Color
Map, default file extension *.cmap
Properties:

Color Map Source

Color Map Output File

Selects the color map data to be output.

The output file is only written once the Apply button is selected.

Information Only

The path and name of the output file is entered in the
text box or the Browse button is used to find the file
path using the standard Windows open file dialog.
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12.85 Write Curve File

What: Writes single or multiple curve data to a text file. Up to 24 curves may be
included in one file.

Why: Allows curve data to be used or manipulated outside the nSIGHTS application
(for example, in another nSIGHTS application).
Appearance:
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Figure 192. Write Curve File Window
Application: nPre, nPost as an output object
Input Data: curve data

Output Data:  text output file containing curve file information compatible with Read Curve
File, default file extension *.nCRV

Properties:

Curve Output File The path and name of the output file is entered in the
text box or the Browse button is used to find the file
path using the standard Windows open file dialog.

Curve Object : Curve data to be included in the output file is
selected with the checkbox and adjacent drop-down
list. Up to 24 curve data objects can be written to the
output file.

Curve Description (mandatory) A description of the curve is required. This

description is used as the curve ID once the file is
loaded into another nSIGHTS application.

The output file is only written once the Apply button is selected.
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12.86 Write Table File

What: Writes a table to a text file.

Why: Allows table data to be used or manipulated outside the nSIGHTS application
(for example, in another nSIGHTS application).

Appearance:
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Figure 193. Write Table File Window

Application: nPre, nPost as an output object

Input Data: table data

Output Data:  text output file containing table data compatible with Read Table File

Properties:
Table Data Source
Options

Col Headers

Row Descriptions
Table Output File

Selects the table data to be output.

If selected, the first line of file contains column

header names, right justified.

If selected, each row is prefaced by a row identifier.

The path and name of the output file is entered in

the

text box or the Browse button is used to find the file

path using the standard Windows open file dialog.

The output file is only written once the Apply button is selected.

File Format:

The table is written as a text file with each column right justified in a field 16 characters wide,
each column separated by a space (Basic file format for the Read Table File object). Numeric
values are written in scientific notation with 9 digit precision.

Information Only
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12.87 Write XY File

What: Writes XY data to a text file.
Why: Allows XY data to be used or manipulated outside the nSIGHTS application
(for example, in another nSIGHTS application).
Appearance:
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Figure 194. Write XY File Window
Application: nPre, nPost as an output object

Input Data: XY data

Output Data:  text output file containing XY data compatible with Read XY Data, default
file extension *.dat

Properties:
XY Data Source Selects the XY data to be output.
Options
Col Headers If selected, the first line of file contains column
header names, right justified.
XY Output File The path and name of the output file is entered in the

text box or the Browse button is used to find the file
path using the standard Windows open file dialog.

The output file is only written once the Apply button is selected.
File Format:

The XY data are written as a text file with each column right justified in a field 16 characters
wide, each column separated by a space. Numeric values are written in scientific notation with 9
digit precision.
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13 APPENDIX B - PLOT OBJECT DESCRIPTIONS

This Appendix is divided into four sections:
(1)  Default Plot Objects

(2) Data Display Plot Objects

3) Annotation Plot Objects

4) Active Plot Objects

Default plot objects are automatically created upon creation of a plot page, whereas data display,
annotation and active plot objects are created using the Object->New command. Within the
selection menu of the Object->New command, data display object names are prefixed by Data:,
annotation object names are prefixed by Anno:, and active objects have prefixes specific to the
object.
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DEFAULT PLOT OBJECTS

13.12D XY Main Menu
What: Controls the general layout and characteristics of 2D XY plots.
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Figure 195. 2D XY Main Menu Window
Properties:
ObjectlD For plot pages the object ID of the main menu is

Plot pen set

Background Pen

Plot Dimensions

Horizontal size

Vertical size

Format

Information Only

used as the title of the plot window itself, and as the
identifier for the page in the object tree.

The pen set to be used for all objects on the plot.
This restricts all objects on the plot to the same
palette of 24 colors (except for objects which use
color maps to display data).

The pen color used for the background in the plotting
area.

Size of the window area. Pressing any of the buttons
sets the X and Y of the window accordingly.
Custom window sizes can be set manually with the
following commands:

X dimension in pixels.

Y dimension in pixels.
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Show report area

Minimum Plot Margins (Pixels)

If selected, the bottom of the plot window will
contain an area for displaying cursor related data.

The distance between the plot axes/frame and the
edge of the plotting area.

The following dialog prompts are also available on the 2D XY Axes objects. Changes made here
will be automatically updated in the 2D XY Axes objects.

X/Y Axis Type

X/Y Increment Label Format

X/7Y Cursor Reporting Format

Linear or logarithmic axes can be defined.

Numeric format for labels at each major increment.
Numeric format is discussed further in Section 6.3.3.

Numeric format for the X or Y value of the current
cursor location in the cursor reporting area. This
format is also used for all reporting plot objects that
do not have a specific reporting format. Numeric '
format is discussed further in Section 6.3.3.
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13.22D XY Axes

What: There are two default plot objects to define the plot axes, one for the X axis and
one for the Y axis, each with identical object property windows.
Appearance:
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Figure 196. 2D XY Axes Window
Properties:

Increment Style

Major

Minor

Axis Type

Axes Limits

Auto

Linear min

Linear max

Information Only

Axes increments are represented by grid lines (Grid),
tic marks (7ic), or not plotted (None).

Style for labelled increments.

Style of unlabelled increments between major
increments.

Linear or logai'ithmic axes can be defined. This
dialog prompt is also available on the 2D XY Main
Menu object.  Changes made here will be
automatically updated in the 2D XY Main Menu

object.
Defines the domain of the plot.
Axes are adjusted to enclose all defined plot objects.

The left (X axis) or bottom (Y axis) co-ordinate of
the plot if a linear axis is used.

The right (X axis) or top (Y axis) co-ordinate of the
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plot if a linear axis is used.

Log min The left/bottom co-ordinate of the plot if a log axis is
used.
Log max The right/top co-ordinate of the plot if a log axis is
used.
Major Increment Setup Distance between labelled increments for linear axes.
Auto Increments are set automatically based on data range.
Major increment Value to use if not Auto.
Minor Increment Setup Number of minor increments between each major

increment for linear axes.

Auto Increments are set automatically based on major
increment size.

Minor per major Value to use if not Auto.

The following dialog prompts are also available on the 2D XY Main Menu object. Changes
made here will be automatically updated in the 2D XY Main Menu object.

Increment Label Format Numeric format for labels at each major increment.
Numeric format is discussed further in Section 6.3.3.

Cursor Reporting Format Numeric format for the X or Y value of the current
cursor location in the cursor reporting area. This
format is also used for all reporting plot objects that
do not have a specific reporting format. Numeric
format is discussed further in Section 6.3.3.

Information Only
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13.3 2D Plot Annotation
What: Provides control over axes labelling and the general appearance of all 2D plots.
Appearance:
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Figure 197. 2D Plot Annotation Window
Properties:
Control
Plot Anno ? If not selected, axes related annotation is not shown
on the plot.
Axes/Tic Pen The pen color used for the axes lines, tics, and labels.
Grid Pen The pen color used for any increment grid lines.
Format Toggle control over components of annotation
Axis labels If selected, labels will be drawn to the left of the left
Y axis and underneath the bottom X axis.
Frame If selected, the axes (including tics) are drawn on the
top and right as well as the bottom and left.
Increment labels will not be drawn on these mirror
axes.
Axis lines Axes lines will only be drawn if this is selected.
Grid On Top If major or minor grid lines are used, this controls the
Information Only




Labels
X axis
Y axis
Label Font

Increment Font

Axes Line

Major Tics

Minor Tics

Grid Lines

order in which the grid is drawn — before the plot
data objects (toggle not set) or after the plot data
objects (toggle selected).

If toggle Axis labels is set, the text entered here will be
displayed at the appropriate axis.

Label displayed under bottom X axis.
Label displayed to left of left Y axis.

The font used for axis labels. Font dialogs are
discussed in Section 6.3.4.

The font used for axes increment labels.

The offset of the axes line in pixels away from the
data plotting area, and the thickness of the lines used
to draw the axes.

The length of the major tics in pixels and their
thickness.

The length of the minor tics in pixels and their
thickness.

The thickness of major and minor grid lines in
pixels.

Information Only




13.43D XYZ: Main Menu

What: Controls the general layout and characteristics of 3D XYZ plots.

Appearance:
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Figure 198. 3D XYZ: Main Menu Window

Properties:

ObjectlD, Plot Pen Set, Background Pen, Plot Dimensions, and Minimum Plot Margins are as
described for the 2D XY: Main Menu.

Projection How 3D space is converted to a 2D representation.
Perspective Lines diminish with distance from the view co-
ordinate.
Orthographic Relative sizes remain the same at all distances from

the view co-ordinate.

Field of View For Perspective, the angle of the viewing lens. Smaller
values reduce perspective distortion.

XYZ Properties Used to set the relative lengths of the plotted axes.
The X axes has a relative length of 1.

X:Y axes length ratio Controls length of Y (horizontal axes).
X:Z axes length ratio Controls length of Z (vertical axes).
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13.53D XYZ Axes -

What: There are three default plot objects to define the plot axes, one for the X axis, one
for the Y axis and one for the Z axis, each with identical object property windows.

Appearance and Properties:

Appearance and all dialog items in the object property windows were previously described for the
2D XY Axes object property window.

Information Only




13.6 3D Axes Labels
What:

Provides control over axes labelling for 3D plots.

Appearance:
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Figure 199. 3D Axes Labels Window
Properties:
Control
Axis labels Labels are plotted at each axis if turned on.

Increment labels

Auto Position labels

Labels
X axis
Y axis
Z axis
Label Font

Increment Font

Information Only

Numeric values of major increments are plotted at
each axis if turned on.

The orientation and location of labels are adjusted as
the view azimuth and elevation are changed.

If toggle Axis labels is selected, the text entered here
will be displayed at the appropriate axis

Label displayed under X axis.
Label displayed under Y axis.
Label displayed adjacent to Z axis.

The font used for axes labels. The font dialog is

described in Section 6.3.4.

The font used for axes increment labels.
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Label Orientation/Position Controls text plane, orientation and position of X, Y,
and Z labels if Auto Position Labels is not selected.

XYaxes
plane Vertical or horizontal.
X pos X axis labelling is at X axis associated with Y min or
Y max.
Y pos Y axis labelling is at Y axis associated with X min or
X max.
Z Axes
plane XZ or YZ, normal or reversed.
Y pos Z axis labelling is at Z axis associated with Y min or
Y max.
X pos Z axis labelling is at Z axis associated with X min or
X max.

Information Only




13.7 3D Axes Format
What:

This rather complex menu provides control over general formatting of 3D plot

axes.
Appearance:
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Figure 200. 3D Axes Format Window
Properties:

Axes Line Pen

Major Tic/Grid Pen

Minor Tic/Grid Pen

Layout

>

Information Only

The pen color used for the axes lines.

The pen color used for major tics and grid lines (and
the increment labels and axes labels).

The pen color used for minor tics and grid lines.

A 3D plot is a cube which has 6 sides available for
axes tics and grid lines. The controls in the Layout
frame provide complete control over the appearance
of each side. There are four controls for each axes
direction on each plane. The AU@ controls affect
the horizontal axes on vertical planes and the AX@
axes on the horizontal planes. The AV@ controls
affect the vertical axes (Z axes) on vertical planes
and the AY@ axes on the horizontal planes.

If set, the bottom XY plane (XY-) is used as a
template for the XZ and YZ planes which are on the
far side of the data view from the viewer.
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Controls presence of major tics/grid lines:

No tic marks/grid lines.
Tic marks at major increments.
Grid lines at major increments.

Controls presence of minor tics/grid lines:

No minor tic marks/grid lines.
Tic marks at minor increments.
Grid lines at minor increments.

Controls presence of axes lines:

No axes lines drawn.

Axes line drawn at other axes minimum.
Axes line drawn at other axes maximum.
Axes line drawn at both ends of other axes.

Controls presence of tics (if major or minor tics are
specified):

Tics drawn at other axes minimum.
Tics drawn at other axes maximum.
Tics drawn at both ends of other axes.

The offset of the axes line in pixels away from the
data plotting area, and the thickness of the lines used
to draw the axes.

The length of the major tics in pixels and their
thickness.

The length of the minor tics in pixels and their
thickness.

The thickness of major and minor grid lines in
pixels.

Note: All axes lines and tic marks can be disabled by pressing the Clear button for the menu.

Information Only




13.83D Lighting

What: Provides control over Open GL lighting used on all 3D plots.
Appearance:
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Figure 201. 3D Lighting Window
Properties:
Control Overall determination of lighting
Use lighting If set, OpenGL lighting is used. If not set there is no

Use default light

Show light

Ambient Light

Default Diffuse Light

Default Specular Light

Information Only

lighting and object edges will need to be displayed to
gain perspective information.

If set, a point source diffuse light and ambient
(background) lighting are used. If not set, only
ambient lighting is used.

Shows the location of the diffuse light as a black
cube. The vector from the center of the view to the
light is shown as a straight red line.

A combination control that sets the color and relative
intensity of the ambient light.

A combination control that sets the color and relative
intensity of the directional light.

Not used at this time.
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Light position

Relative

Fixed
Position data
Delta elevation

Delta azimuth

Fixed elevation

Fixed azimuth

Inverse Dist.

How the position of the diffuse light is specified.

Light position is relative to the current view

elevation and azimuth.

Light is at a fixed XYZ, independent of the view.
The actual location of the light source.

For relative position, added to view elevation.
For relative position, added to view azimuth.

For fixed position.

For fixed position.

1 / distance to light. A value 0.0 means light is

infinite.

Information Only
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DATA DISPLAY PLOT OBJECTS

13.9 Confidence Limits
What: Plots single, dual or triple confidence limits of a covariance matrix.
Why: To plot confidence limits of data.
Used By: Series Legend
Appearance: This object appears different in 2D and 3D.
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Figure 203. 3D Confidence Limits Window
Input Data: Extract Covariance Matrices

Output Data: series legend specifications

Properties:
Covariance Data Confidence limits are plotted for the covariance data
' selected.
Pen The color of the confidence limits is selected from
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X Variable

Y Variable

Z Variable

Confidence Limits

Limit Type
Single

Dual

Triple

Plot Format

Line

Solid

Tube

Ellipse Pts

Ellipsoid Slices

the plot window’s plot pen set.

A parameter is selected for the X axis from a list of
available parameters based on the covariance data
selected.

A parameter is selected for the Y axis from a list of
available parameters based on the covariance data
selected.

For 3D plot object, a parameter is selected for the Z
axis from a list of available parameters based on the
covariance data selected.

A probability is selected (99.0, 95.4, 90.0, 68.3) for
the confidence limits. The probability indicates the
likelihood the true parameter values are within the
plotted confidence error bar or region.

An error bar for each axes will define the confidence
limits.

An ellipse will be used to define the confidence
region. In 3D, an ellipse is plotted in all three planes
(XY,YZ and XZ).

For 3D plot object, an ellipsoid will be used to define
the confidence region.

The only plot format for Single limit type. For Dual
limit type, the confidence region is plotted as a Line
surrounding the region. For Triple limit type, the
lines of the slices and meridians of the ellipsoid are
drawn.

For Dual or Triple limit type, the ellipse/ellipsoid
defining the confidence region is solid, filled with
the color defined in Pen.

For 3D plot object, plots the same information as for
Line plot format, but the lines are plotted as three-
dimensional tubes.

For Dual limit type, the number of points defining
the ellipse of the confidence region can be defined.

For 3D plot object and Triple limit type, defines the
resolution of the ellipsoid. For example, if the

Information Only >




Ellipsoid Meridians

Line Thickness

Tube Extrusion

Cap Ends

" Polygon type

Polygon size

Legend Description

Offset

New Label

Information Only

ellipsoid was a globe, the slices would represent the
globe’s latitude.

For 3D plot object and Triple limit type, defines the
resolution of the ellipsoid. For example, if the
ellipsoid was a globe, the meridians would represent
the globe’s longitude.

The thickness of the error bars, ellipse line or slices
and meridians is defined in pixels.

For 3D plot object and Tube plot format.

The ends of the tube are filled with a polygon, such
that the viewer cannot see inside the tube.

The tube can be several Shépes: Triangle, Square,
Octagon OT Round.

Point size of each polygon of the tube in pixels.

A label used for the Series Legend object can be
entered in the text box. If the New Label checkbox is
not selected, the Object ID is used as the legend label.

For 3D plot object, XYZ offset is used to improve
visibility of objects (see discussion of 3D plot object
visibility in Section 8.1.2.1).
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13.10 Cube Color Block

What: Displays color blocks around each cube data value for specified cube indices
within specified cube value limits. Blocks are colored according to the
associated value.

Why: Displays cube data in a 3D plot window.

Used By: Color Legend

Appearance:
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Figure 204. Color Cube Block Window

Input Data: cube data, cube indexes and color map

Output Data:  color map limit specifications

Properties:

Cube Data To Plot

Cube Indexes

Limit Selection

Color Map

Data Limits

Information Only

The cube data set to be plotted is selected.

The indexes of cube data to be plotted are selected.
Cube indexes are defined in an Extract Cube
Indexes object.

A master/slave control to connect the data limits to
those specified in another object (e.g. Cube Color
Point, Grid Color Block, etc.). Master/Slave
controls are described in Section 6.3.1.

The color map used to associate colors with data
values is selected.

Controls how data values in the input data are
mapped to colors in the input color map. This
involves minimum and maximum data limit values
that correspond to the first and last color in the color
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map respectively.

If set, then the data limits are extracted from the data,
based on the Auto Source. If not set, then the data
limits specified by the Min and Max properties are
used.

If set, the log range is mapped to the colors, and the
log of the data values are used in calculating the
mapped color. Otherwise, linear mapping is used.

The method for determining the data limits
automatically.

The data limits are based on all data values.

The data limits are based on the data values within
the window view.

Minimum data value for color mapping.
Maximum data value for color mapping.
Colors used for data values outside the data limits.

Values below the minimum data limit are given the
first color in the color map, values above the
maximum data limit are given the last color in the
color map.

Values outside the data limits range are not plotted.

Factor by which the plotted blocks are reduced.
Reduction is performed by shrinking the block along
the lines between block vertices and the enclosed
node by the factor.

Controls the plotting of block edges with lines.
If selected, edges are plotted.

Color for edges selected from the plot window’s plot
pen set.

Edge line thickness.
Polygon offset of lines. Used only for OpenGL 1.1.

Determines which cube variable is plotted as the X,
Y and Z axis. Once the input data has been selected
and applied, the three Cube dialog prompts will be
replaced with the name of each cube variable.

Information Only




Offset

XYZ offset is used to improve the visibility of
objects (see discussion of 3D plot object visibility,
Section 8.1.2.1).

Information Only ™




13.11 Cube Color Point

What: Displays points at each cube data value for specified cube indices within
specified cube value limits. Points are colored according to the associated
value.

Why: Displays cube data in a 3D plot window.

Used By: Color Legend

Appearance:
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Figure 205. Cube Color Point Window

Input Data: cube data, cube indexes and color map

Output Data:  color map limit specifications

Properties:

Cube Data To Plot

Cube Indexes

Limit Selection

Color Map

Data Limits

Information Only

The cube data set to be plotted is selected.

The indexes of cube data to be plotted are selected.
Cube indexes are defined in an Extract Cube
Indexes object.

A master/slave control to connect the data limits to
those specified in another object (e.g. Cube Color
Block, Grid Color Block, etc.). Master/Slave
controls are described in Section 6.3.1.

The color map used to associate colors with data
values is selected.

Controls how data values in the input data are
mapped to colors in the input color map. This
involves minimum and maximum data limit values
that correspond to the first and last color in the color
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map respectively.

If set, then the data limits are extracted from the data,
based on the Auto Source. If not set, then the data
limits specified by the Min and Max properties are
used.

If set, the log range is mapped to the colors, and the
log of the data values are used in calculating the
mapped color. Otherwise, linear mapping is used.

The method for determining the data limits
automatically.

The data limits are based on all data values.

The data limits are based on the data values within
the window view.

Minimum data value for color mapping.
Maximum data value for color mapping.
Colors used for data values outside the data limits.

Values below the minimum data limit are given the
first color in the color map, values above the
maximum data limit are given the last color in the
color map.

Values outside the data limits range are not plotted.

Select from available symbols: X, +, square, circle,
triangle, diamond, filled square, filled circle, filled
triangle and filled diamond. The approximate
relative size in pixels is also selected.

Controls the plotting of point edges with lines. Only
available for filled symbols.

If selected, edges are plotted.

Color for edges selected from the plot window’s plot
pen set.

Edge line thickness.
Polygon offset of lines. Used only for OpenGL 1.1.

Determines which cube variable is plotted as the X,
Y and Z axis. Once the input data has been selected
and applied, the three Cube dialog prompts will be
replaced with the name of each cube variable.

Information Only




Covariance Covariance List Covariance

Jacobian Jacobian List Jacobian

OptRun Optimization Results List Optimization Run
16.4 Output Objects

Output Object Names :
Object Tree Object Menu Object Description

WriteColorMap

Write Color Map File

Write Color Map

WriteCurveArray | Write Curve File

Write Curve File

WriteGrid Write Grid File Write Grid
WriteTable Write Table to File Write Table
WriteXY Write XY Data to File Write XY Data

Information Only
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XYMath Vector Math XY Math
XY Statistics Statistics XY Statistics
XYToXYArray Add XY to Array XY To XY Array
16.2 Plot Objects

Plot Object Names

Object Tree Object Menu Object Description
2DAnalytic Analytics: Line Data 2D Line Analysis
2DPlotAnno 2D Plot Annotation 2DPlot Annotation
2D-XY 2D XY Main Menu 2D XY Plot

3D Lighting 3D Lighting 3D Light Setup
3DAxesFormat 3D Axes Format 3D Axes Formatting
3DAxesLabel 3D Axes Labels 3D Axes Labelling
3DXY Data XY Series 3D XY Data

3D-XYZ 3D XYZ Main Menu 3D XYZ Plot
ColorContour Grid Contour Grid Contour
ColorCubeBlock Cube Color Block Cube Color Block
ColorCubePoint Cube Color Point Cube Color Point
ColorGridBlock Grid Color Block Grid Color Block Fill
ColorGridFill Grid Color Fill Grid Color Range Fill
ColorGridPoint Grid Color Point Grid Color Point
ColorLegend Color Legend Color Legend

Covar Limits Confidence Limits Covariance Matrix Confidence Limits
Datal.abels Data Labels Data Labels
EditXYOnPlot Modify: Enter/Edit XY | Enter/Edit XY On Plot
Grid Fishnet Grid Fishnet Grid Fishnet

GridLine Extra Grid Lines 2D Grid Line

Multiple Table Multiple Table Series Multiple Table Data
SequenceGridLines Sequence Grid Lines Sequence Lines
SeriesLegend Series Legend Series Legend
TableHistogram Table Histogram Table Histogram
TableSeries Single Table Series Table Series
TableXYZ Table Series 3D Table Data Series
UserLabels User Labels User Labels

X Axis 2D XY Axes Single 1D Axis

XY Data XY Series XY Data
XYHistogram XY Histogram XY Histogram

XY Horsetail XY Array Horsetail XY Array Horsetail
XY Labels XY Labels XY Labels

XYZ Labels XYZ Labels XYZ Labels

Y Axis 2D XY Axes Single 1D Axis

Z Axis 3D XYZ Axes Single ID Axis

16.3 List Objects

List Object Names

Object Tree | Object Menu

| Object Description

Information Only
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ReadLabelArray

Read XYZ Label Data

Read Labels

ReadOptSimResults

Read nSIGHTS Optimizer Results

Read Optimizer Results File

ReadProfileSimResults

Read nSIGHTS Profile Results

Read Profile Sim Results File

ReadRangeSimResults Read nSIGHTS Range Results Read Range Results File

ReadSequenceTimes Read Sequence Time Interval Data | Read Sequence Times

ReadTable Read Table File Read Table Data

ReadXY Read XY Data Read XY Data

ReadXYSimResults Read nSIGHTS XY Results Read XY Sim ResultsFile

Real S/T Scale/Transform Real Scale/Transform

RealToTable Real Value(s) To Table Real Values To Table

Reduction Reduction XY Reduction

Remove Duplicate Remove Duplicates XY Remove Duplicates

ResidualDiagnostic Calculate Residual Diagnostic Residual Diagnostic

SelectCurve Select Curve from File Select Curve

SelectOptCovar Extract Covariance Matrices Select Covariance Matrices

SelectOptJacob Extract Jacobian Select Jacobian Data .

SelectOptResid Extract Residuals Select Residuals

SelectOptResults Extract Optimizer Results Table Select Results

SelectProfile Extract Profile Grid Select Profile from Profile Sim
Results

SelectRangeCube Extract Range Cube Select Range Cube

SelectRangeGrid Extract Range Grid Select Range Grid

SelectRTCube Select Range Cube Select RunTime Range Cube

SelectRTGrid Select Range Grid Select RunTime Range Grid

SelectXY Select XY from XY Array Select XY

SelectX Y fromXYSimResults Extract XY from XY Results Select XY from Results

SequenceFit Sequence Fit Sequence Fit

SingleFit (Basic) Single Fit Single Fit

Smooth/Filter Smooth/Filter XY Smooth/Filter

SumTables Sum Tables Sum Tables

Table Col S/T Table Column Scale/Transform Table Column Scale/Transform

TableColCorr Table Column Correlations Calculate Table Column
Correlation

TableColumnMath Table Column Math Table Column Math

TableHistogram Table Column To Histogram Table Column Histogram

TablelnterpVal Interpolate Table Columns Interpolate Real from Table

TableRangeExtract Extract Table Rows Table Column Range Extract

TableRowlIndexLogic Table Row Index Logic Table Row Index Logic

TableRowStatistics Table Row Statistics Table Row Summary Statistics

TableStatistics Table Column Statistics Table Column Statistics

TableToReal Extract Real from Table Extract Real from Table

TableToXY Table Columns To XY Extract XY From Table

Transpose Transpose * XY Transpose

ViewTable View Table Data View Table Data

ViewXY View XY Data View XY Data

WriteColorMap Write Color Map Write Color Map

WriteCurveArray Write Curve File Write Curve File

WriteTable Write Table File Write Table

WriteXY Write XY File Write XY Data

XY Array S/T Array Scale/Transform XY Array Scale/Transform

XY Range Extract Extract Range XY Range Extraction

XY S/IT Single Scale/Transform XY Scale/Transform

XYHistogram Histogram XY Histogram

Information Only
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16 APPENDIX E — OBJECT NAMES

Object names sometimes appear different in the object menu, the object tree and the object
description area. The following tables provide alternate names given the object name in the
object tree, sorted alphabetically. Object names used in the user manual, including object
description appendices, refer to the object menu name.

161 Data Objects

Data Object Names
Object Tree Object Menu Object Description
AddNoise Add Noise XY Add Noise
BasicResidual Calculate Basic Residual Basic Residual Calculation
BasicTimeExtract Time Limits | Extract/Interpolate XY Data by
Extraction/Interpolation Time Limits
CompositeFit Composite Fit Composite Fit
CreateCurve Create Curve from XY Data Create Curve Data
CreateRealValue Create Real Value Create Real Value
CreateTimeProcess P(t) Time Processing Create Time Process Data
CreateXY Array Create XY Array Create XY Array
Cube S/T Scale/Transform Cube Scale/Transform
CubeExtractGrid Extract Grid Cube Extract Grid
CubeHistogram : Histogram Cube Histogram
CubeMath Matrix Math ' Cube Math
CubeNormalize Normalize Cube Normalize
CubeStatistics Statistics Cube Statistics
CubeTolndex Extract Cube Indexes Cube To Index
Curvinterp Interpolate XY Data from Curve Curve Intcrpolate
DataPgDesc Data Page Description
Derivative P(t) Derivative Calculation Create Derivative Data
Dual XY S/T Dual Scale/Transform Dual XY Scale/Transform
EnterTable Enter Table Data Enter Table Data
EnterXY Enter XY Data . Enter XY Data
ExtractSequence Extract Sequence(s) Extract Sequence Interval
FFT Fourier Transform on Y XY Fourier Transform
FullTableCorr Full Table Correlations Calculate Full Table Correlation
Grid S/T Scale/Transform Grid Scale/Transform
GridExtractXY Extract XY Grid ExtractXY
GridHistogram Histogram Grid Histogram
GridMath Matrix Math Grid Math
GridNormalize Normalize Grid Normalize
GridStatistics Statistics Grid Statistics
Integrate Integrate XYIntegrate
JacobianToTable Jacobian To Table Jacobian To Table
LinColorMap Linear Color Map 2 Linear Color Map
MergeColorMap Merge Color Maps Merge Color Maps
PenSet Pen Set Pen Set
PulseNormalize Pulse Normalization Normalize Pulse Data
ReadColorMap Read Color Map Read Color Map
ReadCubeData Read Cube Data Read Cube Data
ReadCurveArray Read Curve File Read Curve File
ReadGridData Read Grid Data Read Grid Data
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15 APPENDIX D - NPOST OUTPUT OBJECT DESCRIPTIONS

As most nPost output objects are identical to nPre data objects, refer to Appendix A for a
description of all output objects except Write Grid File.

15.1 Write Grid File
What: Writes a grid to a text file.
Why: Allows grid data to be used or manipulated outside the nSIGHTS application

(for example, in another nSIGHTS application).

Appearance:
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Figure 239. Write Grid File Window
Application: nPost
Input Data: table data

Output Data:  text output file containing grid data compatible with Read Grid Data, default
file extension *.grd

Properties:
Grid Data Source Selects the grid data to be output.
Grid File Format One of four file formats can be selected. See the
Read Grid Data object description for standard and
XYZ list file formats.
Std The standard grid file format.
Surfer The grid format produced by Surfer Version 7
software, based on the GS ASCII (*.grd) file format.
XYZ List List of XYZ points.
Other For future use, not currently supported.
Grid Output File The name of the output file is entered in the text bar

or the Browse button is used to find the file path using
the standard Windows open file dialog.

The output file is only written once the Apply button is selected.
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Covariance Matrix

Estimated
Actual

Sub-fits

Multiple List Output

All Cases

Best Fit

Statistics

Listing Selections

or cases allows the user to select the runs or cases to
be viewed in the list window.

Covariance matrices use the estimated standard
deviation specified by the user for each parameter.

Covariance matrices use the actual standard
deviation calculated during the simulation.

Allows the covariance matrix of sub-fits to be
extracted. A sub-fit is a single fit of a composite fit.

Results for each case selected in the Selected Runs to
List are displayed.

Only the best fit of all selected cases are displayed.

Provides statistics (minimum, maximum, mean and
standard deviation) of the Fit Value and Fitted
Parameter Value data.

Specifies which optimization results to display in the
list window.

Information Only




14.3 Optimization Results

What:

Why:
Used By:

Appearance:

Input Data:

Output Data:

Properties:

Displays optimizer results output, including a summary of the simulation, fit
value data, fitted parameter values, parameter correlation values and 95%
confidence intervals in a list window.

Provides text values of optimization results.

Nothing.
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Figure 238. Optimization Results Window
nSIGHTS Optimizer Results

none

Optimization Results To List

Listing Type

Control

Cases

Fd
=]
=
]

>

Selected Runs to List

Select the nSIGHTS Optimizer Results object to
be displayed in the list window.

All cases will be displayed in the Selected Runs to List
window.

Only runs will be displayed in the Selected Runs to List
window.

Clears all runs or cases selected in the Selected Runs to
List window.

Selects all runs or cases in the Selected Runs to List
window.

A selection box containing a list of the available runs
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14.2 Jacobian List

What: Displays Jacobian data, as well as each parameter’s and each fit’s percentage of
the total sensitivity in a list window.

Why: Provides text values and properties of the Jacobian matrix.
Used By: Nothing.
Appearance:
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Figure 237. Jacobian List Window
Input Data: Extract Jacobian Data
Output Data:  none
Properties:

Jacobian Data To List Select the Extract Jacobian Data object to be
displayed in the list window.

341

Information Only




14 APPENDIX C — NPOST LIST OBJECT DESCRIPTIONS

14.1 Covariance List

What: Displays the values of the covariance matrix in a list window.
Why: Provides text values of the covariance matrix.

Used By: Nothing.

Appearance:

wm
Mm“‘?ﬁ”!“.‘"““’_. . =

= R e TR R e —

Figure 236. Covariance List Window
Input Data: Extract Covariance Matrices
Output Data:  none

Properties:

Covariance Data To List Select the Extract Covariance Matrices object to

be displayed in the list window.

Information Only
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Points to Delete

Pen for Connecting Line

Pop-Up Window:

formatting options are as described for Points to Keep.

Points selected with the mouse in Delete mode are
represented by the specified symbol. Once the Apply
command is selected, the selected points will be
deleted from the object. Symbol formatting options
are as described for Points to Keep.

Existing and entered points are connected by a line
of the specified color.

Within the 2D plot window, in select mode, a new pop-up window specific to this object is

available, as shown in figure 235:

Apply

Cancel

Delete mode

Enter mode

Delete All

T EneEdR

1 e
Cancel,

| "osete moce
4 Enter mode

Figure 235.

Equivalent to the Apply button on the Modify:
Enter/Edit XY object’s property window.

Equivalent to the Cancel button on the Modify:
Enter/Edit XY object’s property window.

Once selected, all clicks of the mouse near an
existing point will change the point’s symbol to the
Points to Delete symbol. Once the Apply button is
selected, all points with the Points to Delete symbol
will be deleted.

New points, represented by the Entered Points symbol,
will be created with each click of the mouse in the
2D plot window. A line will connect the point with
the previously selected, created or closest point.
Once the Apply button is selected, all points with the
Entered Points symbol will be entered.

All points within all active Modify: Enter/Edit XY
objects will be deleted.
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13.33 Modify: Enter/Edit XY

What:
Why:

Used By:

Appearance:

Object creates or deletes XY data points.

Allows the user to create a new XY data set or add and delete points from an

existing data set interactively.

Any object using XY data points.

F G5 : e —
S I Layer 0 PiAcive 7, Plot

- nput 2 Osta

- Points o Kee,

[FiesC ). [eem =) (e =]
Enternd Pointy =——— — —— =

Inms . R T -]
mhs e R

I Points 1o Delete ;

ST e g dx)l [HE Binck -

- Pon for C

A B Croen

Figure 234. Modify: Enter/Edit XY Window

Input Data: none or XY data
Output Data: XY data
Properties:

Input XY Data

Update

Points to Keep

Symbol size

Pen

Entered Points

Select an XY data source to be edited. Will not be
used as a source unless the Update button is selected.

The Update button will delete all existing points, and
create new points based on the XY points of the
object selected as Input XY Data.

Existing points are represented by the specified
symbol.

One of the available symbols is selected: X, +,
square, circle, triangle, diamond, filled square, filled
circle, filled triangle and filled diamond.

The approximate relative size of the symbol in pixels
is selected.

Select the color of the symbol from the plot
window’s plot pen set.

Points entered with the mouse (in Enter mode) are
represented by the specified symbol. Once the Apply
command is selected, the entered points will be
represented by the Points to Keep symbol. Symbol
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Line End Handle

Line
Line type
Line thk
Pen
Results

Pop-Up Window:

within the 2D window rotates and changes the length
of the analytic line. Symbol formatting options are
as described for the Center Point.

Two points on each end of the analytic line are
represented by the specified symbol. Dragging
either of these points within the 2D window changes
the length of the analytic line, as well as the location
of the line end. Symbol formatting options are as
described for the Center Point.

The analytic line formatting options.

The line pattern is selected: Solid, Dashed, or Double-
Dash.

Thickness of the line in pixels.

Select the color of the symbol from the plot
window’s plot pen set.

The resulting line properties are provided, including
the center point X and Y co-ordinate, the line length,
the X and Y component of the line length, the line
slope and the line Y intercept.

Within the 2D plot window, in select mode, a new pop-up window specific to this object is

available, as shown in figure 233:

Apply

Reset

P e "

Analytics

Apply,

L

Reset

Figure 233.

Equivalent to the Apply button on the Analytics:
Line Data object’s property window.

Returns the analytic line to the default location,
length and rotation.
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ACTIVE PLOT OBJECTS
13.32 Analytics: Line Data

- What: Creates a line with 5 points in a 2D plot window. Each point in the line can be
dragged to move, rotate, extend or shrink the line. The location of the line, in
addition to its length, slope and Y intercept, are provided in the object property
window, and are output as data labels.

Why: Allows the user to create a straight line on a 2D plot interactively.
Used By: Data Labels
Appearance:
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Figure 232. 2D Analytic Line Data Window
Input Data: none

Output Data:  data labels of line properties

Properties:

Center Point The center of the analytic line is represented by the
specified symbol. Dragging the center point moves
the entire line.

Symbol type One of the available symbols is selected: X, +,
square, circle, triangle, diamond, filled square, filled
circle, filled triangle and filled diamond.

Symbol size The approximate relative size of the symbol
in pixels is selected.

Pen Select the color of the symbol from the plot
window’s plot pen set.

Rotation Handle Two points, one each between the center and the

ends of the analytic line, are represented by the
specified symbol. Dragging either of these points
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ordinate.
Vertical Align Vertical justification relative to the label co-ordinate.

Label Font Specifies the font used for labels. Font formatting
options are described in Section 6.3.4.

Offset XYZ offset is used to improve the visibility of
objects (see discussion of 3D plot object visibility,
Section 8.1.2.1).
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13.31 XYZ Labels

What:
Why:
Used By:

Appearance:

Input Data:

Displays 3D labels in 3D data space.
Text annotation of data values, cultural features.

Nothing (no object output).
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Figure 231. XYZ Labels Window
Read XYZ Labels, Create XYZ Label for Real

Output Data:  none
Properties:

Label Data Source

Label Pen

Label Plane

Auto

Vertical

Horizontal
Label XY Rotation

Auto

Rotation

Horizontal Align

Select the object containing the source of the XYZ
labels.

Pen color used for labels, selected from the plot
window’s plot pen set.

The plane onto which the text will be displayed is
determined by the current view elevation. The label
plane is horizontal if the view elevation is greater
than 45 degrees, vertical otherwise.

The text is displayed orthogonal to the XY plane.
The text is displayed parallel to the XY plane.

Label rotation in the XY plane is perpendicular to the
current view azimuth.

If not Auto, the rotation angle of the label in the XY
plane is entered in degrees (0.0 is parallel to X axis).

Horizontal justification relative to the label co-
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13.30 XY Labels

What:
Why:
Used By:

Appearance:

Input Data:

Displays 3D labels in a 2D data space.
Text annotation of data values, cultural features.

Nothing (no object output).
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Figure 230. XY Labels Window
Read XYZ Labels, Create XYZ Label for Real

Output Data:  none
Properties:

Label Data Source

Label Pen

Horizontal Align

Vertical Align

Legend Fpnt

Options
Clip to Axes

Offset

Information Only

Select the object containing the source of the XY
labels.

Pen color used for labels, selected from the plot
window’s plot pen set.

Horizontal justification relative to the label co-
ordinate.

Vertical justification relative to the label co-ordinate.

Specifies the font used for labels. Font formatting
options are described in Section 6.3.4.

XY labels outside the current axes limits will not be
plotted.

XY label location will be offset by the entered value
(based on a 0-100 annotation co-ordinate space).

333




text boxes within the scroll box, one text box per line
of resulting label text. '

Selected Checkbox must be selected for the entered label to be
included in the legend box.

Label Text Label text is entered in the text box.

Justification Justification of the label text within the legend box.
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13.29 User Labels

What: Annotation object that displays a legend box containing user entered text.
Why: Standard annotation.
Used By: Nothing (no object output).
Appearance:
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Figure 229. User Labels Window

Input Data: none
Output Data:  none

Properties:
Legend Box Location & Size

X, Y Position

Legend Box Format

Opagque
Frame
Legend Pen

Thk

Legend Font

Label Text

Information Only

Location of upper left corner of the legend in a 0-100
annotation co-ordinate system.,

Places the legend box on an opaque rectangle of
background color (allows labels to be overlaid on
data areas).

Places a rectangular frame around the legend box.

Pen color used for labels and frame, selected from
the plot window’s plot pen set.

Thickness (in pixels) of frame.

Specifies the font used for labels. Font formatting
options are described in Section 6.3.4.

Twelve lines of user-input label can be displayed by
each User Labels object. The text is entered in the
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hk

Legend Font

Legend Label

Legend Data

Selected

Data Source

the plot window’s plot pen set.
Thickness (in pixels) of frame.

Specifies the font used for labels. Font formatting
options are described in Section 6.3.4.

Additional label placed in upper right comer of
legend.

Legend data from 12 different input objects can be
displayed by each Series Legend object. The input
objects are selected in the scroll box, one input
object per line.

Checkbox must be selected for the input objects to be
included in the legend.

Series data to include in the legend are selected.
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13.28 Series Legend

What: Annotation object creates a legend box for describing symbols and/or lines
used by other plot objects.

Why: Standard plot annotation.
Used By: Nothing (no object output).
Appearance:
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Figure 228. Series Legend Window

Input Data: Confidence Limits, Grid Contour, Grid Fishnet, Multiple Table Scries,
Table Series, XY Array Horsetail, XY Series.

Output Data:  none
Properties:

Legend Box Location & Size

X, Y Position Location of upper left comer of the legend in a 0-100
annotation co-ordinate system.

Data Size Length in 0-100 space of symbol/line display.

# points . Number of points in symbol/line display.

Legend Box Format

Opague Places the series legend on an opaque rectangle of
background color (allows legend to be overlaid on
data areas).

Frame Places a rectangular frame around the series legend.

Legend Pen Pen color used for labels and frame, selected from
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system from the start to the end of the grid line.

H Horizontal justification.
v Vertical justification.
Off Offset space between the grid line and the label.
Blank Creates a blank in the grid line, where the grid line
and label intersect.
Label Font Specifies the font used for the label. Font formatting
options are described in Section 6.3.4.
Options
Show END label A grid line is created for the starting time of each

sequence, in addition to the end time of the last
sequence. If this checkbox is selected, a label of
“END” will be placed adjacent to the grid line
representing the end time of the last sequence.

328

Information Only




13.27 Sequence Grid Lines

What: Displays a grid line to define sequence intervals. Grid lines are created for the
starting time of each sequence and for the end time of the last sequence. The
grid lines may be labelled with the sequence identifier.

Why: To emphasize the beginning and starting points of sequences.

Used By: Nothing (no object output).

Appearance: '
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Figure 227. Sequence Grid Lines Window

Input Data: Sequence Time Interval Data

Output Data:  none

Properties:

Sequence Times Input * The sequence time data set is selected. In nPre, the

sequence time, data are by default a global object
defined in the Sequence input window. In nPost, the
sequence time data must be read in with a Sequence
Time Interval Data object, or with XY or profile
simulation results.

Grid Line Format

Line type The grid line pattern is selected: Solid, Dashed, or
Double-Dash.

Line thk Thickness of the grid line in pixels.

Pen Select the color of the grid line from the plot

window’s plot pen set.

Label Format

Label | If selected, the sequence identifier will be placed
adjacent to the grid line.

Pos. Position of the label, based on a 0-100 co-ordinate
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Label If selected, a label will be placed adjacent to the grid
line.
Pos. Position of the label, based on a 0-100 co-ordinate
system from the start to the end of the grid line.
H Horizontal justification.
Y Vertical justification.
off Offset space between the grid line and the label.
Blank Creates a blank in the grid line, where the grid line
and label intersect.
Label Font Specifies the font used for the label. Font formatting
options are described in Section 6.3.4.
Label Label text is user-input in the text box.
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13.26 Extra Grid Lines

What: Displays a grid line at a specified X or Y value. The grid line may also be
labelled.

Why: To emphasize a value in the X or Y axis.

Used By: Nothing (1{0 object output).

Appearance:
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Figure 226. Extra Grid Lines Window

Input Data: none
Output Data:  none
Properties:

Grid X/Y Value Value Source

Grid X/Y Value Value

Grid Line Format

X

|=<

Pen

Line thk

Line type

Label Format

Information Only

A master/slave control to connect the Grid X/Y
Value to a value specified in another object (e.g.
another Extra Grid Lines object). Master/Slave
controls are described in Section 6.3.1.

The X or Y value at which the grid line will be
drawn.

The Grid X/Y Value Value will represent an X co-
ordinate.

The Grid X/Y Value Value will represent a Y co-
ordinate.

Select the color of the gﬁd line from the plot
window’s plot pen set.

Thickness of the grid line in pixels.

The grid line pattern is selected: Solid, Dashed, or
Double-Dash.
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R\

Data Labels

Select

Data Source

Justification

New format

New Label

described in Section 6.3.4.

Each Data Labels object can plot up to 6 data labels,
plotted consecutively within one legend box, one
data label per line. The scroll box in the property
window contains 6 input areas, separated by
horizontal lines. Each input area is used to describe

.one data label.

The toggle box in the upper left corner of each input
area must be selected to plot the selected data label.

The data label to be plotted is selected in the adjacent
drop-down list.

Each data label is justified within an enclosing sub-
rectangle. This property controls the justification
within the sub-rectangle.

If the data value is associated with a numeric value,
the user can override the existing format. Numeric
formatting options are described in Section 6.3.3.

If selected, the existing description associated with
the label is overridden. The first text box will create
a label in front of the data (e.g. data descriptor), the
second text box will create a label after the data (e.g.
units of the data).
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13.25 Data Labels

What: Annotation object that displays property and input settings for other objects in
a legend box.

Why: Ensures annotation is updated as objects change.
Used By: Nothing (no object output).
Appearance:
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Figure 225. Data Labels Window
Input Data: many objects produce one or more label outputs
Output Data:  none
Properties:
Legend Box Location
X, Y Position Location of upper left corner of legend box in a 0-
100 annotation co-ordinate system.
Format
Opaque Places text on opaque rectangle of background color.
Frame Places a rectangular frame around data label.
Pen Pen color used for text and frame, selected from the
plot window’s plot pen set.
Thk Thickness (in pixels) of frame.
Legend Label User-input label placed above specified data labels.
Minimum Data Field Width Specifies minimum width of label, based on the
number of characters.
Legend Font Specifies the font used for the legend label and the

specified data labels. Font formatting options are
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# of inc Actual number of increments, if Auto is not selected.
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Bar length

Aspect ratio

Legend Box Format
Tics

Opaque

Frame

'-—l
=
=

Legend Font

Main Label
Label

Above/Left

Default

Inc. Label

Above/Left

Increment Label Format

Increments

Auto

Height (if vertical) or width (if horizontal) in
annotation units.

Width (if vertical) = length / aspect ratio.

Draws tic marks at increments.

Places the color bar and annotation on an opaque
rectangle of background color (allows bar to be
overlaid on data areas).

Places a rectangular frame around the color bar and
annotation.

Thickness (in pixels) of frame.

Specifies the font used for increments and the main
label. Font formatting options are described in
Section 6.3.4.

Includes a data label next to the color bar.

If selected, the data label is above the color bar (if
horizontal), or to the left of the color bar (if vertical).
If not selected, the data label is below the color bar
(if horizontal) or to the right of the color bar (if
vertical).

When toggled on, the main label is entered by the
user in the adjacent text box. When toggled off, the
main label is based on the object ID of the selected
color object.

If selected, the increment labels are placed above the
color bar (if horizontal), or to the left of the color bar
(if vertical). If not selected, the increment labels are
placed below the color bar (if horizontal) or to the
right of the color bar (if vertical).

Specifies the numeric format of the increment labels.
Number formatting is described in Section 6.3.3.

Specifies the number of increments in the color bar.

The number of increments is based on data type
(lin/log) and range. Not implemented.
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Input Data:

Output Data:
Properties:

Orientation

Color Legend Data Source

X, Y Position

ANNOTATION PLOT OBJECTS

13.24 Color Legend

What: Annotation object that displays a color bar and associated data limits.
Why: Gives numeric context to plot objects using color maps.

Used By: Nothing (no object output).

Appearance:
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Figure 224. Color Legend Window

Color Cube Block, Color Cube Point, Color Grid Block, Color Grid Fill,
XY Array Horsetail

none

Select the color plot object the color legend will
represent.

Horizontal Legend is horizontal.
Right Legend is vertical, main label is read from top to
bottom.
Left Legend is vertical, main label is read from bottom to
top.
Legend Pen Pen color used for label, tics, and frame,
selected from the plot window’s plot pen set.
Legend Box Location & Size

Location of upper left comer of bar in a 0-100
annotation co-ordinate system.
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Tube size

Edges
SymEdges
TubeEdges ~

Edege Pen

Sesme T

Edge line thk

PolyOff

Z Value Source
Z Value
3D Co-ordinate Mapping

Series Label

New label

Offset

selected: Triangle, Square, Octagon OF Round.

The relative size of the tube in pixels is selected.

If selected, plots a line around plotted symbols.

If selected, plots a line around plotted tubes.

Select the color of the symbol or tube edges.
Thickness of edge lines in pixels.

Polygon offset of lines. Used only for OpenGL 1.1.

Master/Slave controls for the Z value. Master/Slave
controls are described in Section 6.3.1.

XY values will be plotted at the constant Z value
entered.

Determines which X, Y and Z values are plotted as
the X, Y and Z axis.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the object output ID of the input XY
data. ‘

XYZ offset is used to improve the visibility of
objects (see discussion of 3D plot object visibility,
Section 8.1.2.1).

Information Only




Select

Type
Pen

mbol type
Symbol size
Line type
Line thk
New label

3D Plot Object Properties:

The toggle box in the upper left comer of input area
must be selected to plot the selected XY series. The
XY series to be plotted is selected in the drop-down
list.

The XY series is plotted as lines and/or symbols.

Select the color of the lines and/or symbols from the
plot window’s plot pen set.

Available if Type is not Line, one of the available
symbols is selected: X, +, square, circle, triangle,
diamond, filled square, filled circle, filled triangle
and filled diamond.

The approximate relative size of the symbol in pixels
is selected.

Available if Type is not Symbol, the line pattern is
selected: Solid, Dashed, or Double-Dash.

Thickness of the line in pixels.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the object output ID of the input XY
data.

Each XY Data Series object can plot only one XYZ series, using X and Y from the selected XY
data, and Z values specified as the Z value source.

Plotting Spec.

3
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Symbol type

Symbol size

Line type

Line thk

Tube type

The XY series is plotted as lines and/or symbols.

Select the color of the lines and/or symbols from the
plot window’s plot pen set.

Available if Type is not Line, one of the available
symbols is selected: X, +, square, circle, triangle,
diamond, filled square, filled circle, filled triangle
and filled diamond.

The relative size of the symbol in pixels is selected.

Available if Type is not Symbol, the line pattern is
selected: Solid, Dashed, Double-Dash OT Extruded.

Thickness of the line in pixels.

Available if Line type is Exnuded, the tube pattern is

Information Only




13.23 XY Series

What: Displays multiple XY data using symbols and/or lines.
Why: Standard XY data display.
Used By: Series Legend

Appearance: This object appears different in 2D and 3D.
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Figure 222. 2D XY Data Series Window
3D
moﬁﬁ@mm: o IS
L] N v il
B3 Dile 12 Pt S5 2
([nona svatsties _ 7 i st S =l
f:‘,ﬂmm::_._._-;_.z Y L b e I e i
! Ure v ls:;uara I} |Solid [ " I')negr.m =1
t e o lﬁ b, ——r E;::E]
. Gismsen "o e T =
\E'; r)TllhpEduH -E“ g ‘_!:; E ;‘ Preini} Pone pon, 2
2 Velie Source : -2 Valvo- -
F LU TR [Eteveuan 3057 _ _;j” [o0 i
BT [ e o ' ==
fcrux “ = ixm fv_|§ Data ¥ : |Ym'-v| Dats 2 !Zm .v|-
-.:Sminl.nhel = - - -—
[ New Labal |H_‘. -—‘--n-——-—--n-, TN TSR e e e
£ Ofiset e i SIS
% T —— v. . [om __5__; 2 L —
v ) 2 r

Figure 223. 3D XY Data Series Window
Input Data: XY data
Output Data:  series legend specifications
2D Plot Object Properties:

Each XY Data Series object can plot up to 8 XY series, each plotted using a different format.

The scroll box contains 8 input areas, separated by horizontal lines. Each input area is used to
describe one XY series.
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% Avail

Line Thk

X Thick

Pixels

% Available

Edges

Plot

Legend

New label

Histogram bars are plotted as lines.

Histogram bars are plotted as bars, with a thickness
specified as an X increment.

Histogram bars are plotted as bars, with a thickness
specified as a pixel width. Similar to lines, however
a rectangle is created which can be surrounded by an
edge.

Histogram bars are plotted as bars, with a thickness
specified as percentage of the minimum distance
between bars.

For histogram bars plotted as lines, the line thickness
is specified.

For histogram bar thickness specified as an X value,
the thickness as an X increment is specified.

For histogram bar thickness specified as a pixel
width, the thickness in pixels is specified.

For histogram bar thickness specified as the
percentage of space between X values, the thickness
as a percentage is specified.

For all histogram width types except line.

If toggled, edges of the bars will be plotted using the
pen color and pixel thickness specified within this
dialog frame.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the object ID of the input object.

Information Only




13.22 XY Histogram

What: Plots XY data as bars in a standard histogram format.
Why: Standard histogram data display.
Used By: Series Legend
Appearance:
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Figure 221. XY Histogram Window
Input Data: . XY data

Output Data:  series legend specifications

Properties:
XY Data to Plot . The XY data set to be plotted is selected.
Histogram Pen All histogram bars are plotted in the specified color.
Baseline
Axis Histogram bars will extend down to the X axis,
regardless of the Y value at the X axis.
Value Histogram bars will extend down (or up) to the Y
) value specified in the Baseline Value box.
Baseline Value If Value is specified as the Baseline, the minimum Y
value of the histogram bars is specified.
X Position

Index The X value of histogram bars is based on the index
value (e.g. the first Y value is plotted at an index of
1, the second at an index of 2, etc.)

Value The X value of histogram bars is based on the X
value in the data set.

Histogram Width

Information Only




13.21 XY Array Horsetail

What: Displays all XY data sets contained within an XY array.
Why: Standard XY data display of many XY data sets.
Used By: Series Legend, Color Legend
Appearance:
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Figure 220. XY Array Horsetail Window
Input Data: XY array
Output Data:  series and color legend specifications
Properties:

XY Data Array to Plot
Horsetail Color

Pen
Color Map

Single Color Pen

Color Map

Horsetail Line Options

Line thk

Line type

Legend

New label

The XY array data set to be plotted is selected.

All data set lines are plotted in the same color.

Each data set line is plotted in a different color.

If Pen is selected, select the color of the lines from
the plot window’s plot pen set.

If Color Map is selected, select a color map from the
drop-down list.

Thickness of the line in pixels.

The line pattern is selected: Solid, Dashed, or Double-
Dash.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the object ID of the input object.

Information Only




Edges
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Symbol type

Symbol size

Line type

Line thk _

Tube type

Tube size

SymEdges

TubeEdges
Edge Pen
Edge line thk

PolyOff

Series Label

Offset

New label

The XY series is plotted as lines and/or symbols.

Select the color of the lines and/or symbols from the
plot window’s plot pen set.

Available if Type is not Line, one of the available
symbols is selected: X, +, square, circle, triangle,

. diamond, filled square, filled circle, filled triangle

and filled diamond.
The relative size of the symbol in pixels is selected.

Available if Type is not Swmbol, the line pattern is
selected: Solid, Dashed, Double-Dash or Extruded.

Thickness of the line in pixels.

Available if Line type is Extruded, the tube pattern is
selected: Triangle, Square, Octagon Or Round.

The relative size of the tube in pixels is selected.

If selected, plots a line around plotteci symbols.

If selected, plots a line around plotted tubes.
Select the color of the symbol or tube edges.
Thickness of edge lines in pixels.

Polygon offset of lines. Used only for OpenGL 1.1.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the column ID of the Z data.

XYZ offset is used to improve the visibility of
objects (see discussion of 3D plot object visibility,

_ Section 8.1.2.1).

Information Only




13.20 Table Series

What: In a 3D plot, displays columns of single table as XYZ data using symbols
and/or lines.

Why: Standard XYZ data display.

Used By: Series Legend

Appearance:
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Figure 219.Table XYZ Series Window

Input Data: table data

Output Data:  series legend specifications

Properties:

Table Data The table data set to be plotted is selected

X data column

Y data column

Z data column

Options

Plot all rows

# of rows to plot

Plotting Spec.

Information Only

The column in the input table that will form the X
co-ordinate of the series.

The column in the input table that will form the Y
co-ordinate of the series.

The column in the input table that will form the Z co-
ordinate of the series.

If toggled off, only rows 1 to the specified # of rows
will be plotted.

If Plot all rows is toggled off, the maximum number of
rows to be plotted is specified.
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Value

Histogram Width
Line

X Value

Pixels

% Avail

Line Thk

X Thick

Pixels

% Available

Edges

=
=)

|

Legend

New label

The X value of histogram bars is based on the X
value in the data set.

Histogram bars are plotted as lines.

Histogram bars are plotted as bars, with a thickness
specified as an X increment.

Histogram bars are plotted as bars, with a thickness
specified as a pixel width. Similar to lines, however
a rectangle is created which can be surrounded by an
edge.

Histogram bars are plotted as bars, with a thickness
specified as percentage of the minimum distance
between bars.

For histogram bars plotted as lines, the line thickness
is specified.

For histogram bar thickness specified as an X value,
the thickness as an X increment is specified.

For histogram bar thickness specified as a pixel
width, the thickness in pixels is specified.

For histogram bar thickness specified as the
percentage of space between X values, the thickness
as a percentage is specified.

For all histogram width types except line.

If toggled, edges of the bars will be plotted using the
pen color and pixel thickness specified within this
dialog frame.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the object ID of the input object.

Information Only




13.19 Table Histogram

What: Plots two columns of table data as bars in a standard histogram format.
Why: Standard histogram data display.
Used By: Series Legend
Appearance:
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Figure 218. Table Histogram Window
Input Data: table data

Output Data:  series legend specifications

Properties:
Table Data to Plot
Histogram Pen
X Data Column

Y Data Column

Baseline

Baseline Value

X Position

Index

The table data set to be plotted is selected.
All histogram bars are plotted in the specified color.
The table column to be used as the X data is selected.

The table column to be used as the Y data is selected.

Histogram bars will extend down to the X axis,
regardless of the Y value at the X axis.

Histogram bars will extend down (or up) to the Y
value specified in the Baseline Value box.

If Value is specified as the Baseline, the minimum Y
value of the histogram bars is specified.

The X value of histogram bars is based on the index
value (e.g. the first Y value is plotted at an index of
1, the second at an index of 2, etc.)

Information Only




Select

¥

Type

Pen

Symbol tvpe

Symbol size

Line type

Line thk

New label

Information Only

The toggle box in the upper left comer of input area
must be selected to plot the selected XY series.

The table column from the selected table to be used
as the Y data of the series.

The XY series is plotted as lines and/or symbols.

Select the color of the lines and/or symbols from the
plot window’s plot pen set.

Available if Type is not Line, one of the available
symbols is selected: X, +, square, circle, triangle,
diamond, filled square, filled circle, filled triangle
and filled diamond.

The approximate relative size of the symbol in pixels
is selected.

Available if Type is not Symbol, the line pattern is
selected: Solid, Dashed, or Double-Dash.

Thickness of the line in pixels.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the column ID of the Y data in the
input table.
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13.18 Single Table Series

What: In a 2D plot, displays columns of single table as XY data using symbols and/or
lines. Only one column is selected as the X data column. Multiple columns can
be selected for the Y data.

Why: Standard XY data display.

Used By: Series Legend

Appearance:
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Figure 217. Single Table Series Window

Input Data: table data

Output Data:  series legend specifications

Properties:

Table Data The table data set to be plotted is selected

X data column

Options

Plot all rows

# of rows to plot

The column in the input table that will form the X
co-ordinate of the series.

If toggled off, only rows 1 to the specified # of rows
will be plotted.

If Plot all rows is toggled off, the maximum number of
rows to be plotted is specified.

Each Single Table Series object can plot up to 8 XY series from one table, all using the same X
values specified in the X data column. A different format can be used to plot each XY series
selected. The scroll box contains 8 input areas, separated by horizontal lines. Each input area is
used to describe one XY series.

Information Only
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Symbol size

Line type

Line thk

New label

symbols is selected: X, +, square, circle, triangle,
diamond, filled square, filled circle, filled triangle
and filled diamond.

The approximate relative size of the symbol in pixels
is selected.

Available if Type is not Symbol, the line pattern is
selected: Solid, Dashed, or Double-Dash.

Thickness of the line in pixels.

When toggled on, the label output is entered by the
user in the adjacent text box. When toggled off, the
label output is the object output 1D of each table
input.

Information Only




13.17 Multiple Table Series

What:

Why:
Used By:

Appearance:

Input Data:

Output Data:

Properties:

In a 2D plot, displays columns of up to 8 multiple tables as XY data using
symbols and/or lines. X and Y data columns are specified for each table.

Standard XY data display.
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Figure 216. Multiple Table Series Window

table data

series legend specifications

Each Multiple Table Series object can plot up to 8 XY series. The scroll box contains 8 input
Each input area is used to describe one XY series. A

areas, separated by horizontal lines.
different format can be used to plot each XY series selected.

Select

>

[=<

E

o
(1]
=

Symbol type

The toggle box in the upper left corner of input area
must be selected to plot the selected XY series. The
table data object from which to extract the XY series
is selected from the adjacent drop-down-box.

The table column from the selected table to be used
as the X data of the series.

The table column from the selected table to be used
as the Y data of the series.

The XY series is plotted as lines and/or symbols.

Select the color of the lines and/or symbols from the
plot window’s plot pen set.

Available if Type is not Line, one of the available

Information Only o




Line Thickness
Line Tyvpe
Tube Extrusion

Cap Ends

Polvgon type

Polygon size
Options

X modulus

Plot Last X

Y modulus

Plot Last Y

Legend Label

3D Co-ordinate Mapping

Offset

Information Only

Lines, or 3D Tubes.

The thickness of the grid fishnet lines is selected.
The line pattern of the grid fishnet lines is selected.
For 3D plot object and Tubes plot type.

The ends of the tube are filled with a polygon, such
that the viewer cannot see inside the tube.

The tube can be several shapes: Triangle, Square,
Octagon Or Round.

Point size of each polygon of the tube in pixels.

Reduces the number of X grid points included in the
fishnet by the user-specified factor.

Ensures that the last X grid line (grid line at
maximum X value) is plotted.

Reduces the number of Y grid points included in the
fishnet by the user-specified factor.

Ensures that the last Y grid line (grid line at
maximum Y value) is plotted.

If New Label is toggled, up to 40 characters of user-
entered text in the text box is used in legend label
data output by the object. If the New Label checkbox
is toggled off, the default legend label data will be
the object ID.

For 3D plots, determines which grid and Z variable
is plotted as the X, Y and Z axis.

XYZ offset is used to improve the visibility of
objects (see discussion of 3D plot object visibility,
Section 8.1.2.1).
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13.16 Grid Fishnet

What: Plots grid lines of the grid, connecting all nodes of the grid. The number of
grid lines can be reduced, based on an X and Y modulus.

Why: To view the grid in a plot window.

Used By: Series Legend

Appearance: This object appears different in 2D and 3D.
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Figure 214. 2D Grid Fishnet Window
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Figure 215. 3D Grid Fishnet Window

Input Data: grid data

Output Data: series legend specifications

Properties:
Grid Data The grid data set to be plotted is selected.
Pen The color of the grid fishnet is selected from the plot
window’s plot pen set.
Plot Type For 3D plots, the grid fishnet can be plotted as 2D

Information Only




Line Format

Legend Label

Options

XYZ line output

3D Co-ordinate Mapping

Offset

Number of contour increments to plot. Contour lines
will be drawn for number + 1 values. Enter 0 to plot
a single line at the start value.

The appearance of each contour line. Color, line
width, and line pattern can be specified.

If the New Label is toggled, up to 40 characters of
user-entered text in the text box is used in legend
label data output by the object. If the New Label
checkbox is toggled off, the default legend label data
will be the object ID.

If set, the contour data are exported from the object
as XYZ co-ordinate array data. Note that the XYZ
line output is calculated even if the Plot toggle is off.

For 3D plots, determines which grid and Z variable
is plotted as the X, Y and Z axis.

XYZ offset is used to improve the visibility of
objects (see discussion of 3D plot object visibility,
Section 8.1.2.1).

Information Only




Grid Data To Plot

Z value

Same

Other Grid

Constant

Z Value Grid

Fixed Z Value Value Source

Fixed Z Value Value

Contour Specification

Increment Size

Specified

Calculated

Increment Type

Increment Values

Stant
End

Inc Size

The grid data set to be plotted is selected.

For 3D plots, a Z value needs to be identified to plot
XY data in a 3D plot.

The grid value at each grid co-ordinate is used as the
Z value.

Grid value is based on the grid value from another
grid of the same size.

The grid is plotted at a constant Z value. The Z
value may be specified, or based on the Z value of
another object.

For 3D plots, a grid is selected of the same size as
the Grid Data To Plot. The value from the selected
grid is used as the Z value.

For 3D plots, Master/Slave controls for a Constant Z
value. For grids extracted from a cube, the grid
extraction value may be used as the constant Z value.
Master/Slave controls are described in Section 6.3.1.

For 3D plots and Constant Z value, the constant Z
value at which to plot the grid.

A master/slave control to connect the contour
specifications to those specified in another object
(e.g. another Grid Contour object). Master/Slave
controls are described in Section 6.3.1.

How the contour increment is specified.
Enter minimum and increment, calculate maximum.
Enter minimum and maximum, calculate increment.

Increments are equally spaced in linear or
logarithmic data space.

The contour lines to plot.

Data value of first contour to plot (minimum contour
value).

Data value of last contour to plot (maximum contour
value) if Increment Size is Calculated.

Delta between lines if Increment Size is Specified. For
log increments the value is in terms of log cycles.

Information Only




13.15 Grid Contour
What: Displays single contour lines of the nodes of a grid based on specified grid
values.
Why: Display grid contours in a plot window.
Used By: Series Legend
Appearance: This object appears different in 2D and 3D.
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Figure 213. 3D Color Contour Window
Input Data: grid data ‘
Output Data:  series legend specifications
Properties:
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Auto Source
All Data
Grid in View
Min
Max

Out-of-Range

Extend

Clip
Symbol

Edges

=
2

-
(5]
=

—

hk

PolyOff
3D Co-ordinate Mapping

Offset

The method for determining the data limits
automatically.

The data limits are based on all data values.

The data limits are based on the data values within
the window view.

Minimum data value for color mapping.
Maximum data value for color mapping.
Colors used for data values outside the data limits.

Values below the minimum data limit are given the
first color in the color map, values above the
maximum data limit are given the last color in the
color map.

Values outside the data limits range are not plotted.

Select from available symbols: X, +, square, circle,
triangle, diamond, filled square, filled circle, filled
triangle and filled diamond. The approximate
relative size in pixels is also selected.

Controls the plotting of point edges with lines. Only
available for filled symbols.

If selected, edges are plotted.

Color for edges selected from the plot window’s plot
pen set.

Edge line thickness.
Polygon offset of lines. Used only for OpenGL 1.1.

For 3D plots, determines which grid and Z variable
is plotted as the X, Y and Z axis.

For 3D plots, XYZ offset is used to improve the
visibility of objects (see discussion of 3D plot object
visibility, Section 8.1.2.1).
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Grid Data To Plot

Z value

Same

Other Grid

Constant

Z Value Grid

Fixed Z Value Value Source

Fixed Z Value Value

Limit Selection

Color Map

Data Limits

The grid data set to be plotted is selected.

For 3D plots, a Z value needs to be
identified to plot XY data in a 3D

plot.

The grid value at each grid co-ordinate is used as the
Z value.

Grid value is based on the grid value from another
grid of the same size.

The grid is plotted at a constant Z value. The Z
value may be specified, or based on the Z value of
another object.

For 3D plots, a grid is selected of the same size as
the Grid Data To Plot. The value from the selected
grid is used as the Z value.

For 3D plots, Master/Slave controls for a Constant Z

~ value. For grids extracted from a cube, the grid

extraction value may be used as the constant Z value.
Master/Slave controls are described in Section 6.3.1.

For 3D plots and Constant Z value, the constant Z
value at which to plot the grid.

A master/slave control to connect the data limits to
those specified in another object (e.g. Cube Color
Point, Grid Color Block, etc.). Master/Slave
controls are described in Section 6.3.1.

The color map used to associate colors with data
values is selected.

Controls how data values in the input data are
mapped to colors in the input color map. This
involves minimum and maximum data limit values
that correspond to the first and last color in the color
map respectively.

If set, then the data limits are extracted from the data,
based on the Auto Source. If not set, then the data
limits specified by the Min and Max properties are
used.

If set, the log range is mapped to the colors, and the
log of the data values are used in calculating the
mapped color. Otherwise, linear mapping is used.
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13.14 Grid Color Point

What:

Why:
Used By:

Displays points at each grid data value within specified grid value limits.

Points are colored according to the associated value.

Displays grid data in a plot window.

Color Legend

Appearance: This object appears different in 2D and 3D.

2D

3D

Input Data:

Output Data:

Properties:
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Figure 211. 3D Color Grid Point Window

grid data and color map

color map limit specifications
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Cursor Reporting Format

3D Co-ordinate Mapping

Offset

Information Only

The data limits are basegl on all data values.

The data limits are based on the data values within
the window view.

Minimum data value for color mapping.
Maximum data value for color mapping.
Colors used for data values outside the data limits.

Values below the minimum data limit are given the
first color in the color map, values above the
maximum data limit are given the last color in the
color map.

Values outside the data limits range are not plotted.

Controls the plotting of triangulation edges with
lines. (The grid is automatically triangulated in order
to generate contours.)

If selected, triangulation edges are plotted.

Color for edges selected from the plot window’s plot
pen set.

Edge line thickness.
Polygon offset of lines. Used only for OpenGL 1.1.

For 2D plots, the numeric format of the values
associated with the cursor position in the report area
of the 2D plot window. Numeric format controls are
described in Section 6.3.3.

For 3D plots, determines which grid and Z variable
1s plotted as the X, Y and Z axis.

For 3D plots, XYZ offset is used to improve the
visibility of objects (see discussion of 3D plot object
visibility, Section 8.1.2.1).
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Z value

Same

Other Grid

Constant

Z Value Grid

Fixed Z Value Value Source

Fixed Z Value Value

Limit Selection

Color Map

Data Limits

>
=
]

3

Auto Source

Information Only

For 3D plots, a Z value needs to be identified to plot
XY data in a 3D plot.

The grid value at each grid co-ordinate 1s used as the
Z value.

Grid value is based on the grid value from another
grid of the same size.

The grid is plotted at a constant Z value. The Z
value may be specified, or based on the Z value of
another object.

For 3D plots, a grid is selected of the same size as
the Grid Data To Plot. The value from the selected
grid is used as the Z value.

For 3D plots, Master/Slave controls for a Constant Z
value. For grids extracted from a cube, the grid
extraction value may be used as the constant Z value.
Master/Slave controls are described in Section 6.3.1.

For 3D plots and Constant Z value, the constant Z
value at which to plot the grid.

A master/slave control to connect the data limits to
those specified in another object (e.g. Cube Color
Block, Grid Color Point, etc.). Master/Slave
controls are described in Section 6.3.1.

The color map used to associate colors with data
values is selected.

Controls how data values in the input data are
mapped to colors in the input color map. This
involves minimum and maximum data limit values
that correspond to the first and last color in the color
map respectively.

If set, then the data limits are extracted from the data,
based on the Auto Source. If not set, then the data
limits specified by the Min and Max properties are
used.

If set, the log range is mapped to the colors, and the
log of the data values are used in calculating the
mapped color. Otherwise, linear mapping is used.

The method for determining the data limits
automatically.
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13.13 Grid Color Fill

What: Displays color filled contours of the nodes of a grid based on specified grid
value limits.

Why: Displays contours of grid data in a plot window.

Used By: Color Legend

Appearance: This object appears different in 2D and 3D.
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Figure 208. 2D Color Grid Fill Window
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Figure 209. 3D Color Grid Fill Window
Input Data: grid data and color map
Output Data:  color map limit specifications
Properties:

Grid Data To Plot The grid data set to be plotted is selected.
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Offset

log of the data values are used in calculating the
mapped color. Otherwise, linear mapping is used.

The method for determining the data limits
automatically.

The data limits are based on all data values.

The data limits are based on the data values within
the window view.

Minimum data value for color mapping.
Maximum data value for color mapping.
Colors used for data values outside the data limits.

Values below the minimum data limit are given the
first color in the color map, values above the
maximum data limit are given the last color in the
color map.

Values outside the data limits range are not plotted.

Factor by which the plotted blocks are reduced.
Reduction is performed by shrinking the block along
the lines between block vertices and the enclosed
node by the area reduction factor.

Controls the plotting of block edges with lines.
If selected, edges are plotted.

Color for edges selected from the plot window’s plot
pen set.

Edge line thickness.
Polygon offset of lines. Used only for OpenGL 1.1.

For 2D plots, the numeric format of the values
associated with the cursor position in the report area
of the 2D plot window. Numeric format controls are
described in Section 6.3.3.

For 3D plots, determines which grid and Z variable
is plotted as the X, Y and Z axis.

For 3D plots, XYZ offset is used to improve the
visibility of objects (see discussion of 3D plot object
visibility, Section 8.1.2.1).
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Output Data:  color map limit specifications

Properties:
Grid Data To Plot

Z value

Same

Other Grid

Constant

Z Value Grid

Fixed Z Value Value Source

Fixed Z Value Value

Limit Selection

Color Map

Data Limits

>
3
)

3

The grid data set to be plotted is selected.

For 3D plots, a Z value needs to be identified to plot
XY data in a 3D plot.

The grid value at each grid co-ordinate is used as the
Z value.

Grid value is based on the grid value from another
grid of the same size.

The grid is plotted at a constant Z value. The Z
value may be specified, or based on the Z value of
another object.

For 3D plots, a grid is selected of the same size as
the Grid Data To Plot. The value from the selected
grid is used as the Z value.

For 3D plots, Master/Slave controls for a Consrant Z
value. For grids extracted from a cube, the grid
extraction value may be used as the constant Z value.
Master/Slave controls are described in Section 6.3.1.

For 3D plots and Consrant Z value, the constant Z
value at which to plot the grid.

A master/slave control to connect the data limits to
those specified in another object (e.g. Cube Color
Block, Grid Color Point, etc.). Master/Slave
controls are described in Section 6.3.1.

The color map used to associate colors with data
values is selected.

Controls how data values in the input data are
mapped to colors in the input color map. This
involves minimum and maximum data limit values
that correspond to the first and last color in the color
map respectively.

If set, then the data limits are extracted from the data,
based on the Auto Source. If not set, then the data
limits specified by the Min and Max properties are
used.

If set, the log range is mapped to the colors, and the
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13.12 Grid Color Block

What: Displays color blocks around each grid data value within specified grid value
limits. Blocks are colored according to the associated value.

Why: Displays grid data in a plot window.

Used By: Color Legend

Appearance: This object appears different in 2D and 3D.

2D
.r#*,ga Hioi Saings
| [ColerGridBiock . | |Lmrﬂt]' r:jﬂnpun !Piot
Ciota Ta Piot - -
[(ncmn cvaﬂnhlg: 8 — _ _.J].
b Limit S = Calor M
| 2 Mostor ! [ColorMep Cold-»Hot =
i
|enone puailohler {_} F
:Datn Limis OutoFRange
¥, Auto leg {—‘” = :...:‘ &‘:“'
Auld $50ce [aidan =] Mex IIF_; it
b Aren — e -
[Toooo0 4
Edges : -
+ CaPlot Dlisg ) e
k- Cureos Repoding Foume!
=) R~
- - - -~
Figure 206. 2D Color Grid Block
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Figure 207. 3D Color Grid Block
Input Data: grid data and color map
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Offset

XYZ offset is used to improve the visibility of
objects (see discussion of 3D plot object visibility,
Section 8.1.2.1).
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